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Foreword
Welcome to The Colorist Guide to DaVinci Resolve 17.
DaVinci Resolve 17 is the only postproduction solution that brings editing, color correction, 
audio post, and visual effects together in the same software application! The most exciting 
thing about DaVinci Resolve 17 is the revolutionary new cut page, which is designed specifically 
for the fastest possible editing when working with tight deadlines. It’s an alternative edit 
page with a newly styled editing interface that eliminates unnecessary steps to edit, plus 
it’s combined with new tools, all designed to help you work faster than ever before.

DaVinci Resolve 17 also includes even more advanced color correction, powerful new editing 
options on the traditional edit page, vastly improved Fairlight digital audio tools, and even 
faster 2D and 3D visual effects compositing on the Fusion page. DaVinci Resolve 17 enables 
you to switch between creative tasks without having to export or translate files between 
different applications!

Best of all, DaVinci Resolve 17 is absolutely free! Plus, we’ve made sure that the free version 
of DaVinci Resolve actually includes more features than any paid editing system. That’s 
because at Blackmagic Design we believe everybody should have the tools to create 
professional, Hollywood-caliber content without having to spend thousands of dollars.

I hope you’ll enjoy using DaVinci Resolve 17, and we can’t wait to see the amazing work 
you produce! 

Grant Petty  
Blackmagic Design
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Getting Started
Welcome to The Colorist Guide to DaVinci Resolve 17, an official Blackmagic Design-
certified training book that teaches professionals and students how to get the most out of 
color correction using DaVinci Resolve 17. All you need is a Mac or Windows computer, the 
free download version of Resolve 17, and a passion to learn about color correction.

This guide blends practical, hands-on exercises with the aesthetics of the colorist’s art to 
help you discover new techniques for whatever tasks you take on. You will learn how to use 
the program’s many grading tools and workflows, and gain an in-depth understanding of 
advanced techniques and creative industry practices. Some exercises will even take you 
into the realm of compositing, which is an increasingly requested skill of 
contemporary colorists.

After completing this book, you are encouraged to take the 50-question online proficiency 
exam to receive a Certificate of Completion from Blackmagic Design. The link to the exam 
is located at the end of this book.

About DaVinci Resolve 17
DaVinci Resolve is the world’s fastest growing and most advanced editing software. It also 
has a long history of being the world’s most trusted application for color correction. In 
addition to its world-class color correction toolset, DaVinci Resolve 17 is a professional-level 
nonlinear editing and effects application with a complete set of professional audio editing 
and mixing tools that enable you to complete projects using only one piece of software!

What You’ll Learn
In these lessons, you’ll work with multiple projects to learn advanced, practical techniques 
used in several editing genres. You’ll acquire real-world skills that you can apply to real-
world productions.
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Part I
Part I of the book will have you restoring a documentary edit from a Resolve archive file. The 
three lessons within this section focus on fundamental grading theory and practices. You will 
normalize and balance footage with the primary grading tools in Lesson 1, match the shots in 
the timeline for continuity in Lesson 2, and adopt secondary grading workflows in Lesson 3.

Part II
Part II looks at more advanced approaches to the grade node structure in the context of a 
feature film trailer. In Lesson 4, you will migrate the project to Resolve using an XML file 
format. In Lesson 5, you will more fully explore the importance of node order and consider 
incorporating mixer nodes when grading to ensure the optimal color outcome. In Lesson 6, 
you will practice different methods of managing and copying grades with an eye toward 
developing efficient, quick workflows.

Part III
Part III will focus more strongly on the optimization of grading workflows to ensure a quick, 
accurate grading process and output. In Lesson 7, you will look at a variety of methods of 
controlling the image frame and properties, as well as advanced keyframing, compositing, 
and noise-reduction techniques. Lesson 8 incorporates the classic grading workflow into a 
group-based pipeline that will allow you to grade entire segments of the timeline in one 
node tree. Lesson 9 demonstrates the different approaches you could take when starting a 
grading workflow with RAW media and emphasize its extended grading potential in the 
HDR grading palette. Finally, Lesson 10 covers project delivery from basic preset setup to 
custom renders and DCP workflows.

The appendices at the end of the book provide additional information regarding the layout 
and functionality of the program, as well as the corresponding controls on the 
Blackmagic Design Mini Panel.

The Blackmagic Design Training and Certification Program 
Blackmagic Design publishes several training books that take your skills farther in 
DaVinci Resolve 17. They include:

	� The Beginner’s Guide to DaVinci Resolve 17
	� The Colorist Guide to DaVinci Resolve 17
	� The Editor’s Guide to DaVinci Resolve 17
	� The Fairlight Audio Guide to DaVinci Resolve 17
	� The Visual Effects Guide to DaVinci Resolve 17

Whether you want an introductory guide to DaVinci Resolve or you want to learn more 
advanced editing techniques, color grading, sound mixing, or visual effects, our certified 
training program includes a learning path for you.
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After completing this book, you are encouraged to take a 1-hour, 50-question online 
proficiency exam to receive a certificate of completion from Blackmagic Design. The link 
to the online exam can be found on the Blackmagic Design training web page.

The web page also provides additional information on our official Training and Certification 
Program. Please visit www.blackmagicdesign.com/products/davinciresolve/training.

Author: Dion Scoppettuolo
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System Requirements
This book supports DaVinci Resolve 17 for Mac and Windows. If you have an older version of 
DaVinci Resolve, you must upgrade to the current version to follow along with the lessons.

NOTE The exercises in this book refer to file and resource locations that will differ 
if you are using the version of software from the Apple Mac App Store. For the 
purposes of this training book, if you are using macOS we recommend 
downloading the DaVinci Resolve software from the Blackmagic Design website, 
and not the Mac App store.

Download DaVinci Resolve
To download the free version of DaVinci Resolve 17 or later from the Blackmagic  
Design website:

1	 Open a web browser on your Windows or Mac computer.

2	 In the address field of your web browser, type:  
www.blackmagicdesign.com/products/davinciresolve.

3	 On the DaVinci Resolve landing page, click the Download button.

4	 On the download page, click the Mac or Windows button, depending on your 
computer’s operating system.

5	 Follow the installation instructions to complete the installation.

When you have completed the software installation, follow the instructions in the following 
section, “Acquiring the Lesson Files,” to download the content for this book.

http://www.blackmagicdesign.com/products/davinciresolve/training
http://www.blackmagicdesign.com/products/davinciresolve
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Acquiring the Lesson Files
The DaVinci Resolve lesson files must be downloaded to your Mac or Windows computer 
to perform the exercises in this book. After you save the files to your hard disk, extract the 
file and copy the folder to your Movies folder (Mac) or Videos folder (Windows).

To Download and Install the DaVinci Resolve Lessons Files:
When you are ready to download the lesson files, follow these steps:

1	 Open a web browser on your Windows or Mac computer.

2	 In the address field of your web browser, type: www.blackmagicdesign.com/products/
davinciresolve/training.

3	 Scroll the page until you locate The Colorist Guide to DaVinci Resolve 17.

4	 Click the Lesson Files Part 1 link to download the media for the first section of the book. 
The BMD 17 CC - Project 01.zip  file is roughly 2 GB in size.

5	 Click the Lesson Files Part 2 link to download the media for the second section of the 
book. The BMD 17 CC - Project 02.zip is roughly 1.10 GB in size.

6	 Click the Lesson Files Part 3 link to download the media for the third section of the 
book. The BMD 17 CC - Project 03.zip is roughly 2.30 GB in size.

7	 After downloading the zip files to your computer, open your Downloads folder and 
double-click to unzip them if they haven’t unzipped automatically. 

8	 In your chosen storage location--for example, the Movies folder (Mac) or Video folder 
(Windows)—create a new folder called BMD 17 - The Colorist Guide.

9	 From your Downloads folder, drag the BMD 17 CC - Project 01, BMD 17 CC - Project 02, 
and BMD 17 CC - Project 03 folders into the BMD 17 - The Colorist Guide folder that you 
created in the previous step.

You are now ready to begin Lesson 1, “Balancing Footage.”

Getting Certified
After completing this book, you are encouraged to take the one-hour, 50-question online 
proficiency exam to receive a Certificate of Completion from Blackmagic Design. The link 
to this exam is located at the end of this book.

“No matter how much post experience you have, there’s always something new to learn 
about DaVinci Resolve. I sometimes find that going back and reviewing the basics helps 
give you perspective on finding a new way to give clients the look they want quickly and 
efficiently. Highly recommended for newcomers and veteran colorists alike.”

Marc Wielage, Senior Colorist - Chroma | Hollywood

http://www.blackmagicdesign.com/products/davinciresolve/training
http://www.blackmagicdesign.com/products/davinciresolve/training
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Interface Review
This section contains an overview of the color page interface to remind you of its key 
functions and to establish the terminology that will be used throughout the book.

Color Page Layout
The default layout of the color page contains the following panels:

Gallery

Primaries wheels

Viewer

Custom curves

Node Editor

Scopes

Gallery contains stills that can be used for visual comparison, or for copying grading data. 
Stills can be generated in Resolve or imported from an external source, and organized 
into albums.

Viewer displays and plays the selected clip, and offers additional interface controls.

Node graph allows grades and effects to be structured to maximize the visual quality of 
each clip.

Primaries wheels control the tonal and chromatic values of an image on the basis of three 
luminance ranges (highlights, midtones, and shadows).
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Custom curves give precise control over the chromatic values of an image based on RGB 
and luminance curves.

Scopes provide graphic readouts of the luminance and chrominance values of an image for 
the purposes of balancing and matching.

A series of buttons the top of the interface allow you to show and hide panels as needed. 
Hiding panels (for example, the Timelines or the Gallery) will create more space for the 
Viewer and remaining panels.

Primaries Wheels
The Primaries wheels (and the corresponding Primaries Bars and Log controls) allow you to 
affect the brightness and hue of the image by targeting specific luminance ranges.

Lift targets the shadows of the image. 

Gamma targets the midtones of the image. 

Gain targets the highlights of the image.

Offset affects the entire image uniformly.

Master wheels are the dark horizontal sliders beneath the color wheels that control the 
YRGB values of those respective ranges.

Clicking the Reset arrows in the upper-right corner of each wheel will neutralize the color 
and master wheel of that range. You can also reset the entire palette by clicking the 
general Reset button next to the palette mode name.

The adjustment controls at the top and bottom of the Primaries palette give additional 
control over the image with features such as contrast and saturation, temp and tint, 
and so on. 
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Viewer
The Viewer shows the frame that the playhead is currently on. By default, clips are represented 
as they will appear upon final render. Some additional features allow you to temporarily 
bypass grades, see a representation of a clip’s matte, and to compare clips to other media.

Some additional controls at the top and bottom of the Viewer maximize the functionality of 
the tools in the color page.

TIP You can position your mouse pointer over any tool in the color page to 
see its name.

Image wipe enables you to wipe between a still, reference frame, or another clip in the 
timeline for visual comparison and matching.

Split screen places clips alongside one another for review and comparison. It features 
several modes to allow comparison between clips on a timeline, in the same group, or even 
versions of grades within the same clip.

Highlight is enabled to reveal the matte that is associated with a selected node.

On-screen control menu is a pop-up menu in the lower-left of the viewer that features a 
selection of UI controls associated with some of the palettes and functions of the 
color page.

The bottom of the viewer contains a scrubber and transport controls that allow you to 
navigate the clip as you would in the edit page.
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Palette Panel
A series of buttons under the timeline enable you to navigate between the palettes 
available on the color page. From left to right, these palettes are:

Left palettes—Camera RAW, Color Match, Primaries, High Dynamic Range, RGB Mixer, 
Motion Effects

Central palettes—Curves, Color Warper, Qualifier, Window, Tracker, Magic Mask, Blur, Key, 
Sizing, 3D

Keyframe Editor—Keyframes, Scopes, Info

Use these buttons to navigate between palettes when prompted during the exercises. 
The name of each palette appears in the upper-left corner when clicked, as well as over 
the button itself when a mouse pointer is hovered over it.

Project File Locations and Solutions
You will find the training materials required to complete the exercises in this book 
divided into three project folders, which correspond to the three sections of the book 
(BMD 17 CC—Project 01, BMD 17 CC—Project 02 and BMD 17 CC—Project 03).

Follow the instructions at the start of every lesson to find the necessary folder, project, 
and timeline.

After you have completed an exercise, you have the option to review the completed timeline 
that is included in every project file provided with the media. Keep in mind that color grading 
is a subjective practice, and your results will often differ from the completed timelines. 
Rather than attempting to match your work exactly, use them for general comparison and 
troubleshooting.
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Introduction to the Color Panels
Blackmagic Design manufactures a wide range of control surfaces for use with 
DaVinci Resolve 17. Professional colorists working on commercials, television, and film 
prefer using control surfaces to using a mouse and keyboard. Hardware control surfaces 
allow you to work faster and more efficiently because you can adjust multiple parameters 
simultaneously. Three control panels are available for Davinci Resolve: Micro, Mini, 
and Advanced.

DaVinci Resolve  
Micro Panel

DaVinci Resolve 
Advanced Panel

DaVinci Resolve  
Mini Panel

DaVinci Resolve Micro Panel
The DaVinci Resolve Micro Panel is a high-quality, portable, low-profile panel that features 
three high-resolution trackballs and 12 precision-machined control knobs for accessing 
essential primary correction tools. If you’re using a Micro Panel, it’s important to know that 
all the instructions regarding the primary color tools and setup are identical to the Mini 
Panel. Above the center trackball are keys for switching between Log and offset color 
correction, as well as a key to display DaVinci Resolve’s full-screen viewer, which is great 
for use with laptops. Eighteen dedicated keys on the right side of the panel also give you 
access to many commonly used grading features and playback controls. The Davinci 
Resolve Micro Panel is perfect for anyone who needs a truly portable solution. It’s great for 
use on set to quickly create looks and evaluate color; it’s ideal for grading in broadcast 
trucks, excellent for education, and ideal for anyone whose work relies mostly on the 
primary color correction tools.

DaVinci Resolve Mini Panel
The DaVinci Resolve Mini Panel is a compact panel that’s packed with a massive 
combination of features and controls. As with the Micro Panel, you get three professional 
trackballs along with a variety of buttons for switching tools, adding color correctors, and 
navigating your node tree. It also features two color LCD screens that display menus, 
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controls, and parameter settings for the selected tool, along with buttons that give you 
direct access to the menus for specific features. The Mini Panel is ideal for users who 
regularly switch between editing and color grading, or for freelance colorists who need to 
carry a panel with them when moving between facilities. It’s also great for colorists working 
on location shoots, for corporate and event videographers, for houses of 
worship, and more.

DaVinci Resolve Advanced Panel
For the ultimate in speed, power, and control, get the DaVinci Resolve Advanced Panel! 
The Advanced panel was designed in collaboration with professional colorists to work in 
total harmony with the software. This large panel consists of left, center, and right consoles 
that give you quick, one-touch access to virtually every parameter and control in 
DaVinci Resolve. The Advanced Panel lets colorists instinctively reach out and touch every 
part of the image, adjusting multiple parameters simultaneously with complete 
responsiveness for a smooth grading experience. When you’re working with a client over 
your shoulder on a tight deadline, you need the DaVinci Resolve Advanced Panel.
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Part I

Color Correcting 
a DaVinci Resolve 
Timeline
Lessons

	� Balance footage
	� Create color continuity
	� Correct and enhance isolated areas

Part I of The Colorist Guide to DaVinci Resolve 17 focuses on establishing a strong practical 
foundation of primary and secondary grading techniques with additional focus on 
balancing and matching media in preparation for creative grading.

Each part of this guide focuses on its own project, and each project is set up to explore the 
variety of methods for starting a grade in Resolve. In Part 1, the project is accessed using 
Resolve’s archiving feature.

Project File Location
You will find all the necessary content for this section in the “BMD 17 CC - Project 01” folder. 
Follow the instructions at the start of every lesson to find the necessary project, timeline, 
and media files. If you have not yet downloaded the first set of content files, go to the 
“Getting Started” section of this book for more information.

NOTE Although you can use DaVinci Resolve 17 for the majority of this guide, 
some exercises will require DaVinci Resolve Studio 17.



﻿
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TimeTime
This lesson takes approximately 
90 minutes to complete.

Lesson 1

Balancing Footage

The first project you will be grading is a 
documentary about protecting 
endangered rhinos. The workflow 
described is applicable to virtually all types 
of video project grading, but documentary 
cinematography is particularly sensitive 
to the following steps:

	� Balance footage—Documentary 
videographers often change locations 
during a shoot, which means they 
have less shot-to-shot control over 
lighting conditions.

	� Match shots—Scenes, interviews, 
and b-roll can be shot over many 
days with different cameras. You must 
visually match all content to create a 
cohesive narrative.

	� Improve imagery—You can confine 
grading to specific portions of a shot 
to enhance skies, skin tones, and 
visual framing.

Goals
Opening a Resolve Archive	 4

Setting Up Project Backups	 5

Understanding the Grading Workflow	 7

Setting Tonal Range and Contrast	 9

Balancing Colors	 17

Understanding Log Controls and 
Primaries Wheels	 20

Self-Guided Exercises	 27

Lesson Review	 27
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Also, you wouldn’t color grade a somber documentary about rhinoceros sanctuaries as you 
would grade a 30-second perfume ad featuring the latest Hollywood A-lister, even if both 
projects were shot on the same type of camera. So, in addition to addressing the technical 
requirements of the footage, you will also attend to the documentary’s aesthetic considerations.

In this lesson, you’ll familiarize yourself with the primary grading tools used to normalize 
and balance clips on a timeline, waveforms, and parade scopes for optimal matching, and 
employ secondary grading selection methods to enhance your final look. You will do so in 
the context of an overall grading workflow that addresses the needs of each timeline clip.

Opening a Resolve Archive
This book is divided into three distinct sections, each devoted to a different genre and 
using three different project setup methods. The first method uses a timeline edited and 
archived in DaVinci Resolve 17. This is one of the most efficient methods for sharing and 
launching timelines, as it uses the original project file and its associated media. By restoring 
the DRA folder, you can be certain you are seeing the timeline exactly as intended by the 
editor, with all of its transitions, layers, and retiming intact.

Blackmagic Design Mini Panel Operations
DaVinci Resolve control panels are designed to give you fluid, hands-on control over 
multiple parameters at the same time, so you can work faster and be more creative. See 
Appendix B, “Using the Blackmagic Design Mini Panel,” for an overview of how a control 
panel can optimize your workflow in Resolve. Throughout this book, lesson notes will show 
how exercise workflows can be enhanced by using a Mini Panel.

NOTE For a quick refresher course on the DaVinci Resolve interface, see 
Appendix A, “Interface Review.”

1	 Open DaVinci Resolve 17.

2	 Right-click in the Project Manager window, and choose Restore Project Archive.

3	 On your hard disk, locate the “BMD 17 CC - Project 1” folder.

4	 Select the Project 01 - Disunity Documentary.dra file, and click Open.
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5	 In the Project Manager, double-click the Project 01 - Disunity Documentary thumbnail 
to open the project.

6	 To enter the color page, click the Color button at the bottom of the interface, or 
press Shift-6.

7	 Verify that you are on the 01 Main Timeline. The name of the timeline appears above 
the viewer. You can select the current timeline by clicking the disclosure arrow next to 
the timeline name.

TIP You can archive projects by right-clicking a project thumbnail in the Project 
Manager, and choosing Export Project Archive. Doing so will consolidate your 
project file, timelines, and media into a single folder for sharing or future retrieval.

You’re almost ready to start grading! However, before you begin, you should make it a habit 
to verify that your project backup settings are enabled.

Setting Up Project Backups
As soon you create or load an existing project, it is good practice to ensure that Resolve’s 
Live Save feature is running in the background. Performing incremental background saves 
will keep track of every change you make to your project, as well as retain older variants of 
your project for future recall.

1	 Open DaVinci Resolve > Preferences.

2	 At the top of the Preferences pop-up window, switch from System to User.

3	 Click “Project Save and Load” to the left to access Save Settings.



6Setting Up Project Backups

By default, Live Save is enabled, so DaVinci Resolve will overwrite your active project 
file every time you make a change, no matter how small. This setting is crucial to 
enable to minimize the risk of losing any project changes in the event of unexpected 
system or program shutdowns.

4	 Choose Project Backups.

Selecting this option saves a new copy of your project file at regular intervals to a 
designated backup location.

5	 To select the backup location, click Browse, and specify a save destination on your 
workstation or external drive.

By default, a backup project is generated every 10 minutes, regardless of the number 
of changes that you made during that period. Eventually, older project backup files are 
cleared from the project storage, with the exception of files that extend over longer 
hourly and daily intervals. This behavior can be extremely helpful when working on 
long form projects because it allows you to return to the state of a project (from two 
weeks ago, for example) without sorting through thousands of project files.

6	 Click Save to close Preferences and return to the project. You may now continue 
working on your project safe in the knowledge that your every change is backed up.

NOTE To open a backed-up project file, you can access the .drp file at 
the designated backup location on your drive or you can open the Project 
Manager, right-click the thumbnail of the project you wish to restore, and choose 
Project Backups. In a pop-up window, you can select from a list all of the backups 
associated with the project.

With the project loaded and Live Save enabled, you can proceed with actual color grading. 
But where to begin? When approaching an ungraded timeline, it’s not always obvious 
where your starting point should be. The next section aims to establish a fundamental 
understanding of the grading process. 
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Understanding the Grading Workflow
It is good practice to have a clear idea of what your workflow is before beginning a grade. 
Your workflow is informed by a variety of factors including the color space and format of 
your footage, the way that the timeline edit was shared with you, and the project’s content. 
Before continuing, let’s review the common phases of a grading workflow.

Balancing and Shot Matching
Before you can grade footage creatively, you must adjust shot luminance and chrominance 
to create a level starting point for your grade. This process is akin to laying down a primer 
on a canvas before painting to ensure that the pigment is applied to a consistent surface.

A single grade applied to five balanced and matched shots will establish a visual continuity 
that flows naturally from one shot to the next, whereas the same grade applied to 
unbalanced and mismatched shots will continue to reflect each shot’s differences.

This stage of grading is categorized as a primary grade because the entire frame of the 
image is adjusted. It is usually performed using techniques known as normalization, 
balancing, and shot matching.

Normalization and balancing involve creating a neutral starting point for clips in the timeline 
by consistently adjusting the luminance levels of each, and neutralizing any issues with 
their color balance.

Shot matching involves comparing clips and matching their contrasts and colors exactly. 
This technique is particularly advantageous when the majority of your clips already have a 
similar look, and you need to tweak only a few exceptional shots to create a smooth 
starting point for your scene.

Performing Secondary Grading
Secondary grading refers to any part of the grading process in which only a part of an 
image is altered. The potential for secondary grading is limitless, but it is mainly achieved 
by two means: keying and masking.

Keying targets a portion of an image based on a hue, saturation, or luminance range. In 
Resolve, the main tool for key extraction is the qualifier.

Masking employs geometric vector shapes to isolate a portion of an image. Resolve’s 
masking interface—the Power Windows palette—features some standard shapes (linear, 
circle, polygon, and gradient), as well as a fully customizable power curve that enables you 
to generate garbage mattes and rotoscopes (animated masks).

Like the qualifier, Power Windows cannot alter the appearance of an image directly but act 
as selectors for the grading tools.
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Secondary grading is most powerful when the qualifier and Power Windows are used in 
tandem. While the qualifier focuses on extracting an element with a clean edge, a Power 
Window can confine the qualifier’s influence to a specific portion of the screen. In this way, 
it is possible to target an object in areas of the shot that are of a similar key range.

Creating a Look
Once your clips are balanced and shot matched, and any individual secondary grading 
needs are met, your creative process can begin.

When performing creative grading, you should carefully consider the emotional and 
narrative implications of the scene. You can apply both primary and secondary grading 
techniques to influence an audience’s emotional perception of an environment by tweaking 
the scene’s color temperature to indicate positive (warm) or negative (cold) moods, and 
evoke a wide range of psychological color and tone associations. Additionally, a creative 
grade can communicate practical narrative elements such as a change in location or time 
(for nonlinear stories).

NOTE The grading workflow described here does not rigidly dictate the order in 
which these grades should be performed by the colorist. Although first completing 
the balancing and shot-matching stage is best practice, it is often necessary to 
readjust grades applied in earlier stages to ensure a consistent final output, and in 
some cases, it may be necessary to skip color correction altogether.

Visualizing the Grading Workflow in the Node Editor
The following chart represents a traditional grading workflow in the context of the Node 
Editor in Resolve’s color page.

This graph is not intended as a literal guideline to how nodes should be structured but a 
representative overview of how nodes relate to one another and their relative positions.
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Setting Tonal Range and Contrast
The human eye is particularly sensitive to light sources and shadows, which is why it makes 
sense to begin the normalization and grading processes by establishing the luminance 
of an image.

In the following exercises, you will adjust luminance using master wheels and custom 
curves while also learning about the waveform monitor.

Normalizing with Master Wheels
The color wheels are among the most integral primary color correction tools used to adjust 
image hue. Beneath them, the master wheels allow you to set the tonal range and contrast 
of an image by altering its luminance.

In this exercise, you will adjust the shadows and highlights using the master wheels. You’ll 
also refer to the waveform scope to monitor your adjustments for unwanted clipping.

1	 Select clip 02.

The palette in the lower-right corner of the DaVinci Resolve interface is currently set to 
the Scopes panel in Waveform mode.
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The waveform scope displays the luminance and color channel values of the video at 
the precise timeline position of the playhead.

The vertical axis of the scope represents the entire luminance range of the image.

The bottom of the display represents the blackest black (0 in a 10-bit depth signal), and 
the top represents the whitest white (1023 in 10-bit). Everything between represents 
the full midtones range of the image in a grayscale format.

The horizontal axis represents the image itself and can be read across both the graph 
and the monitor. You can think of the display as showing the distribution of the pixels 
(the trace) across their respective vertical columns based on their luminance levels with 
darker areas of the footage toward the bottom of the graph and lighter areas displayed 
toward the top.

Each color channel is overlapped in the trace. White in the trace indicates that each 
channel has an equal intensity. When adjusting tonality in an image, you can disable 
the RGB channels in the waveform and show only luminance.

2	 In the upper-right corner of the waveform, click the Settings button.

3	 Click the Y channel button at the top to display only the luminance channel.

4	 Deselect the Colorize option to display the trace with solid white pixels.
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5	 Click anywhere in Resolve to close the waveform settings window.

Any part of the trace that goes below 0 (black point) and above 1023 (white point) in the 
sRGB gamut will be clipped, which will result in a loss of image detail.

When initially normalizing footage, a good starting point is to ensure that the shadows 
are floating at around 5–10% above the black point (0) on the scope, while the pure 
white highlights (if any) should stop well under the white point (90%). This leaves the 
remaining 10% as headroom for superwhite elements such as blown out headlights, 
lens flares, or metallic specular highlights that can extend beyond the white point.

6	 In the color page, open the Primaries palette.

If you have already used DaVinci Resolve or read through Appendix A, “Interface 
Review,” you know that the Lift wheel affects the image shadows, the Gamma wheel 
affects the midtones, and the Gain wheel affects the highlights. The Offset wheel 
impacts the entire image and can be thought of as a combination of all three wheels.

The horizontal wheels located under the color wheels are called master wheels and 
impact the luminance values of their ranges.

7	 Drag the Lift master wheel to the left to darken the shadows. Because this image has 
detail in the darkest areas of the wood, aim to place the lowest parts of the waveform 
trace far above 0 but below the 128 axis.

Notice that the three areas of the graph where the trace of the waveform dips toward 
the black level. Try to locate their respective positions in the frame.
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Those three dark areas correspond to places where the barrier is visible behind the 
wooden poles in the enclosure. The darkest areas of the barrier are represented by a 
pronounced dip in the graph.

8	 You can use the Gain master wheel to brighten the lighter areas of the image. The image 
has no chart or reference for pure white, but you could use the thumb in the image 
as a luminance indicator. The highlights on skin should rest between 50–75% on the 
waveform graph. Drag the Gain master wheel so the tallest traces do not go higher 
than three-fourths of the waveform graph.

This is an example of using image context for balancing and grade adjustment. In 
future exercises, you will continue to identify elements that you could use as a guide 
for grading decisions.

With the shadow and highlight levels set, you will want to adjust the brightness of 
the midtones.

9	 Drag the Gamma master wheel to the right to lighten the overall scene and enhance 
the details of the rhino’s wrinkled skin.

After setting the tonal range, you can further enhance the image details. The master 
wheels affect the luminance too broadly at this stage, so you should use the contrast 
control to refine the distinction between the darker and lighter areas.
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10	 At the top of the Primaries palette, in the adjustment controls, drag the Contrast setting 
to the right to increase the level of detail in the skin and the wooden poles.

Your image may start look a little dark, but that’s OK. So far you have been focusing on 
only the depth of the shadows and the nature of the contrast.

11	 To increase brightness while maintaining the shadows and level of contrast, drag the 
Pivot control next to the contrast.

The Pivot control establishes the contrast balance by placing more or less priority on 
either side of the luminance scale. By lifting the control, you will increase the overall 
brightness and clarity of the image, although at the inverse expense of the shadows, 
which will be reduced.

Finally, you will address the magenta tint in the resulting image. 

12	 Drag the Tint field left until the pink tone of the rhino is reduced.

13	 Drag the Temp field left to further “cool down” the image and turn the rhino gray.

14	 Press Command-D (macOS) or Ctrl-D (Windows) to toggle the bypass on and off. 
Compare your before and after results to evaluate how altering the contrast affected 
the image. Tweak the values if the grade appears overpowering.

Bypassed Graded

The grading process usually requires a lot of back-and-forth tweaking of palette values 
while monitoring the waveform. Some changes dramatically offset the effects of prior 
adjustments—as in this example, when increasing the contrast darkened the shadows and 
prompted additional tweaks. Iteration is a completely natural part of the grading process.
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Using the Mini Panel—Offset Mode
Whereas the DaVinci Resolve 17 interface shows four wheels within the primary tool palette 
(Lift, Gamma, Gain, and Offset), you’ll notice that the hardware-based Mini Panel has but 
three wheels and trackballs. To access the Offset wheel functionality, press the Offset 
button directly above the Gamma wheel. When the Offset button is illuminated, the Gain 
wheel and trackball will control the master offset. Just as when adjusting Lift, Gamma, or 
Gain, moving the wheel will control brightness and moving the trackball will control color.

Additionally, when in this “offset mode,” the Lift and Gamma wheels control temperature and 
tint, respectively. To exit this offset mode, press the illuminated Offset button once again. 
When it no longer lights up, your trackballs and wheels will return to controlling Lift, 
Gamma, and Gain.

Setting Contrast with Increased Flexibility
Curves are another major grading tool used to perform primary and secondary 
adjustments. Whereas the master wheels target the luminance range of an image, 
the curves affect the image based on its luminance or RGB color channels.

The curves controls allow you to manipulate the image with great precision and flexibility.

1	 In the timeline, click clip 03.
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Because the colors in the image are flat, the majority of the waveform graph is 
condensed in the lower midtones. A significant elevation appears to the left, where 
a window is positioned behind the scale, and to the right you’ll see a gentle peak 
where the light reflects off the plastic rim.

2	 Choose Workspace > Viewer Mode > Enhanced Viewer, or press Option-F (macOS) 
or Alt-F (Windows) to enlarge the viewer.

The Clips timeline and surrounding palettes collapse, dynamically enlarging the size 
of the viewer. The image becomes much easier to see for grading work.

3	 Ensure that the Custom Curves palette is active in the central palettes of the color page.

The lower-left of the curve graph represents the blackest potential point of the image, 
and the upper-right represents the whitest.

The horizontal axis represents the luminance range of the image itself, while the 
vertical axis represents the offset of that luminance range. By raising or lowering the 
two control points at either extreme of the curve, you can manipulate the distribution of 
the tonal range.

By default, the luminance curve (Y) will be visible for adjustment, ganged to all three 
color channels (R, G, B).

4	 For finer adjustment control, turn the Curves palette into a floating window by clicking 
the Expand button in the upper-right corner.  

To move the window, drag the header. To resize, drag the sides and corners.
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5	 Click the Y channel button to ungang the channels.

Now, instead of adjusting RGB values you will alter only the image luminance.

6	 Drag the lowest control point on the luminance curve across the floor to the right.

Doing so lowers the waveform of the image logarithmically, darkening the shadows 
more than the highlights.

7	 Stop dragging the control point when the bottom of the trace is still above the 0 line 
of the waveform.

8	 To raise the top of the waveform, drag the highest control point across the top of 
the graph. 

Normally, you’d stop when the top of the trace touches the second horizontal line in the 
Waveform graph (896), but because this part of the trace represents a very bright 
window in the video clip, it makes sense to continue raising it until the trace is almost 
halfway between the top horizontal lines on the graph.

You can add more control points to the curve to manipulate the midtones of the image. 
Let’s tackle the lower midtones that appear too dark after performing that black 
point adjustment.

9	 Click the lower half of the curve to create a new control point to target the 
lower midtones.

TIP When creating a control point, Shift-click to prevent the curve from 
moving at the position of the mouse.
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10	 Drag the control point up to raise the lower midtones and brighten the face of 
the scale.

Many colorists prefer setting the tonal range and contrast in the custom curves 
because it offers much finer control over the contrast amount, the pivot point, and 
the intensity of each luminance level of the image.

Bypassed Graded

Balancing Colors
After adjusting the tonal range and contrast, you should carefully examine the colors and 
neutralize them in preparation for grading. An unbalanced image will affect the precision of 
your grade, along with the quality of any keyed elements, and will stand out in a sequence 
of balanced clips.

Balancing Color with Curves
You can use custom curves to manipulate the three color channels in great detail by 
creating dedicated control points on each segment of the luminance on each channel.

1	 Open the waveform settings and click the RGB channel button to view the 
RGB channels.

2	 Select the Colorize checkbox to view the individual color channel representations in 
the waveform trace.

When balancing an image using the waveform, all three channels making the trace 
appear white when the channels are aligned. In an image that should have white 
highlights, the trace will appear white at the top.
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3	 Review clip 03 alongside the waveform.

The red channel appears elevated above the other channels, which is giving the image 
a slightly warm tint.

4	 In the Custom Curves palette, Click the red (R) button to select the red channel.

5	 Click the top of the red curve and drag it downward. Pay attention to the waveform and 
drag until the red highlight overlaps the blue and green channels in the trace, resulting 
in white along the upper edge of the graph.

6	 Create a second point on the red curve to perform the same action in the midtones. 
Drag until the lower half of the trace appears white.
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Though the red tint is corrected, the image now has a mild yellow tint because the blue 
channel has less presence in the highlights and midtones.

7	 Click B to isolate the blue channel. 

8	 Click the center of the blue curve line to add a control point, and drag it up until the 
midtones in the waveform are aligned.

9	 Press Command-D (macOS) or Ctrl-D (Windows) to disable color adjustments, and then 
press it again to see the corrected image.

With the luminance of the overall image altered, you could opt to return to the Y curve and 
further adjust the tonal range and contrast of the image, if necessary.
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Using the Mini Panel—Curves
You can use the Mini Panel to control all your curves in DaVinci Resolve. If you used your 
keyboard and mouse in DaVinci Resolve, or any other image-processing application, 
chances are you’ve already worked with curves. While you might have previously used a 
mouse to control curves, the Mini Panel places dozens of preset curve points at your 
fingertips. You can enter Curves mode by pressing the Curves button in the upper left of the 
Mini Panel.

If you’ve already selected a specific curve tool using your mouse, the Mini Panel will jump to 
that tool. Otherwise, the default curves 
that the Mini Panel will jump to will be 
custom curves.

The curve tools provide an excellent way 
to explore the versatility and functionality 
of your Mini Panel. You may activate 
every major curve type featured in 
Resolve using the soft buttons above the 
5-inch screens. The knobs below those 
screens allow you to control specific 
points of the currently activated curve. 
For custom curves, intervals of 0%, 20%, 
40%, 60%, 80%, and 100% may be 
adjusted. This functionality allows you to 
control more than one curve point at once, which will save time, increase your grading 
efficiency, and allow you to make more creative color grading decisions.

Understanding Log Controls and 
Primaries Wheels
Before you normalize the next clip, let’s take a slight detour to understand another function 
that can be a fundamental part of primary grading and balancing: the Log color wheels.

It is easier to grasp the difference between the Primaries wheels and the Log controls by 
observing a graphic example before moving on to image adjustment. Let’s use the simple 
gradient image at the end of the timeline and manipulate its brightness to compare how the 
two adjustments affect it.

1	 Choose Workspace > Viewer Mode > Enhanced Viewer, or press Option-F (macOS) or 
Alt-F (Windows), to see the timeline clips.
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2	 Select the last clip in the timeline (the grayscale image).

In the standard Primaries wheels that you are familiar with, the Lift, Gamma, and Gain 
wheels target the luminance ranges as seen in the following figure.

Lift Gamma Gain

A wide overlap occurs between the segments. When you try to manipulate the 
shadows of the image using the Lift color or master wheels, the change also 
substantially affects the midtones, and even the brighter ranges of the image.

The waveform scope displays the gradient clip as a flat diagonal line extending left 
to right from 0 to 1023, indicating its linear transition from black to white in the image.

3	 Drag the Gain master wheel to the left to darken the upper ranges of the gradient.

In the waveform, the bottom of the diagonal line remains connected to the black point. 
The brightest part of the gradient is affected most severely but still exerts substantial 
impact on the rest of the luminance range.
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4	 Reset the Gain master wheel.

5	 Drag the Lift master wheel to the right to brighten the lower ranges of the gradient.

In contrast to the Gain wheel, the majority of the Lift wheel’s impact is on the 
darkest portion of the gradient with the effect tapering off linearly as it reaches 
the top of the waveform.

The main point is that in both the gain and lift adjustments, the entire image is 
changed, except for the white and black points. This is intentional because a wide 
overlap creates nice, smooth transitions even in dramatic grades.

6	 Reset the Lift master wheel.

When working in Log, the luminance ranges are much more defined:

Low Range High Range

Shadows Midtones Highlights

Manipulating the image shadows will have very little effect on the rest of the luminance 
range due to the small amount of overlap between the shadows and the 
midtones range.

7	 In the Primaries palette drop-down menu, choose Log.



22 23Understanding Log Controls and Primaries Wheels

On the surface, this interface looks identical to the Primaries wheels. However, 
adjustments to the shadows, midtones, and highlights react very differently.

8	 Drag the Highlight master wheel to the left to darken the highlights of the gradient.

The upper-third of the waveform bends until it is horizontal, but this has no impact on 
the shadows. This behavior is reflected in the viewer, in which the brightest portion of 
the gradient are darkened, while the midtone and shadows remain the same.

9	 Drag the Shadow master wheel to the right to brighten the dark ranges.

This time, the lower-third of the line rises until it is parallel to the horizon.

With the waveform in this position, it is easy to see how you can affect the position of 
overlap between the shadows and midtones (low range), and the midtones and 
highlights (high range).

10	 In the Log adjustment controls, drag the Low Range value left to move the shadow 
segment of the waveform lower, thereby giving priority to the midtones controls.
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11	 Drag the High Range value right to move the highlight segment of the waveform higher 
for the same effect, but in reverse.

TIP To further appreciate how Primaries and Log wheels differ, drag the color 
indicator inside the Lift and Shadow wheels to see how the gradient is 
affected. Adjusting the Lift wheel will cause the entire gradient to change hue, 
whereas dragging the Shadow wheel will constrain the color change to the 
darkest edge of the gradient.

The Log controls can be extremely useful when you are attempting to change the 
luminance or chrominance of a narrower image luminance range. The next exercise will 
demonstrate a practical use of switching between Primaries and Log wheels.

Applying Log and Primaries Changes to an Image
With an understanding of how you can target the luminance ranges of an image, you can 
now more accurately adjust the tonal range and balance of an image.

1	 Select clip 07.

The luma waveform indicates some room for adjusting the image’s highlights. 

2	 Drag the Gain master wheel right to increase brightness until the trace reaches the 
second horizontal line from the top.

Even though the waveform appears to be intact, the sunset on the horizon might start 
to appear “blown out.” To understand why this is happening, let’s check the Parade 
scope to determine the presence of color in the luminance ranges.
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3	 Switch the scopes panel to Parade.

Waveform Parade

The waveform represents the combined luminance of the channels, but it does not take 
into account instances of clipping within individual channels in scenes with pronounced 
chromatic brightness (such as this sunset). 

4	 Reset the Gain wheel.

With reliable white and black references in an image, standard procedure is to 
neutralize the three channels to achieve balance. Without references, context is 
important. In this case, the context is the sunset with its accompanying red skyline, 
which requires an exception to the balancing rule.

5	 Switch the scopes back to Waveform. With the highlights analyzed, you can focus on 
the tonal range and the balance of the dark foreground elements.

6	 To increase the overall brightness of the image without clipping its highlights, drag the 
Gamma master wheel to the right until you have raised the darkest parts of the image 
between the 128 and 256 graticule lines.

The image shadows appear to be compressed along a narrow luminance range, which 
is causing loss of the detail in the image foreground. Adjusting the Lift master wheel 
will not sufficiently expand the compressed shadows.

7	 To confirm this, drag the Lift master wheel to the left to see how dramatically it affects 
the foreground. The compressed shadows are pulled down until the entire image 
becomes too dark.

8	 Reset the Lift wheel.

9	 Switch the Primaries wheels palette to Log mode.
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TIP Press Option-Z (macOS) or Alt-Z (Windows) to toggle between the 
Primaries wheels and Log controls.

10	 Drag the Shadow master wheel to the left to lower the black point without clipping it. 
Note that the tree details begin to pop out against the mountains and ground.

11	 In the adjustment controls, drag the Low Range parameter to the left to redefine the 
low range of the shadows. Because of this narrower shadow range, adjustments to 
the Shadow wheel will be more focused on altering the compressed shadows at the 
bottom of the image.

12	 Drag the Shadow master wheel to the left to further expand the compressed shadow 
range. Keep adjusting the Low Range and Shadow master wheel controls until you see 
a good amount of detail in the foreground of the viewer. 

Because the Shadow wheel is more dedicated to the lower ranges of luminance, it is not 
affecting the midtones as dramatically as the Lift wheel did. With the contrast adjusted, you 
can now address the colors. This image is particularly tricky because of the conditions 
under which it was captured. The sun is still rising, resulting in beautiful peach, purple, 
and blue gradients throughout the sky. You will strive to retain these unusual hues, while 
normalizing the colors in the foreground—most notably, the magenta in the shadows.

13	 Switch the Primaries palette back to Wheels.

14	 Gently drag the Gamma color wheel indicator away from the magenta side of the 
wheel and toward green. Stop dragging before the green in the shadows becomes 
overpowering.

Bypassed Graded

This adjustment removes the magenta tint from the shadows and lower midtones while 
preserving the hues in the mountains and the sky.
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As you saw in this exercise, you can use Primaries and Log wheels together very effectively. 
Primaries wheels can be used to establish an initial tonal range and contrast, while Log controls 
behave like a secondary adjustment that can further refine the three luminance ranges.

Log controls are particularly effective when working on underexposed or overexposed 
footage. They allow for restorative work in the high and lower ranges, as well as minor 
tweaks to the brightness and hue of those ranges, without seriously altering the remainder 
of the image.

Together with balancing and matching, Log controls are also powerful tools for creating 
distinct creative looks.

Self-Guided Exercises
Complete the following exercises in the 01 Main Timeline to test your understanding of the 
tools and workflows covered in this lesson.

Clip 01—Use custom curves to normalize and balance this clip by eye. Place an additional 
control point in the high midtones of the Y channel to create a contrast and accentuate the 
details in the wood grain.

Clip 03—Use the contrast and pivot controls to enhance the details of the scale.

Clips 04, 05, 06, and 09—Use the Primaries wheels to establish a tonal range and contrast 
on these clips with the assistance of the waveform scope.

Clips 12, 16, and 17—Using custom curves, and using the Parade scope for reference, 
normalize these clips and balance the colors, as necessary.

When you’ve completed these exercises, open the 04 Completed Timeline to compare 
your balancing to the Balance node in this “solved” timeline. Note that normalization, 
balancing, and contrast in some of the clips was separated into individual actions in the 
Node Editor. In the next lesson, you will also begin the practice of separating your grading 
stages into nodes.

Lesson Review
1	 Does a DaVinci Resolve archive (.DRA) contain the original project media?

2	 What does the Y in YRGB represent?

3	 What does the pivot in the adjustment controls do?

4	 How do you add additional control points to curves?

5	 What is the difference between the Primaries wheels and Log controls?
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Answers
1	 Yes. Archived projects (.DRA) consolidate all related project media within a single 

folder that can be restored through the Project Manager.

2	 The Y refers to luminance.

3	 The pivot control adjusts contrast balance

4	 Click directly on a curve to add a new control point. Shift-click to add a new control 
point without adjusting the curve’s position.

5	 They target different tonal ranges of the image.



Time
This lesson takes approximately 
80 minutes to complete.

Lesson 2

Creating Color 
Continuity

When editing footage for a video project, 
the end goal often is to create a single 
running narrative that appears to be 
happening in real time. Much of the 
time—even in documentary filmmaking—
this unity of time is an illusion. Materials for 
a single scene can take days or even 
weeks to photograph, which can result in 
fluctuations in light, temperature, and tint 
as environmental factors influence the 
footage from one day to the next.

The goal of shot matching is to assess 
how multiple clips compare to one another 
when placed into a timeline, and to ensure 
that they create color continuity. When 
shots don’t match, an audience becomes 
aware of their artificial sequencing (as 
opposed to events that were actually shot 
in real time), which breaks the illusion of 
cinema and compromises the viewer’s 
suspension of disbelief.
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Comparing and Matching 
Shots Manually	 43
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Lesson Review	 51
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In the previous lesson, you looked at the most common tools and workflows for normalizing 
and balancing shots in preparation for a grade. In this lesson, you’ll examine the shot-
matching process.

Building a Shot-Matching Strategy
Your approach to shot matching will depend greatly upon the nature of the footage.

On a narrative production that was shot by an experienced cinematographer and camera 
crew, the quality of the raw content can have a reliable consistency throughout and require 
minimal normalization.

For documentaries, fluctuation in locations, light sources, and temperatures (not to mention 
the use of multiple, different cameras) may require a much more dedicated preparation.

It is normal to incorporate both balancing and shot matching during the first primary grade 
pass. You may opt to treat these as separate jobs and apply them to independent nodes, or 
you can forgo balancing on shots that you are matching to a single “key” shot in a scene.

Your shot-matching strategy may be narrowed down to the following approaches and 
considerations:

	� Balance all shots in a sequence. This workflow assumes a shot-by-shot approach to 
normalizing the luminance range and balancing every shot in the sequence, which will 
result in a uniform sequence of shots. This time-consuming method is best applied 
to projects with vastly mismatched media sources or lighting conditions (archival 
documentaries, promo videos, and so on).

Every clip balanced individually

	� Adjust only mismatched shots in a sequence. If only one or two shots in a sequence 
have a contrasting color balance, it makes sense to adjust only those shots to create 
an even starting point for the grade. This approach is more common to standard 
grading practices.

Mismatched clips graded to match the rest of the sequence
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	� Select a master reference shot. Sometimes you will have more than one clip that you 
could use as a reference for matching. In those cases, you may opt to use the reference 
shot that will have a less extreme impact on the color tone of the other clips.

Clips adjusted to a key shot that causes the least color distortion

Or, you might consider settling on the clip that is closest in appearance to your 
intended grade. In doing so, any further creative grading you perform will aim to 
enhance the colors and not undo them.

Clips adjusted to a key shot that is closer to final intended look

TIP When selecting a master reference shot, it is best to select a wide angle 
of the scene and match all other angles to it. A wide-angle shot is likely to 
have the best overall representation of light sources and shadow tones, as 
well as include most of the physical elements in the scene, such as actors, 
costumes, set design, walls, and so on. In contrast, a close-up might contain 
less reliable data for balancing and share few elements with other shots.

The exercises in the following lessons will focus on the practical implementation of shot 
matching based on these methods. Understanding the variety of matching methods 
available in DaVinci Resolve 17 will enable you to construct grading workflows that are 
best suited to your coloring abilities and project type.
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Organizing Shots Using Flags and Filters
In the previous lesson, you clicked on individual clips throughout the timeline. However, 
Resolve provides helpful organizational tools, called flags, that can assist you in identifying 
and categorizing clips based on any criteria that you define. For example, you might flag 
clips that have overexposed skies, clips that require green-screen keying, or clips that 
need narrative-specific dynamic grades.

1	 In the timeline menu above the viewer, open the 02 Balanced Timeline.

The timelines in this project already include some flags. You’ll add a few more to 
identify those clips you will use for the matching exercises in this lesson.

2	 In the timeline, right-click clip 04, and choose Flags > Green.

A green flag appears in the upper-left corner of the clip thumbnail to indicate that the 
clip is flagged.

Another method for applying flags is to use a keyboard shortcut.

3	 Click clip 05. Press G on your keyboard to add another flag.

While this is a faster technique for applying flags, in this case it applied the wrong 
color flag.
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4	 To change the flag to green, double-click the blue flag on the thumbnail to open the 
Flags dialog.

Note that the Flags dialog allows you to attach notes to flags, which is very handy for 
detailing future grading reference and visual adjustments.

5	 Select the green-colored flag and click Done to close the dialog.

The keyboard shortcut currently is configured to apply blue flags by default. To change 
the default flag color, you will need to change the flag color in the toolbar of the edit page.

6	 Go to the edit page. In the toolbar, next to the flag icon, click the disclosure arrow, and 
choose Yellow.
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7	 Return to the color page.

8	 Select clip 04 and hold Command (macOS) or Ctrl (Windows) to select clip 06 at the 
same time.

9	 Press G to apply yellow flags to both clips.

TIP You can apply a flag to multiple clips by selecting a range of thumbnails 
and then using any of the methods described to apply the desired flag to the 
selected clips.

The green flags in the timeline now identify the clips you will be working on throughout 
this lesson. You will find it easier to locate and navigate between them if you filter the 
timeline to show only the green-flagged clips.

10	 At the top of the color page, click the disclosure arrow next to the Clips button and 
choose Flagged Clips > Green Flag.

TIP When a filter is applied to a timeline, the Clips button is underlined in red 
to serve as a visual reminder that some clips in the timeline might not be 
visible because of the filter.
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You have temporarily hidden all clips that do not have a green flag. The result is a 
significantly simplified timeline that will help you focus on those clips without the need 
to navigate around your timeline and locate them.

TIP Like flags, you can also use markers for filtering purposes. The difference 
compared to flags is that flags identify an entire clip (or source media), 
whereas markers identify a specific frame or range on a single clip in the 
timeline. In contrast, adding a flag to a clip applies it to every appearance of 
the source clip in the timeline. Markers can be applied using a keyboard 
shortcut (M), and their default colors may be set in the toolbar of the edit page.

11	 Once again, click the disclosure arrow next to the Clips button and choose Flagged 
Clips > Yellow Flag.

As you can see, clips may contain containing multiple flags. As a result, media 
classifications can overlap, which allows you to filter clips that have several 
workflow roles.

12	 In the Clips pop-up menu, choose Yellow again to remove the yellow flags from 
the clip filter.

In Resolve, flags and filters can perform a wide variety of functions. You can use different 
flag colors to identify clips that must be reframed due to a visible boom, single out clips that 
were incorrectly white balanced, or isolate clips that require a flashback look. When the 
timeline is filtered based on flag color, you can focus on addressing just one category of 
clips at a time.

Applying Shot Match
The shot match function in Resolve analyzes the colors in one image and reconfigures the 
balance of another image (or multiple images) to match it.

The results of any algorithmic grading function should be carefully evaluated after you 
apply it because an algorithm is unable to recognize the environmental factors behind 
scene colors. Even so, shot match can be a great starting operation for a match grade 
and can enable you to quickly prepare shots for on-set review or processing dailies.
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1	 In the green flag-filtered Timeline, select clip 01.

You will match the colors in this clip to the balanced clip 02 directly after it. In 
the interest of preserving the integrity of the video signal, you are advised to keep 
normalization, balancing, and matching on separate nodes.

2	 In the Node Editor, create a new serial node by right-clicking node 02 and choosing 
Add Node > Add Serial or pressing Option-S (macOS) or Alt-S (Windows). 

3	 Right-click the new node, and choose Change Label. Name the node Shot Match.

NOTE In the Balanced Timeline, the normalization and color balancing stages 
were organized into dedicated nodes. This method represents a common 
grading workflow that focuses on preserving the integrity of the RGB signal. 
You will explore it in greater depth in Part 2 of this book.
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4	 Right-click clip 02 and choose “Shot Match to This Clip.” The shot match is performed 
on the active clip in the timeline, which is currently clip 01.

The result is a better match between the two images. Clip 01 becomes warmer and less 
contrasted to match the environment in clip 02. However, the shadows could be 
darkened to better match the mountains in the background, and the gamma brightened 
and made cooler to remove the strong red tones.

5	 Drag the Lift master wheel left until the shadows of the waveforms in clips 01 and 02 
more closely match.

6	 Drag the Gamma master wheel right to brighten the image and increase contrast in 
the details.

7	 Drag the Gamma color wheel indicator away from red until the rhinos appear more 
neutral in color.

Before match

After match

Automatic shot matching is useful for quickly realizing an approximation of a match 
to create a starting point for manual match grade and to provide quick demonstrations to 
clients. But ultimately, you should still assess the image and check its video scopes to 
confirm an accurate match. If necessary, perform manual adjustments with the grading 
tools to refine the match.
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Matching Shots Using Stills
Stills have a variety of functions in Resolve, as you will learn in lessons throughout this 
book. One of the most direct uses of stills is for visually comparing clips in the viewer.

By superimposing a still, or snapshot, of a previous clip onto a current clip, you can visually 
assess their differences and similarities in contrast, saturation, and color dominance.

In this exercise, you will use stills to manually match clips.

1	 In the green flag-filtered timeline, select clip 05.

In the 02 Balanced Timeline, this clip already has its tonal range and balance set via 
the Primaries wheels.

2	 Right-click in the viewer, and choose Grab Still.

3	 Double-click under the still that appears in the gallery and label it Match Reference.

NOTE The numbers under the stills refer to the timeline track, the clip 
number, and the number of stills generated for that clip.



38 39Matching Shots Using Stills

4	 In the timeline, click clip 06. You will use the Primaries Bars and the Parade scope to 
match this shot to the still.

5	 In the Scopes pop-up menu, choose Parade. This representation of the image 
is similar to that of the waveform scope but with the luminance value of all three 
channels represented separately.

6	 In the gallery window, double-click the Match Reference still.

You should now see the two clips in the viewer, separated by a wipe line that 
you can drag.

TIP You can invert a wipe using the keyboard shortcuts Option-W (macOS) or 
Alt-W (Windows). Doing so will switch the frames for a reverse reference view.
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The shot of the man by the fence is much cooler than the still with the men and the 
horse. The Parade scope, which is also split in half, reveals this difference.

The channel traces on the reference still are much lower, which is an indication of 
higher contrast, and the reduced impact of the blue channel in the upper midtones and 
highlights produces a warmer look for the shot because the complementary color of 
blue in the additive color space is yellow. 

7	 In the node graph, change the label of node 01 in clip 06 to Match.

TIP Labelling nodes has many benefits. It clarifies the grading workflow by 
specifying each node’s task, which enables you to make faster adjustments as 
you grade. Labels are also great for inserting reminders for future necessary 
returns to the clip grade.

To label nodes more quickly, consider creating a custom keyboard shortcut. 
Open DaVinci Resolve > Keyboard Customization. Find the Label Selected 
Node command in the Commands list (use the search field at the top, if 
necessary), and press the keyboard shortcut you wish to associate with the 
command. The Tab key is a good option because it is not assigned to any 
default command.
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8	 In the Primaries palette, switch the mode to Primaries Bars.

9	 To match the shadows, drag the Lift Y (luminance) bar down until the shadows of clip 
06 match the shadows in the still. Keep your eye on the green parade, in particular, 
and aim to set the lowest point of clip 05’s trace (the man and dog) to a similar level as 
the shadow in clip 06.

TIP Use the scroll wheel of your mouse to adjust the Primaries Bars with 
more precision.

The next step is to address the overall balance to match the reference.

10	 Drag down the Blue Gain bar until the tops of the blue parades align.

11	 Drag up the Red and Green Gain bars to match the warmer reference look.

12	 To address the coolness in the shadows of the mountains, drag up the Red Lift bar.

Finally, tweak the Gamma bars to offset any remaining color inconsistencies between 
the two images.

13	 While keeping an eye on the middle pattern of the traces, drag up the Red Gamma bar 
and lower the Blue Gamma bar.

The result is a quick matching of the two clips using the Primaries Bars.
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14	 To turn off the reference wipe view, in the upper-left of the viewer, click the Image Wipe 
button or right-click in the viewer, and choose Show Reference Wipe.

15	 Toggle the grade bypass to compare clip 06 before and after the manual 
matching adjustment.

Before match

After match

With the clips matched, you can now apply creative grades to them and continue to 
see consistent results. 

16	 Select clip 05.

17	 In the Node Editor, locate the Contrast node and click the number 02 in the lower-left 
corner to enable it. The image in the viewer will shift to display deeper shadows and 
more detailed midtones.

18	 Select the Contrast node and choose Edit > Copy, or press Command-C (macOS) or 
Ctrl-C (Windows). 

19	 Select clip 06.

20	 Right-click the Match node and choose Add Node > Add Serial.
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21	 Select the newly created node and choose Edit > Paste or press Command-V (macOS) 
or Ctrl-V (Windows).

Clip 06 adopts the same level of contrast due to the successfully matched tonal ranges 
and colors in the first node.

NOTE The Y (luminance) bar of the Primaries Bars affects the image differently 
than the Primaries master wheel. The master wheel affects all RGB channels, 
which impacts saturation, whereas the Y bar targets only luminance.

When using stills for shot matching, your grading becomes even more precise when used 
in conjunction with video scopes. The scopes display a precise measure of the chroma and 
luma values of each frame, thereby allowing you to make very precise adjustments.

Stills have the additional benefit of carrying the grading data of the clips they were 
generated from. In later lessons, you will copy this data as a starting point for grading other 
clips in the Timeline.

Comparing and Matching Shots Manually
Unlike using the still wipe as in the previous exercise, you can grab a reference from any 
clip in the timeline without generating a still in the gallery. In this exercise, you will extract a 
reference directly from the timeline and match the images using custom curves.

1	 In the green flag-filtered Timeline, click clip 04. You will match this clip to the previously 
balanced clip 03.

2	 Review the Parade scope for clip 04.

You can see a distinct inconsistency in the shapes of the three channels. The red 
channel has the widest spread, extending beyond the green and blue channels in 
both the shadows and highlights. The blue channel’s highest point is almost level with 
the green channel’s, even though the blue channel is far more compressed within the 
midtone range.
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When shot matching, the goal is not to spread out the parade channels to match each 
other. Instead, you must study the relationships of the three channels in the parade and 
try to recreate those relationships in the clip that you are matching.

3	 Click clip 03 and review the channel relationships within its parade.

The most obvious difference is in the overall spread and contrast of the channels. The 
shadows extend to the bottom of the graph, while the red shadows actually touch the 
black point line (0).

In this situation, visual evaluation of the graph is vital. By understanding the context of 
the image, you can choose to ignore certain properties of the graph. Clip 09 contains a 
variety of elements that are not visible in the close-up in clip 10. The trees and field 
silhouetted against the mountains are portrayed as bunching at the bottom of the 
parades. You can ignore such elements when using the parade for shot matching.

4	 Click clip 04.

5	 Right-click clip 03 and choose Wipe Timeline Clip.

Both clips become visible in the viewer at the same time, divided by a wipe line.

TIP Quickly toggle the wipe on and off by pressing Command-W (macOS) or 
Ctrl-W (Windows). Some colorists set their reference to fill up the whole screen 
and toggle the wipe continuously as they match the grade in the active clip.
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One way to help you focus on relevant elements of the parade is to reframe the 
reference clip within the viewer. Clip 03 is a much wider shot than clip 04, so you can 
zoom in and reposition it for better reference.

6	 In the middle palettes, click the Sizing button to open the Sizing palette.

7	 In the palette’s upper-right corner drop-down menu, choose Reference Sizing.

The reference sizing applies the transform changes only to the reference image in the 
viewer, not to the actual clip in the timeline.

8	 Use the sizing controls to zoom into the reference image (by a factor of about 8x).
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9	 Pan the image to the left and tilt the image down until the framing starts to 
match clip 04.

These transform changes place the reference image into a much better position for 
both visual reference and for the Parade scope.

The side-by-side parade comparison reveals that the reference image is brighter 
overall with substantially more influence of the red color in the highlights. The overall 
spread of the green and blue channels is satisfactory, although they also need to be 
raised uniformly.

Remember, when matching, it is impossible to recreate the exact shape of the graphs 
themselves. Instead, you should focus on matching the height, depths, and the midtone 
distributions of the graphs.

10	 In the Node Editor, rename node 01 as Match.

11	 Open the Custom Curves palette. Let’s perform a few adjustments to see how curves 
affect the parades.

12	 Isolate the R curve and drag the black point up and the white point left until the red 
channel in both parades has an equal spread.
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13	 Isolate the G curve and drag the white point to the left.

As you drag the green control point, the two other channel parades shift to 
compensate, thereby affecting the output of the entire image. This happens because, 
by default, Resolve tries to keep the luminance of the image constant when you 
change individual RGB channels in the Custom Curves and Primaries Wheels palettes. 
This behavior is usually advantageous because it maintains the luminance of the image 
and allows you to adjust only the colors.

However, when shot matching, this behavior can be obstructive. To manipulate each 
channel independently, you need to indicate to Resolve that you do not wish to 
maintain a constant luminance.

14	 Open the Primaries palette, and choose Wheels as the mode.

15	 In the adjustment controls, drag Lum Mix down to 0.

TIP In the Project Settings, you can set Lum Mix to default to a value of 0 on 
every clip. Go to General Options > Color and choose Luminance Mixer 
Defaults to Zero.

16	 With the channels behaving independently, you can attempt to match up the curves 
once again. First, reset the Custom Curves palette.

TIP When using the master wheels, you adjust the luminance together with 
the RGB channels, which impacts the saturation of the image. To adjust only 
luminance without altering saturation, Option-drag (macOS) or Alt-drag 
(Windows) the master wheel or the indicator inside the color wheel.

17	 Isolate the R curve again and drag the black and white points until the red channel in 
both parades has an equal spread.
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18	 Isolate the G curve again and reposition the black and white points to align the trace 
in the parade.

19	 Isolate the B curve and reposition the black and white points to align the trace in 
the parade.

It appears that the parades now equally match each other, but the colors in clip 04 still 
do not match the reference in the viewer. This is because you have been focusing only 
on the highlights and shadows of the images. The midtones are equally important and 
can have a profound impact on image appearance.

Notice the bunching occurring in the lower midtones of the channels. It represents the 
mountains in the image. Though the red and blue channels are aligned, the green 
channel is showing a substantial mismatch between clips 04 and 05.

20	 Add control points to the green curve and drag them until the midtones of the green 
channel line up more accurately.

The match between the two parades results in a satisfactory visual similarity in the 
mountains and the sky. However, you can now continue to assess the match visually 
and further refine the result.
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The close-up shot could use some contrast to create greater depth between the 
mountain ranges in clip 04.

21	 In the adjustment controls, tweak the Contrast.

The depth is now accurate, but the contrast change results in the colors looking 
more saturated.

22	 In the adjustment controls, reduce the Sat until you get a good visual match.

23	 Open the Sizing palette. In Reference Sizing mode, click the reset arrow to return the 
reference image to its original placement.

If you do not reset this, all future reference images, including wiped stills from the 
gallery, will have the same transform placement in the viewer.

24	 Disable the image wipe.

25	 Toggle between clips 03 and 04 to verify that the match is successful.

When matching contrast between clips, you aim to equalize the heights and depths 
of the pixel spread and match contrast bunching. By displaying an exact readout of 
the RGB values of each clip, scopes can help you remove the guesswork that might 
accompany the minute tweaking of midtone ranges and allow you to approach the 
image from a more empirical, yet creative mindset.

Using Split-Screen Views to Compare Multiple Clips
An alternative method of visually comparing clips within the viewer is using a split-screen 
display. Instead of overlaying the still of a single image, you can display the frames of 
multiple clips side by side. The frames you use could be from other clips in the timeline, 
stills in the gallery, different versions of grades, or other clips in the same group.

This comparison method is especially effective when you already have a collection of clips 
that are similar in appearance, and you wish to examine a wider visual reference of a scene 
or environment.

1	 In the green flag-filtered timeline, click clip 07. This clip is already normalized and 
balanced with custom curves.

2	 Shift-click clip 10 to highlight clips 07 to 10.
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3	 Right-click in the viewer, and choose Split Screen > Selected Clips to display all four clips. 
For better visibility, press Option-F (macOS) or Alt-F (Windows) to enlarge the viewer.

4	 In the viewer, click the upper-right image to select clip 08 on the timeline. The 
selection is indicated by a white outline in the viewer.

Changes made to the color page palettes will impact whichever clip is actively 
selected in the split-screen view. You can perform quick grade matching by switching 
between clips in split-screen view, visually comparing them and making quick 
adjustments in the color wheel and curves.

Although reading the scopes and evaluating their data can be a straightforward 
process, you will need practice to acquire a level of finesse to accurately adjust the 
colors in the highlights, midtones, and shadows. Shot-matching is a highly valued 
skillset that requires plenty of experience and patience, so keep at it!

Self-Guided Exercises
Complete the following exercises in the green flag-filtered 02 Balanced Timeline to test 
your understanding of the tools and workflows covered in this lesson.

Clips 08, 09, and 10—Match these clips to clip 07 using any of the methods covered in 
this lesson.

When you’ve completed these exercises, open the 04 Completed Timeline to compare 
your matching to the Match node in this “solved” timeline.
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Lesson Review
1	 How do you prevent changes made to one color channel from affecting the waveform 

trace of the other two channels?

2	 How can you filter the timeline to show only clips with a flag?

3	 When performing an automatic shot match, you might right-click the clip you have 
selected and not see “Shot Match to this Clip” in the contextual menu. Why?

4	 Yes or no? It is possible to use a timeline clip as a reference in the viewer without first 
creating a still.

5	 Which viewer mode allows you to see multiple clips in the viewer at the same time?
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Answers
1	 Set Lum Mix to 0.

2	 Click the Clips button and choose Flagged Clips.

3	 The clip you have selected is the one that will be receiving the automatic shot match 
adjustment, so “Shot Match to this Clip” cannot be an option. Right-click any other clip 
on the timeline and “Shot Match to this Clip” will appear in the contextual menu.

4	 Yes. To do so, right-click a clip in the Timeline, and choose “Wipe Timeline Clip”.

5	 Split-screen mode allows you to see multiple clips in the viewer at once.
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Correcting and 
Enhancing Isolated Areas

After you’ve completed balancing and shot 
matching, you will want to target details in 
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This is the secondary color-grading stage.
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some of the common applications of 
secondary grading using qualifiers and 
Power Windows. Your goal is to isolate 
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the viewer’s eye.
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In the second part of the lesson, you will use more nuanced tools to clean up overcast (or 
overblown) skies, adjust regions of an image based on hue, and calibrate skin tones to 
enhance their warmth and smooth their details. Throughout the lesson, you will also 
employ some of the tools available in the OpenFX panel to see how subtle adjustments 
can exert enormous effect on the emotional impact of an image.

Controlling the Viewer’s Eye
A film’s musical score and sound effects can have a resounding impact on audience 
perception. Similarly, color and light play a critical role in manipulating the way an audience 
interprets a scene. In this lesson, you will focus on the fine art of shaping light to control 
the viewer’s eye.

Drawing Attention Using Windows and Saturation
A simple alteration can dynamically reimagine the composition and mood of a shot by adjusting 
the saturation of colors in a specific part of the frame. In this exercise, you’ll enhance the 
saturation in the vibrant, sunlit area of a field to give one scene a more dramatic feel.

1	 In the Project 01 - Disunity Documentary project, open the 03 Matched Timeline.

2	 In the Clips pop-up menu, choose All Clips to remove the green filter in the timeline.

3	 Filter the timeline to show only those clips with yellow flags.

4	 In the yellow flag-filtered timeline, click clip 07. The clip already has a first node 
labelled Normal.
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5	 Create a second node and label it Sunlight.

6	 In the central palettes toolbar, click the Window palette button. You will use a Power 
Window to specify the region of the image you will be grading.

7	 Click the Linear window button to activate it. It is the square-shaped window at the top 
of the default windows list.

When activated, the button will have an orange outline around it, and you will see the 
outline of the window in the viewer.

8	 Double-click next to the window thumbnail and enter the name Sunlight Area.

9	 In the viewer, move the four edges of the window to select the entire horizontal middle 
of the image where the sun hits the ground. Make sure to extend the shape to mimic 
the path of the sunlight.

10	 In the viewer, drag the red points on the window outline to increase the softness 
around its upper and lower edges.

11	 To review your Power Window selection in the viewer, click the Highlight button in the 
upper-left corner of the viewer.

12	 Click the Highlight button again to disable highlight mode and return to your full frame.

With the secondary selection created, you can begin to grade the image.
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13	 In the Color Wheel palette, increase the Sat to 65 and the Contrast to 1.1.

TIP Toggle the window outline in the viewer by pressing Shift-~ (tilde) on your 
keyboard. You can use this keyboard shortcut to hide the outline and better 
see the impact of your grade on the image. 

14	 With the Sunlight node still selected in the Node Editor, right-click it and choose Add 
Node > Add Outside or press Option-O (macOS) or Alt-O (Windows). This inverse 
selection will allow you to grade the environment around the sunlight.

15	 Label node 03 as Outside.

16	 Drag the Gamma master wheel (-0.05) to decrease the brightness, and minimize 
Contrast (0.900).

Doing so creates a dark framing effect around the figure of the man and further draws 
the eye toward the sunlight on the field.

Before

After
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Mimicking a Shallow Depth of Field
ResolveFX are a series of filters included with DaVinci Resolve that enable you to adjust 
the physical or visual properties of your footage in creative ways that are often not possible 
using common grading tools.

NOTE The following exercise requires DaVinci Resolve Studio to complete.

The Tilt-Shift Blur effect imitates the look of a shallow focus lens to direct audience 
attention. However, you can also apply it to achieve effects that a lens could not—such as 
reducing the focus of elements contained within the same field and realizing a greater level 
of control over the blur type, amount, and angle. You will continue to work on clip 05 in the 
yellow flag-filtered timeline.

1	 Create a new serial node (node 04) labelled Tilt Shift.

2	 Click the OpenFX button to open its panel.

3	 In the OpenFX panel, under ResolveFX Stylize, locate the Tilt-Shift Blur effect.

4	 Drag the Tilt-Shift Blur effect onto the empty Tilt Shift node.

The OpenFX library panel now displays a settings window in which you can tweak the 
Tilt-Shift Blur effect controls.

5	 In the settings panel, in the Depth of Field category, select Depth Map Preview to see 
where the matte is currently located.
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The matte represents the area where the effect is applied. Black indicates transparency, 
or the lack of selection in that area, whereas white represents full opacity, or a selected 
region. Gray implies semi-opacity and a diminished strength of selection.

Currently, the map is already placed level with the horizon and successfully targets the 
rhinos in the background. However, it is not an entirely realistic composite. The depth 
of field is too extreme at the top and bottom of the image, while maintaining focus on 
both the man in front of the camera and the rhinos hundreds of yards in front of him.

TIP Repeatedly select and deselect Depth Map Preview to visually assess the 
position of the Tilt-Shift Blur matte in relation to the image.

6	 Adjust the width of the matte by dragging the In Focus Range pointer to the right 
(0.330) to include more of the man in the focused range of the shot.

7	 Adjust the height of the matte by dragging the Center Y value down (0.460) to ensure 
that the area directly behind the rhinos begins to go out of focus.

8	 Deselect Depth Map Preview.

9	 Slightly decrease the Near Blur Range (0.630) and Far Blur Range (0.630) values to 
control the severity of the blur and make it look more realistic.

Before

After 
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Focusing Attention with Vignettes
In classic filmmaking, a vignette refers to the darkened, soft edges of a film frame caused 
by the lens and matte box. With the advancement of camera equipment, and especially 
with the advent of digital film, natural vignettes are no longer an issue. However, their 
absence has caused an appreciation for the framing service they provided, and vignettes 
are now sought after for creative and compositing purposes as an effective method of 
directing the viewer’s eye.

In this simple exercise, you will apply a circle window to a shot and reduce the brightness 
of the frame around it to create a vignette around the central subject. You will continue to 
work on clip 05 in the yellow flag-filtered timeline.

1	 Create a new serial node labeled Vignette.

2	 In the Window palette, click the Circle window button.

3	 Double-click the layer name field next to the circle window, and type Vignette Frame.

4	 Vignettes are usually elliptical to reduce their visibility and enable easier blending into 
the footage, as compared to shapes with straight lines and corners.

Use the onscreen transform controls to reposition and rescale the circle to completely 
fill the viewer frame. 

5	 In the onscreen controls, drag one of the red points to create a wide, soft edge around 
the selection.

In the Node Editor, the Vignette node thumbnail preview shows that you have selected 
the subjects in the center of the frame. To use the node as a vignette, you will need to 
invert this selection.

6	 In the Window palette, next to the circle window, click the invert symbol.
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7	 In the pop-up menu in the lower-left of the viewer, choose Off to hide the 
window outline.

8	 Now that the vignette shape is made, you can proceed to use the grading tools to 
create a vignette effect on the image. Reduce the brightness of the selected area by 
dragging the Gamma master wheel to the left (-0.05). Using the gamma tonal range 
will ensure that you are not darkening overly bright areas of the footage (such as the 
overcast sky), which would make the vignette too obvious.

TIP Vignettes are most effective when they are not noticeable. If you are 
concerned that your vignette may be too prominent, review the thumbnail of 
the clip in the timeline to determine whether the vignette is too pronounced in 
the corners. If so, in the Key palette, lower the Vignette node’s Key output 
Gain to reduce its strength and further soften the Power Window’s edges to 
more seamlessly blend it into the image.

You can also save the vignette you just generated for future use as a preset.

9	 In the Window palette, ensure that the appropriate window (Vignette Frame) is selected 
in the window list.

10	 In the upper-right corner of the palette, click the Options button, and choose Save as 
New Preset.

11	 Enter the preset name as Vignette.

From now on, when you want to apply this exact shape to a node in any other clip, you 
need only access the Window palette option menu, and choose the preset Vignette.

This basic adjustment allowed you to reduce the brightness of the majority of the 
image to focus attention on the subjects in its center. The softness around the vignette 
is crucial to ensure that the adjustment does not draw undue attention to itself.

TIP A vignette preset is also available in the OpenFX library (in the ResolveFX 
stylize category) for quick application of a simple, customizable vignette.

It takes careful assembly and adjustment of secondary grading to draw the eye of the 
audience to the subject matter without calling attention to the image manipulation. When 
an audience becomes aware of the colorist’s handiwork, it can break the illusion of realism 
and compromise viewer involvement with the content.
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Using the Mini Panel—Power Windows
Using a DaVinci Resolve Mini Panel offers a great deal of time-saving potential when you’re 
working with Power Windows. To make a Power Window on the Mini Panel, you have a few 
methods available. When you’d like to apply a Power Window to a node, press the Windows 
button in the upper-left of the panel. The 5-inch screens will display a row of Power Window 
presets along the top. 

Select the desired window preset and then press Window On to active it in the node. 

Then use the knobs under the screens to simultaneously adjust the size, pan, tilt, aspect 
ratio, softness, and opacity of your window. With practice, you will find that this is a faster 
method for calibrating Power Windows than using a mouse.

It’s important to note that Power Windows also extend to the node controls on the Mini 
Panel. At the upper-right of the panel, node controls allow you to create several types of 
common nodes. You’ll learn more about them throughout this book. 

Right now, you’ll want to pay attention to the node + buttons with which you can create a 
new serial node with a Power Window already activated, thereby turning two commonly 
used shortcuts into one. Pressing the Node + Circle button, for example, creates a new node 
with a circular Power Window.
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Sharpening Key Elements
The Blur palette in the central palettes of the color page also contains a Sharpening mode. 
It works best when used conservatively and applied at the end of a grade. Too much 
artificial sharpening can stand out for the wrong reasons. When used precisely, sharpening 
can make details look extremely dynamic and draw the viewer’s eye in a desired direction.

1	 In the yellow flag-filtered timeline, click clip 06.

The clip begins with a man’s hand obscuring the shot. In such cases, it is a good idea 
to play through the clip until you find a better point for grading and adding effects.

2	 In the viewer jog bar, drag the playhead to the center of the clip.

3	 Create a second node called Sharp.

4	 In the central palettes, open the Blur palette.
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5	 In the pop-up menu in the upper-right corner of the palette, choose Sharpen.

The main control in the Sharpen palette is the Radius. Dragging it upward will blur the 
image, and dragging it down will sharpen the edges of high-contrast detail.

6	 Reduce the Radius to 0.40 by dragging down any of the three channel sliders under 
the Radius heading. The three channels are ganged together, so adjusting one will 
equally alter the other two.

Although it is easy to see that the engravings become more detailed, the impact that 
sharpening has on the rest of the image is more difficult to perceive.

7	 Above the viewer, click the Highlight button, and then click the A/B Difference button in 
the right corner to display the edges found by the sharpening adjustment. You can also 
toggle this display on and off by pressing Command-Shift-H (macOS) or Ctrl-Shift-H 
(Windows).

8	 In the Sharpen palette, increase the scaling to 0.5. Doing so will multiply the result of 
the Radius adjustment.

The adjustments add a satisfactory level of detail to the engraving, but add too much 
detail to the gun barrel and the smoke coming out of it. You can limit the sharpening 
effect using the Coring Softness and Level controls at the bottom of the palette. Start 
by increasing the Level control to set a threshold for the sharpening.

9	 Increase the Level (around 10-15) until the detail in the smoke and on the barrel of the 
gun disappears.

10	 Increase the Coring Softness to around 5 to recover some of the sharpening between 
the level threshold setting and the most detailed areas.

To see the results on the image, you can disable the difference highlight.
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11	 Click the Highlight button above the viewer, or press Command-Shift-H (macOS) or 
Ctrl-Shift-H (Windows).

12	 Press Command-D (macOS) or Ctrl-D (Windows) to bypass the Sharp node and 
compare your results to the original image.

TIP You could also achieve this effect using Sharpen Edge ResolveFX in the 
OpenFX palette. This filter includes an edge display in the settings controls, as 
well as other fine-tuning parameters.

Although the sharpness looks very nice on the engravings, it’s causing some ringing on the 
hand in the left corner of the screen, as well producing some pixel artifacting on the 
shotgun shell at the start of the clip. However, you can use a window to limit an effect to a 
specific area in the shot.

Tracking Obscured Objects
Adding a simple circular window to the Sharp node will allow you to confine the sharpening 
to the engravings and shotgun barrel.

1	 In the Sharp node of clip 04, create a circle window, and name it Barrel Detail.

2	 Resize the circle, and place it directly over the engravings on the shotgun.

3	 Make the circle narrower and rotate it so it confines the sharpening effect to just the 
engravings on the handle.

4	 Drag the red control point on the window to soften the edges of the mask. The 
sharpening is now successfully isolated to the detail on the handle. 

However, scrubbing through the clip will reveal that this is a handheld camera shot, and 
the shotgun is moved as it is loaded. You’ll need to track the window for the effect to 
follow the engravings.
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5	 In the central palettes toolbar, click the Tracker button next to the Window button.

6	 With the playhead still located in the center of the shot, and your circle window placed 
on the detail just under the barrel, click the Track Reverse button.

The analysis runs backward through the shot, recording the motion data for the gun 
barrel until the first frame of the clip is reached.

TIP It is common practice to track from the center or the end of a clip when 
doing so will provide more reliable tracking data.

7	 When the tracking is completed, in the upper-right corner of the tracker graph, click the 
Keyframe button to return the playhead to the central keyframe.

8	 Click the Track Forward button to perform the rest of the track analysis in the second 
half of the clip.

As the analysis runs, the window will be disconnected from the barrel detail due to the 
interference of the man’s hand. This disconnection can occasionally occur during 
tracking, and it is useful to know how to quickly fix the issue.
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In the Tracker palette, you can see a visual representation of the amount of motion 
applied to each transformation. Each colored line corresponds to the colored 
transformation label above the Tracker palette. Based on the sudden and dramatic 
movement on the pan and tilt graph lines in the second half of the graph, it is clear 
that the tracking data becomes distorted. To fix the track, you must first remove the 
bad tracking data.

9	 Drag within the tracker graph to draw a dotted selection outline around the bad 
tracking data.

10	 In the Tracker palette, in the Options menu, choose Clear Selected Track Data.

The tracking data in the selected area of the tracker graph is removed. Knowing that 
the track cannot be analyzed with the obstruction, you will need to manually adjust the 
movement of the window during the time that the hand is in the shot.

11	 Switch the tracking to Frame mode.

In Frame mode, any changes you make to the window in the viewer now will be 
recorded as a keyframe, as opposed to the Clip mode, which applies a uniform change 
to the window’s position in relation to the key clip.
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12	 In the viewer, drag the playhead to a point in time where the obstruction has passed, 
and the area appears to be trackable again.

13	 Manually reposition the window to the area of the barrel that you were previously tracking. 
Use the anchor point in the center of the window as a visual guide, if necessary.

A new keyframe appears in the tracker graph, and tracking data is automatically 
generated between it and the last reliable tracked moment.

14	 Click the Track Forward button to perform the rest of the track analysis.

Using the Mini Panel—Tracking
You can use the Mini Panel to track Power Windows and avoid using your mouse and 
keyboard by pressing the Tracker button at the upper-left of the panel.

By enabling Frame mode, you can keyframe Power Windows. Pressing the Left Arrow and 
Right Arrow keys will display more advanced keyframe controls.
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Fixing Overcast Skies
Capturing footage with skylines in-camera can sometimes be problematic. Subjects in the 
foreground usually require a substantial difference in their exposure levels compared to the 
sky. Opening the aperture or raising the ISO value usually results in better exposure in the 
foreground but also creates a blown-out sky.

In such cases, the best method of correction is to target the sky with a keying tool, such as 
the qualifier, and tweak the color using standard grading tools; or extract the sky altogether 
and composite an image/video of another sky in its place. In this exercise, you will practice 
the first method of sky correction.

1	 In the yellow flag-filtered timeline, click clip 01. This clip was previously balanced and 
matched and now needs secondary grading to address its overcast sky.

2	 Create a fourth corrector node called Sky.

3	 With the Sky node selected, in the central palettes, open the Qualifier palette.

4	 In the viewer, using the qualifier tool, click a portion of the sky. The thumbnail 
representation of the image in the Sky node will change to show the qualifier selection.
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To perform further work with this selection, you must change the viewer mode to 
display only the qualifier extraction.

5	 Switch the viewer to Highlight mode by clicking the Highlight button in the upper-left of 
the viewer. Ensure that the mode is set to Highlight in the upper-right corner.

The viewer now shows what the qualifier has selected by making the sky visible and 
turning everything else gray. This is a way to display the image matte.

Often, when a selection is first made using the qualifier, it will miss sections or will 
include unwanted areas. You can use the HSL Qualifier palette to fine-tune the 
selection by dragging the Hue, Saturation, and Luminance sliders to define exactly 
what those respective values should be.

6	 Toggle the Highlight button to compare the original image with the selection. You will 
see that areas of sky between the branches of the trees need refinement.

TIP It can occasionally be unclear where you should click with the qualifier 
tool to identify the optimal starting selection. The best strategy is to click and 
drag close to an area from which you are trying to extract the selection. In this 
case, the best area is on the horizon directly above the mountains. Once the 
selection has a clean edge, you can easily isolate the remainder of the area 
using windows.

A good starting point to refining the HSL selection is to disable each value one by one 
to determine if its absence could improve the qualifier quality.
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Using the Mini Panel—Qualifiers
After you make an initial qualifier selection, you can use the Mini Panel to refine it. When you 
press the Qualifier button in the upper-left section of the panel, the two 5-inch screens and 
their surrounding buttons and knobs become the controls you’ll use to continue making 
adjustments.

At first, you’ll see the controls for Hue on the left screen and Saturation on the right. In the 
upper-left section of the panel, press the Right Arrow button to navigate to the luminance 
controls. In certain tools, you must use the Left Arrow and Right Arrow buttons to access all 
the functions that a specific tool offers.

One more push of the Right Arrow button will bring you to the Matte Finesse tools, which 
you will use later in this exercise.

7	 Click the orange toggle next to Hue to disable it.

Doing so has a positive effect on the selection. The horizon becomes refined and more 
areas of sky in the trees are included in the qualifier result. This result makes sense 
because the blown-out white sky is mostly made up of luminance data, not hue.

8	 Drag the left side of the Luminance selection (Low) to refine the horizon selection. Aim 
to include the darker areas of sky between the trees.

The current focus is on ensuring the cleanest possible selection along the horizon; so, 
for now, you can ignore any other regions in the image that are also selected, such as 
the horses.
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9	 In the upper-right of the viewer, click the Highlight B/W button to switch to a black-and-
white representation of the matte. This is the traditional appearance of mattes, with 
white indicating full opacity and black representing transparency.
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10	 You can adjust the matte finesse controls in the HSL qualifier to further refine the 
selection. Adjusting Clean Black will reduce some of the minor spill-off occurring in 
the trees under the horizon. A setting of 20.0 should be enough for a satisfactory 
reduction.

11	 Likewise, tweaking Clean White (20.0) can amplify the white between the tree 
branches for a cleaner overall result.

The clarity of the qualifier will often depend on the nature and quality of the footage. In 
this case, you might experience minor difficulty in getting a clean extraction from both 
mountain tops due to the difference in focal length between them. When one mountain 
has a clean key, the other appears too soft and vice versa. In such cases, the best 
approach is to break up the keying process into several nodes and combine them 
using a key mixer.

NOTE You can see the results of using a key mixer to clean up the sky selection 
on this clip in the 04 Completed Timeline. Open the timeline, right-click the clip, 
and under Local Versions, choose Mixed Key to see the version of the node 
pipeline with the key mixer.

Using Windows to Limit Qualifiers
If the HSL qualifier selection has extracted areas of the image that are not the sky, you will 
want to exclude them from the final matte.

1	 Click the window palette next to the Qualifier palette.

2	 Click the Linear Window button to activate it. You will see the outline of the window in 
the viewer.

3	 Double-click next to the window icon, and label it Sky Window.

4	 Drag its corners around the sky selection to exclude the lower regions of the matte.
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The sky should now be successfully selected and ready for color adjustment.

5	 Click the Highlight button to disable the matte preview.

6	 Drag the Gain master wheel to the left (0.95) to reduce the overexposure in the 
sky. By turning the white pixels gray, you will make them more receptive to hue and 
saturation changes.

7	 Drag the Gain color wheel toward cyan/blue to introduce blue into the sky.

TIP You could also use the Color Generator in the OpenFX panel to replace 
the sky color. It overwrites all the color data in a node with a single color 
hue without regard for any existing RGB data. It is ideal for working on 
elements that require a consistent color, but using it might not be optimal 
when you are trying to retain some of the natural variations of the hues and 
shadows in a selection.
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Finally, to soften the edges around the tops of the hills, you can gently blur the edge 
between the black and white portions of the matte.

8	 In the Qualifier palette, increase the Blur Radius (10.0) in the matte finesse controls.

A gentler edge will ensure a more organic-looking grade and hide any imperfections 
in the selection.

Adding Atmosphere
When you look into the distance through several miles of air, you can see the atmosphere 
reveal itself. In an air-polluted city, the atmosphere may have a hazy white, brown, or 
orange look; whereas, on a clear day, you would see a soft blue.

When enhancing a sky or replacing it altogether, you need to blend a blue hue into the 
shot’s horizon to replicate that atmospheric refraction. Otherwise, the replacement sky 
might end up looking fake against the horizon.

1	 In the Node Editor, select and then right-click the Sky node and choose Add Node > 
Add Outside or press Option-O (macOS) or Alt-O (Windows). This inverse selection will 
allow you to blend the color of the sky into the horizon of the image.

2	 Label node 05 as Outside.

TIP You may need to pan and zoom out on the node graph by dragging with 
the middle mouse button to pan and dragging the slider above the Node 
graph to zoom out.

3	 With the Outside node selected, in the list of the Window palette, click the Gradient 
Window button.

An outline of the gradient controls appears in the viewer in the form of a line with a 
perpendicular arrow extending from it.
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4	 In the Window palette, double-click the layer name field next to the gradient icon, and 
type Atmosphere.

This gradient window works a bit differently compared to the other windows that you 
have created. Instead of defining a shape, you position a starting point and drag the 
arrow in the direction of the gradient fall-off. The further you drag the arrow, the softer 
the gradient will be.

5	 Adjust the top of the gradient (the horizontal line) to start at the top of the distant 
mountain, and drag the arrow to taper off the gradient toward the bottom.

6	 Drag the Offset master wheel in the direction of cyan, but not as far as you did for the 
sky change. The goal is to give the distant mountain a slight blue tint to convey the 
blue atmosphere in front of it.

7	 Press Command-D (macOS) or Ctrl-D (Windows) to compare the results before and 
after your atmosphere addition.

The gradient looks good in the distance but covers too much of the foreground 
mountain. You will want to create a new shape to select everything that you don’t 
want altered by the atmosphere grade.

8	 In the Node Editor, disable the Outside node by clicking its number (5) or pressing 
Command-D (macOS) or Ctrl-D (Windows). Doing so will allow you to continue work 
without being distracted by the blue grade.

9	 While still in the Window palette, click the Curve button.
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10	 In the viewer, click around the foreground hill and the lower-half of the frame to create 
a custom shape around it. To close the loop and define the shape, click the first point 
that you created.

TIP When creating custom windows, click to create linear points and drag to 
create rounded Bézier curves. To delete a point, select it and press the Delete 
or Backspace key or middle-click the point with your mouse.

11	 Double-click the layer name field next to the Curve button and enter the name 
Foreground. Enable the Outside node to see the result.

The cyan grade now affects both the background mountain and the entirety of the 
custom shape. By default, all windows are additive. You will need to indicate that you 
wish to subtract the selection from the final result.

12	 In the curve field, next to the label, click the Subtract Mask button to extract this 
custom shape from the final output of the node.
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13	 To the right of the Window palette, adjust the Softness parameter to feather the edge 
of the Power curve. Drag the Inside and Outside fields to make the border of the 
window less aggressive between the two mountains.

TIP When changing the sky color, another technique is to apply a gradient 
window on top of the sky selection node. By tapering off the artificial color 
toward the original hues at the bottom, you can also achieve a realistic-
looking secondary grade.

Ordinarily, overblown skies can be addressed on the set using ND filters and focusing 
additional lighting on your talent. However, this solution may not always be an option for 
smaller productions or documentaries. In such cases, secondary grading becomes a viable 
option. It keeps the filming process light while ensuring a good shot at the end of the 
post-production process.

Warping Color Ranges
The Color Warper allows you to adjust two parameters at once, producing quick results in 
an interface that encourages intuitive grading. It features two grids for changing either Hue 
and Saturation, or Chroma and Luma. Its mesh interface produces a smooth transition 
between hues, which reduces image artifacts. The Color Warper is helpful for enhancing 
the appearance of objects or areas with a distinct hue and can be combined with other 
secondary selection methods for optimal results.
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Warping Colors in the Viewer
The simplest way to interact with the Color Warper is through the color page viewer. This 
method works best on well-defined color ranges, such as for vehicles, clothing, or the sky.

1	 In the yellow flag-filtered timeline, ensure that clip 01 is selected.

2	 Create a new serial node at the end of your pipeline called Sky (node 06).

3	 In the central palettes, open the Color Warper palette.

TIP You can check which region of an image will be affected by a control 
point in the Color Warper by holding Option (macOS) or Alt (Windows) while 
clicking the control point. A highlight of the selection will appear in the viewer.

The Color Warper features a Hue-Saturation “spider web” mesh grid that you can 
adjust to warp the colors of the image. A vectorscope trace of the frame in the viewer 
is projected behind the grid to guide your selection.

The right side of the palette features advanced selection and pinning tools, which are 
used to achieve optimal precision.

4	 Click the Expand button in the upper-right corner to turn the palette into a 
floating window. 
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Drag the corners and edges to resize the window to your liking and drag the palette 
header to reposition it. The larger interface will make it easier to make precise 
adjustments in the grid. 

5	 Hover your mouse over the image in the viewer.

An orange crosshair appears in the Color Warper grid, corresponding to the hue over 
which your mouse is placed. Additionally, a yellow box appears on the nearest grid 
control point, indicating that it is the optimal point for adjusting that hue.

6	 While still in the viewer, move your mouse over the sky region of the image, click and 
drag to the right.

The sky becomes more saturated.

7	 Check the Color Warper grid and verify that a control point in the blue region has 
become highlighted and moved away from the center of the grid.
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The Color Warper features the same hue layout as the color wheels and offers the 
same saturation control. Moving a point closer to the center will desaturate a hue, while 
moving it outward will increase color intensity.

8	 While still in the viewer, drag in a circular motion to change the color of the 
sky to green.

Before

After

Rotating a selected color range around the Color Warper grid will change its hue. While 
dragging, continue to maneuver toward or away from the center to simultaneously 
adjust the hue saturation.
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The Color Warper allows for an incredibly simple method of controlling color hue and 
saturation directly within the viewer. As you likely noticed, the adjustment is optimal when 
the hue is kept close to the source color. If pushed too far, the grid mesh can begin to 
overlap itself, which can cause artifacts. In such cases, consider adjusting your selection 
method or using an alternative hue correction method like HSL curves or the qualifier.

Selecting Multiple Hues in the Color Warper Grid
The Color Warper’s true strength can be found in the variety of selection methods that 
allow you to achieve a clean grade. In this exercise, you will adjust the color of the dry 
grass on the ground to give it a healthier, greener appearance.

1	 Select the Sky node and press Backspace or Delete to remove it.

2	 Create a new serial node called Grass (node 06).

3	 In the viewer, click on an area of grass in the foreground of the scene and drag to the 
top and left (orange hue) to review the accuracy of your selection.

The result will show that the selection does not adequately capture the grass on the 
ground, while also spilling into undesired areas, like the rhinos.

TIP You can check which region of an image will be affected by a control 
point in the Color Warper by holding Option (macOS) or Alt (Windows) while 
clicking the control point. A highlight of the selection will appear in the viewer.

4	 Reset the Color Warper by clicking the reset arrow in the upper-right corner of 
the palette.
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5	 Hover your mouse over the foreground of the image and review how the crosshairs 
behave in the Color Warper.

You will see that the yellow box jumps between multiple hue columns and saturation 
rings. This suggests that the grass represents a wider range of hues and saturation 
values than can be captured with one click in the viewer.

6	 In the lower-left corner of the Color Warper palette, click the Hue resolution drop-down 
menu and set the resolution to 16.

The Color Warper grid now features 16 hue divisions, allowing for much more precise 
hue selection. By default, the hue and saturation resolutions are linked, though this 
behavior can be disabled by clicking the link icon next to the drop-down menus.

7	 Hover your mouse in the viewer to review the grass hues. 

They are mostly focused on control points in the three leftmost columns of the grid.

8	 Hover your mouse over the rhinos in the image. 

They are mostly represented by control points in the orange-leaning columns.

With this successful separation of target hues, you can now focus on grabbing a broad 
range of greens.
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9	 In the Color Warper grid, click and drag to select a range of green hue control points 
near the outer edge of the vectorscope trace.

TIP You can also hold Command (macOS) or Ctrl (Windows) to make multiple 
point selections when clicking or dragging. Right-click a control point to reset 
its position in the grid.

10	 Click any of the orange selected points and drag the entire selection toward a more 
vibrant hue.

Observe the surrounding environment in the scene to ensure you reach a realistic 
shade of green. Drag the selected control points toward and away from the center of 
the grid until you find a satisfactory saturation level. 
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Finally, you can use secondary selection tools to isolate your grade to one area of 
the frame.

11	 In the Window palette, create a linear window and name it Grass Matte.

12	 Drag the corners of the window around the grassy field in the foreground of the image.

The Color Warper adjustment is isolated to the grass, while keeping other elements, 
like the background and the dirt on the ground, unaffected.

Enhancing Colors Based on Luminance
The Color Warper’s Chroma-Luma grid allows you to simultaneously adjust the luminance 
and hue of a selected range. This opens up some creative options when working with 
bright areas, like skies, lights, and windows.

1	 In the yellow flag-filtered timeline, click clip 03.

2	 Create a new serial node called Sky (node 02).

3	 In the upper-right corner of the Color Warper, press the Chroma-Luma button.

The Chroma-Luma panel features many of the same controls as Hue-Saturation, though 
the control point interface is now a 3D cube mesh.
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The horizontal axis of the grid represents hues, while the vertical axis represents 
luminance. You will use this grid to add vibrant colors to the sky.

4	 In the viewer, click on a light area of the sky and drag down.

In color grading, changing luminance based on a hue can often lead to distortion. 
Therefore, it is important to keep Chroma-Luma selections exact and 
adjustments subtle.

5	 To improve selection precision, change the Chroma and Luma resolutions to 12.

You will next lock off the darker regions of the image to protect them from adjustments 
made to the sky.

6	 In the viewer, hover over the hill in the foreground and mountains in the background. 
The orange crosshair will indicate that the luminance range of those regions lies in the 
bottom two rows.

7	 Select any point on the row directly above the bottom of the grid.
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8	 In the Tools sidebar, click the Select Row button to expand the selection to the 
entire row.

9	 In the Tools sidebar, click the Convert Selected to Pin button to lock all the control 
points on that row.

Pinned points are indicated by a black outline. Adjustments made near a pinned point 
will not affect it, and the surrounding grid mesh will warp around it.

10	 At the bottom of the palette, drag the Axis Angle parameter (35.00) to determine the 
hues you will be introducing to the sky. Aim to achieve an orange/cyan balance.

As you do this, the waveform trace in the grid will rotate, revealing its 3D nature.

11	 In the viewer, click on a blue region of the sky and drag it down and to the right to give 
it a richer blue tone.

12	 In the viewer, click an orange area of the sunset and drag left to make the warm glow 
more pronounced.
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13	 Click on the center of the sky gradient and drag left and up to brighten and warm it.

Continue to make finer adjustments across the sky gradient in the viewer to smooth 
out any artifacting.

			   Before

			   After
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14	 If you start to see banding in the sky as a result of dragging a control point too far, 
select the point, and then click the Smooth buttons under the Chroma and Luma 
parameters in the sidebar.

This will nudge the point toward its original position, softening the grade and reducing 
artifacts. The Smooth buttons can be clicked as many times as needed for 
incrementally smaller nudges.

15	 When finished, copy the Sky node and paste it in a new node in clip 04.

16	 Tweak the Color Warper in clip 04’s Sky node to achieve a better match for the close-
up of the horizon.

			   Before

			   After

By rotating the Axis Angle (45.00), you can achieve a deeper red color in the sky.
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As you continue to work with the Color Warper, explore the remaining selection and 
pinning tools in the sidebar to gain a fuller understanding of how selections can be made 
faster, and with more precision. Review the completed grade on these clips in 04 
Completed Timeline to see how the luminance warp in this lesson was achieved.

Enhancing Skin Tones with 
Face Refinement
A common task for secondary correction is to make skin tones look more natural. Whether 
you are working with a fictional narrative or a documentary, the audience will be paying 
the utmost attention to the actions (and, therefore, the faces) of the people on the screen. 
With this much focus from the audience, you want to be certain that skin tones do not 
cause a distraction.

NOTE This exercise requires DaVinci Resolve Studio to complete.

In this exercise, you’ll start with a well-framed and properly exposed shot. The only issue is 
that the speaker is wearing a wide-brimmed hat on a sunny day, which is causing shadows 
that obscure her face. Your goal is to make her face stand out more and then address 
general imperfections using the Face Refinement effect.

1	 In the yellow flag-filtered timeline, select clip 02. In the Node Editor, you can see that it 
has already been balanced on the first node.

2	 Create a new serial node, and label it Face.

3	 In the ResolveFX Refine category, drag the Face Refinement effect onto the 
Face node.
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NOTE If you are not using DaVinci Resolve Studio, a watermark will appear 
over the image. You can dismiss the warning dialog and complete this 
exercise with the watermarked image.

Face Refinement includes a number of diagnostic and grading tools aimed specifically 
at enhancing the skin and details of a human face.

The effect analyzes the shot to automatically detect and track a moving face and to 
recognize and adjust individual features such as eyes, lips, cheeks, chin, and forehead.

4	 In the Face Refinement settings, click Analyze. Processing will take some time because 
the software detects the face and constructs a travelling matte.

When the analysis is complete, you will see a series of green trackers identifying the 
woman’s facial features.

To ensure the highest quality of selection, you should check the matte of the face 
before proceeding with any adjustments. The matte quality can be compromised when 
analyzing a subject whose skin tones closely match their hair, clothes, or surroundings. 
In this example, the subject fits all three of these criteria.

5	 Within the Face Refinement settings, click the Skin Mask header to expand it and 
select Show Mask.

6	 Deselect Show Overlay at the top of the settings to remove the green trackers from 
the viewer.
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7	 Zoom inside the viewer to get a clearer view of the subject’s face.

The selection is very clean overall. The only exception is the upper segment of the mask, 
which includes part of the tan hat that the woman is wearing.

Combining Windows with Face Refinement
To remove the unnecessary segment from Face Refinement, you will use a window to 
exclude the top of the matte from the selection.

1	 Move the playhead to the last frame of the clip.

2	 With the Face node still selected, open the Window palette.

3	 Create a new circle window.

4	 In the upper-right options menu of the Window palette, choose Convert to Bézier to 
transform the circle’s points into Bézier curves. Label the resulting curve window Face.
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5	 Adjust the points to fit around her face, paying extra attention to excluding the hat.

6	 To ensure the Face Refinement tool recognizes the newly created window, right-click 
the Face node and choose ‘Use OFX Alpha’ to deselect the internal alpha link.

7	 In the face refinement setting, deselect Show Mask.

8	 Enter the Tracker palette.

9	 Click the Track Reverse button to track the motion of her face backward 
through the clip.

10	 When tracking is completed, refine the shape of the Face window, if necessary. Return 
to the Face Refinement settings when you are finished.

TIP You can apply ResolveFX to an existing Corrector node or drag onto a 
connection line to create a ResolveFX node. ResolveFX nodes work slightly 
differently from normal Corrector nodes in that you cannot use grading tools, 
windows, or qualifiers on a ResolveFX node. They perform only the effect for 
which they were designed.

Improving Skin Quality
The bulk of the face refinement feature is about fixing skin tones. Skin tones might need 
adjustment for a variety of reasons:

General skin imperfections, such as variations of color, spots, dryness, oiliness, and so on— 
By applying the appropriate brightness, contrast, and blurring, you can reduce these issues 
and put the focus back on the performance.

Some skin types are prone to reflecting light with unpredictable tints—The most 
common variants are skin types that appear magenta or green under certain lights. The 
purpose of grading in this case is to remove the tint and match the performer to his 
surroundings and co-stars.
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Overpowering primary grade—When a shot has been extremely graded at the primary 
stage to look a certain way (for example, to make the environment look cold), the skin can 
end up looking dead as a result. These kinds of flat grades can drain the shot of life and 
look dull. By bringing back the skin tone, the shot once again becomes vibrant.

In this exercise, you’ll look at some of the commonly used settings of the face 
refinement feature.

1	 In the Workspace menu, choose Full Screen Viewer or press Shift-F to expand the 
viewer to fill your screen while still allowing you to access the ResolveFX panel 
to the left.

2	 In the Face Refinement settings, under Texture, adjust the Amount to 0.200. Doing so 
will gently blur the skin to soften minor wrinkles and imperfections.

Be careful not to push this setting so far that skin starts to look plastic. You should not 
aim to remove wrinkles but merely soften them.

TIP For more precise skin-smoothing options, change the Texture Operating 
mode to Smoothing or Beauty Advanced. These modes can break up the 
smoothing process into individual steps in which you can take into account 
skin texture and lighting.

3	 Scroll down to the Color Grading section to begin work on the woman’s skin 
tone grade.

The Midtone control is responsible for the overall brightness of the skin, which you can 
adjust to negate the presence of shadows.
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4	 Drag the Midtone slider to the right (0.050) to brighten the skin, but do not pull it so far 
that the onscreen results become distracting.

Color Boost enhances the saturation in areas of the skin that are under-saturated.

5	 Drag the color Boost slider to the right until you reach 0.080.

Tint is responsible for undoing the green or magenta color cast that some skin 
tones reflect.

6	 Drag Tint to -0.200 to reduce the redness in the skin.

7	 Raise the Contrast (0.100) to return some detail into the shadows of her face.

8	 Next, scroll down to the Eye Retouching section and click to expand it.

The controls in this section allow you to enhance details in the iris of the speaker, as 
well as brighten up the reflections from light sources (known as specular reflection).

9	 Set Sharpening to 0.050 to refine the pupil, eyelashes, and eye shape.

10	 Set Brightening to 0.050 to brighten the color of the iris.

11	 Set Eye Light to 0.050 to gently increase the brightness around the eye area.

12	 Adjust Eyebag Removal to 0.200 to brighten the area directly under her eyes.

In addition to addressing general dark circles under eyes, Eyebag Removal can reduce 
shadows caused by headwear as in this clip.

Lip Retouching allows you to saturate and change the hue of a subject’s lip color and to 
smooth upper lip wrinkles in tighter close-ups. As usual, context is key. The park ranger 
in question is not wearing lipstick, nor do you have a justifiable reason to glamorize her 
as she talks about the issue of rhino poaching in South Africa. In this case, the Lip 
Retouching tool is necessary only to add a minor contrast to her skin tone.

13	 Raise Saturation to 0.200 to define her lips against her skin. 

The same guidelines apply to the Blush Retouching section.
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14	 Set Saturation just high enough (0.200) to define her face shape without making it look 
like makeup.

15	 Additionally, you could expand the Size to 0.500 to spread the gentle redness across 
either side of her face without concentrating it to the apples of her cheeks.

The final three sections (Forehead, Cheek, and Chin Retouching) enable further hue 
adjustments to those specific areas. These controls can be beneficial when employing 
the traditional portraiture technique of “traffic lights,” in which gentle yellow, red, and 
green hues are applied to the forehead, cheeks, and chin, respectively.

The Global Blend control at the bottom of the settings allows you to blend the original 
image back into the Face Refinement node. This is ideal when you are generally happy 
with your face refinement settings but find that they are a touch too powerful.

Before After

With just one node, you have successfully enhanced your subject’s skin tone, made it 
more pronounced by brightening and warming it, and added chromatic detail into her 
features. In the original clip, it now becomes apparent how much the shadow of her hat 
was affecting the visibility of her face and facial expressions.

16	 When you are done with the adjustments, choose Workspace > Full Screen Viewer or 
press Shift-F to exit Full Screen mode.

TIP To remove a ResolveFX plug-in from a node, right-click the node, and 
choose Remove OFX Plugin.
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Adjusting Skin Tones Manually
As impressive as the Face Refinement ResolveFX feature is, it will not work for every skin 
refinement task. For example, when a face is turned away from the camera, the analysis 
tool will struggle to locate the facial features. When you are working on a profile shot, you’ll 
need to use the standard selection and grading palettes.

In this example, the subject is in an uncontrolled lighting environment. He is simultaneously 
overexposed by direct sunlight, and underexposed in the shadows. Your aim will be to 
reduce this stark contrast and remove the magenta tint from his skin.

1	 In the yellow flag-filtered timeline, select clip 05.

This clip already has a normalized tonal range via the Primaries wheels in node 01.

2	 Create a new serial node, and label it Skin Hue (node 02).

One possible approach to adjusting the man’s skin tones would be to use the qualifier 
to extract his skin and treat it as a secondary grade. However, this is not necessarily 
the best approach. It takes times to create a clean key, and the separation between the 
skin and the rest of the shot could end up looking too aggressive.

A gentler approach is to use the HSL curves, which will allow you to target his skin 
range based on hue, luminance, and saturation.

3	 Open the Custom Curves palette, and in the mode pop-up menu, choose the Hue Vs 
Hue curve.
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TIP The naming convention of the hue curves describes the selection 
method, followed by the change type. Hue Vs Sat implies that you are 
targeting a specific range of color (hue) to adjust its saturation (sat), whereas 
Sat Vs Lum suggests that you are targeting a certain range of saturation in an 
image with the aim of adjusting its brightness (lum).

The Hue Vs Hue palette shows the full range of hues going left to right, looping through 
the red hue. It enables you to sample a specific color and shift it toward another hue.

One method of hue selection is to use the swatch buttons at the bottom of the curve 
graph. Another method is to click in the viewer to sample pixel values.

4	 In the viewer, click on an evenly exposed patch of the man’s face.

TIP If a hue selection lands near the left or right edge of the palette, the 
range will smoothly cycle back around to the opposite edge.

Three control points are added to the Hue Vs Hue curve. The center point identifies the 
selected hue, and the control points on either side limit the range of hue that is affected.

5	 Drag the center control point down slightly to remove some of the red tint in the man’s 
skin tone. Be careful not to introduce too much green. If necessary, drag the two control 
points on either side farther apart to define a wider hue for the skin tone.
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TIP For more precision when moving a control point, use the Input Hue and 
Hue Rotation fields in the lower-right corner of the palette.

This may feel a bit like a guessing game. What is the right hue for his skin? To create 
more certainty in your adjustment, you will need to open the Vectorscope and check 
what the adjustment is doing to the skin.

The first thing you will need to do is to get a clean view of the face by using a window 
to remove interfering elements.

6	 Open the Window palette.

7	 Create a circle power curve window and label it Face Window. Position it over the 
man’s face to isolate a clean patch of skin.

8	 Remove the Softness Soft 1 on the window, and click the Highlight button.

This temporary window will aid in providing a clean readout of the skin tone to the 
Vectorscope.

9	 In the Scopes palette, choose Vectorscope as the scope type.
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The Vectorscope distributes the visual data of an image on a circular graph 
representing the hues in the current frame and their saturation levels. A well-balanced 
image will generally appear as a cloud of pixels in the center of the Vectorscope with 
some deviations toward specific hues in images that contain prominent colors.

10	 In the upper-right corner, click the settings icon to adjust the appearance of the scope 
for easier readability.

11	 Select Show 2x Zoom to increase the size of the scope.

12	 Select Show Skin Tone Indicator to display a line that indicates the direction for skin 
tone hues.

When working with skin tones, the Vectorscope can be invaluable for determining if a 
subject’s skin is deviating toward unflattering hues. However, the skin tone indicator 
line itself is not meant to be used as a strict determiner of all skin hues. Some skin 
tones naturally lean towards red or yellow. Instead, keep an eye on any obvious arcs 
or distortions in the trace that indicate an incorrect color cast on skin.

13	 Click anywhere in the color page to close the pop-up window.

14	 Drag the center control point in the Hue Vs Hue palette up and down to view the 
movement in the Vectorscope. It’s important to keep in mind that you are not trying to 
align the skin hue strictly to the Skin Tone Indicator line. Rather, you are using the Skin 
Tone Indicator to detect and gently reduce any obvious tone deviation in the skin tone.
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15	 A significant part of the man’s skin is in shadow, where it appears to have a prominent 
magenta tint. Add additional control points in the Hue Vs Hue curve and move more of 
the skin data so that it falls closer to the skin tone line.

16	 When you are happy with the skin tone hue, turn off Highlight mode to see the entire 
image and remove the circle window by clicking the circle icon in the Windows palette.

While the Color Warper allows you to intuitively adjust two values at once, the HSL curves 
are ideal for single-purpose precision, like working on skin tones. These tools should be 
your first choice when you are trying to quickly adjust the hue, saturation, or luminance of 
an object. If the result is not immediately satisfactory, you can then switch to working with 
the Qualifier, which offers a greater degree of control over your matte selection. Also, keep 
in mind that you can use the Color Warper and HSL curves in combination with the 
qualifiers and Power Windows for an even more refined selection.
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Perfecting Skin Tone Saturation
The hue of the skin tone is critical because people view skin tones from memory. With an 
expectation of what a healthy skin tone should look like, a viewer will instinctively know if 
something is “off.” You can use another hue curve on a separate node to address the 
saturation of the skin.

1	 Create a new serial node, and label it Skin Sat (node 03).

2	 In the Curve Mode pop-up menu, choose Hue Vs Sat.

You can use the Hue Vs Sat palette to make under-saturated items pop and highly 
saturated items more subdued. When dealing with skin tones, the right settings can be 
subjective. Generally, darker skin tones require the least amount of saturation, while 
lighter skin tones require the most before they begin to look distorted. In this case, 
the saturation in the man’s skin needs a very slight adjustment.

3	 In the viewer, click a saturated patch of the man’s face to drop the three points in the 
Hue Vs Sat curve. Drag the two surrounding control points to include a wider range 
of the skin.

4	 Drag the central point up slightly to increase the height of the saturation in the 
Vectorscope.

5	 Press Command-D (macOS) or Ctrl-D (Windows) to disable the Hue Vs Sat node. Press 
the keyboard shortcut again to view the adjustment.

Be careful not to get too aggressive when adjusting skin tones. The aim is not to produce 
a magazine-cover look but to reduce minor imperfections and enhance the visibility and 
saturation of the face. Getting too aggressive with the ResolveFX or hue controls can result 
in plastic-looking skin that is even more distracting than imperfections.
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Memory Colors
Memory colors are colors for which human beings have an instinctive reference. The most 
common of those are sky, grass, and skin tones that tend to be closely imprinted in our 
perception of the world. It is particularly important to grade these colors accurately to 
ensure audience immersion, unless the narrative specifically calls for a distortion of these 
hues. Man-made objects tend to have less color memory associated with them, so you have 
more freedom to tweak the hue of a car or the saturation of a character’s dress.

Continue using these techniques in new ways and combining qualifiers/Power Windows 
with your own footage. If you’re uncertain how to proceed with a certain shot, write out a 
workflow to help determine how you want the final output to look, and then work backward 
to choose the tools and adjustments that will realize your goals. You’ll always have several 
possible workflow options, so with experimentation and experience you will learn which 
are the most visually successful and time efficient for you.

Using the Mini Panel—Hue Curves
When switching between HSL Curves, the color presets 
normally found in the interface are available using the knobs 
below the Mini Panel screens. You can find additional curves 
and tools by pressing the Left Arrow and Right Arrow buttons 
on the panel.

Self-Guided Exercises
Complete the following exercises in the unfiltered 03 Matched Timeline to test your 
understanding of the tools and workflows covered in this lesson.

Clip 01—Use Lum vs Sat in the HSL Curves to increase the saturation of the deer in the 
center of the shot, but keep the saturation on the fence and ground low.

Clip 02—Apply a window to isolate the rhino’s face between the bars, and then apply the 
contrast Pop effect in ResolveFX to increase the contrast in that portion of the frame. The 
effect should immediately guide the eye without being overpowering.

Clip 03—Apply a window and use any of the sharpening methods covered in this lesson 
(Blur palette, Sharpen Edge FX, or Soften & Sharpen FX) to enhance the numbers on the 
scale and make them more readable. Track the window to the movement of the scale.
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Clip 04—Apply a subtle circular vignette at the end of the pipeline in the shot with the 
rhinos and horses. Create another node before the vignette and increase the brightness 
and contrast of the shot to enhance the color and detail.

Clip 05—Use the Color Warper’s Hue-Saturation grid to tint the ground in the field green. 
Use the greenery in the mountains behind the horses as a reference for the shade of green 
you should use. Apply a window to limit the correction to the field.

Clip 05—Create a new node and use the Color Warper’s Chroma-Luma grid to brighten the 
sky and add more blue to it. On the same grid, reduce the brightness of the grass to better 
match the mountains in the background.

Clip 11—Use the Tilt-Shift Blur ResolveFX to create an artificial shallow depth of field in the 
shot with the man and his dog by the fence. Consider the depth of field in this clip; you 
might want to rotate the angle of the Depth of Field to be nearly vertical.

When you’ve completed these exercises, open the 05 Completed Effects Timeline to 
compare your work to the “solved” timeline.

Lesson Review
1	 How are secondary color corrections different from primary color corrections?

2	 In the Color Warper, how would you pin a specific saturation range of the Hue-
Saturation grid?

3	 What does the Hue vs Lum HSL curve do?

4	 Which tool can you use to create a vignette?

5	 True or False? Track data generated in the Tracker palette can be copied and pasted 
onto another window or node.
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Answers
1	 Secondary color corrections affect only a part of the image, whereas primary 

corrections affect the whole frame.

2	 In the Hue-Saturation grid, saturation is represented by the grid rings. To lock them off, 
first select any point in the desired saturation range. Then, in the Tools sidebar, click 
Select Ring, and then click Convert Selected to Pin.

3	 The Hue vs Lum HSL curve increases or decreases the brightness of a selected color. 
The naming convention of HSL curves is that the first word prompts the selection, and 
the second word affects the change.

4	 The circle Power Window can be used to create a vignette.

5	 True. The function to copy and paste track data is found in the options menu of the 
Tracker palette.
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Managing Nodes 
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Lessons

	� Conforming an XML Timeline
	� Mastering the Node Processing Pipeline
	� Managing Grades Across Clips and Timelines

In Part II of The Colorist Guide to DaVinci Resolve 17, you’ll look at workflows beyond 
primary and secondary color correction stages to improve your speed and productivity 
when grading. Along the way, you’ll learn how to conform timelines from other applications, 
use stills and versions to copy and retain grade data, and perform some common 
compositing tasks.

Project File Location
You will find all the necessary content for this part of the book in the folder BMD 17 CC - 
Project 02. Follow the instructions at the start of every lesson to find the necessary folder, 
project, and timeline. If you have not downloaded the second set of content files, see the 
“Getting Started” section of this book for instructions on how to do so.
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Time
This lesson takes approximately 
90 minutes to complete.

Lesson 4

Conforming an 
XML Timeline

XML and AAF are two file types frequently 
used to migrate timelines between different 
software applications.

However, XML and AAF migration can 
occasionally fail to fully share timeline 
structures because of variances in application 
design. Migration inconsistencies can cause 
problems when you’ve received content 
edited in one application and want to grade 
and finish it in DaVinci Resolve 17. Upon 
import, you may find that some timeline areas 
contain incorrect clips or have failed to 
migrate transform changes or effects.

To ensure that an imported timeline is an 
exact replica of the editor’s work, you must 
use a verification process known as 
conforming to compare the reconstructed 
edit with a reference video and confirm that 
every cut and effect is reproduced within 
Resolve. When an element is mismatched 
or missing, you must manually alter it in 
the timeline.

Goals
Importing an XML Timeline	 108

Syncing an Offline Reference	 111

Conforming a Timeline	 112

Associating HQ Footage with a 
Timeline for Online Workflows	 119
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Lesson Review	 127
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In this lesson, you’ll look at the most common practices and issues associated with the 
conforming workflow. You will look at more advanced project setup practices by setting up 
scene-referred color for optimal grading conditions.

Importing an XML Timeline
The project you will be working on is a film trailer for a documentary called Age of 
Airplanes. Due to its nonlinear nature, you will have more opportunity to experiment with 
grade construction and more dramatic looks on a clip-by-clip basis.

You will start by reconstructing the project timeline from an XML file exported from the 
editing software.

1	 Open DaVinci Resolve 17.

2	 Right-click within the Project Manager window and choose Import.

3	 On your hard disk, locate the BMD 17 CC - Project 02 folder.

4	 In the folder, select the Project 02 – Age of Airplanes Trailer.drp file and click Import.

The project is already set up with bins but contains no media or timelines. You’ll import 
the timelines required for the following exercises as XML files and associate the 
necessary media with them.

5	 In the edit page, select the empty Timelines bin as the destination for the XML timeline 
and choose File > Import > Timeline.

6	 In the BMD 17 CC - Project 02 folder, navigate to the XMLs subfolder. Locate the 
Airplanes – 01 LQ Timeline.xml file and click Open.

The Load XML pop-up dialog appears in which you can set up how your XML timeline 
and associated media are imported.
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The default settings will work for this project because you want Resolve to find the 
media that belongs to this XML file.

TIP Selecting “Ignore file extensions when matching” will allow you to choose 
media that is in a file format different from that of the original timeline media. 
This option can be extremely useful when switching between offline and 
online workflows.

7	 Click OK to close the dialog.

Resolve will search for the files based on their last known locations in relation to the 
XML file. Most often, drives and paths change during transfer, and a dialog will ask for 
help in locating the missing files.

8	 If this dialog window appears, click Yes to locate the missing clips.

This timeline should contain all your low-quality video renders (LQ trancodes). You 
need to be specific when indicating their location.

9	 Navigate to the BMD 17 CC - Project 02 folder and select the LQ Transcodes subfolder. 
Click OK at the bottom of the dialog window. 

This action should reconnect most of your media. However, the dialog box will appear 
again, suggesting that some remaining clips have not been located. You’ve specified 
the location of the video clips but not the audio. 

10	 Click Yes again to find the audio.

11	 In BMD 17 CC - Project 02, select the Audio subfolder and click OK.

A few remaining clips will not be found. This sometimes occurs when video clips in the 
timeline were renamed or changed after generating the XML file. Due to this change, 
Resolve cannot establish a connection with the media. You will resolve this during the 
conforming stage.

12	 In the second dialog box, click No.

Another window will appear. The Log displays a summary of the migration process, 
including a confirmation of the imported timeline and a list of migration issues 
(translation errors). This summary can help eliminate some of the guesswork from 
the conforming process.
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13	 Read the Log to see the name of the missing clips and click Close when you are done.

The timeline should now appear in the edit page and its media in the media pool.

TIP You can view the Log of an imported timeline at any time from the Media 
Pool. With the timeline open in the edit page, access the Media Pool option 
menu and choose Show Import Log.

14	 For easier project management, organize the imported files in the media pool. The 
timeline thumbnail (identified by an orange tick in the upper-right corner) can remain in 
the Timelines bin. The four audio files should be into the Audio bin, and the video files 
in the LQ Transcodes bin. 

As long as the filenames of media files are not changed, relinking is a straightforward 
process. For this reason, it is highly advisable to never rename media but work with the 
original camera filenames throughout the entire postproduction process.

TIP When migrating with AAF files to and from Avid Media Composer, you 
must retain reel names when creating low-resolution dailies and relinking to 
high-resolution original files. To do so, select the offline clips on the timeline; 
choose File > Reconform from Media Storage; and in the conform options, 
select “Assist using reel names from: embedded in source clip file.”
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Syncing an Offline Reference
With the XML timeline imported and set up, you should now check the edit to ensure that 
every clip, cut, and effect was successfully migrated. To aid in this stage of the conforming 
process, the editor should provide a reference movie: a single exported video file of the 
final timeline that you can use for visual verification of the migrated timeline.

In this exercise, you’ll associate a reference movie with a timeline and fix any issues that 
may have occurred during migration.

1	 Go to the media page.

2	 In the Media Pool, select the References bin as the target for the new clip you are 
about to import.

3	 In the media storage browser, navigate to the BMD 17 CC - Project 02 folder.

4	 In the Other folder, find the Age of Airplanes REFERENCE.mov file and drag it into the 
References bin.

5	 Open the edit page.

6	 Access the source viewer option menu and deselect Live Media Preview. This will 
ensure that the viewer does not change modes when you interact with the Media Pool.

7	 In the lower-left corner of the source viewer, in the Mode pop-up menu, choose Offline. 
Doing so will switch the source viewer from showing source materials to displaying 
offline reference clips.

8	 Drag Age of Airplanes REFERENCE.mov from the Media Pool directly into the source 
viewer. This will associate it as an offline reference clip with the active Airplanes 
- 01 LQ timeline. 

However, the viewer currently shows the red Media Offline frame. One of the most 
common reasons a reference clip appears offline is because its timecode does not 
align with the timeline timecode.

9	 Click the List View icon at the top of the Media Pool to view the media metadata.

10	 In the Start TC column, view the start timecode of the reference clip and compare it to 
the start timecode of the timeline.
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Timelines in editing programs tend to begin at the one-hour timecode (01:00:00:00), 
whereas rendered video clips tend to begin at 00:00:00:00, as is the case with this 
reference. You can easily correct this by changing the start timecode of the reference 
clip to match the timeline.

11	 Right-click the reference clip in the media pool and choose Clip Attributes.

12	 In the Clip Attributes window, click the Timecode tab and enter 01 as the Current 
Frame hour. Click OK to close the window.

If the reference movie does not immediately appear in the source viewer, check the 
Mode pop-up menu of the source viewer to ensure that Offline is still chosen 
and drag the timeline playhead to refresh the frame.

Conforming a Timeline
With the reference movie in place, you may analyze of the timeline to address any visual 
inconsistencies. During the first pass, you will make sure that the cuts occur at the right 
time and that the clips are in the right locations. To accomplish this, you must review the 
edit cut by cut.

1	 Enter the media page.

2	 In the Media storage library, navigate to the BMD 17 CC - Project 02 folder and enter 
the Other subfolder.

The Log window lists the credits of the trailer among the missing media.

3	 Drag CREDITS.mov into the Graphics bin of the media pool. 

4	 Return to the edit page.

The credits are automatically detected and can now be seen at the end of the film. If 
the source media maintains the same name as those in an XML file, it will immediately 
appear in the timeline, even if imported after the XML construction.

5	 The audio files have linked successfully in the timeline, but audio level settings usually 
don’t travel when migrating in the XML format. To prevent being distracted by the non-
mixed audio, click the Mute button to the right of the timeline toolbar.
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6	 Move the playhead to the start of the Airplanes - 01 LQ Timeline.

7	 Press the Down Arrow on your keyboard until you navigate to the first video cut point 
at the start of the second clip on the timeline.

It is apparent that the timeline clip does not match the clip in the reference video. This 
could be due to a clash in tape/reel name or due to the editor making a change after 
exporting the XML file. To resolve this, you can manually import and assign the correct 
clip to the timeline.

8	 Enter the media page.

9	 In the Media storage library, enter the Other LQ Transcodes subfolder.

10	 Drag the AERIAL_SFO_02.mov video clip into the LQ Transcodes bin of the 
media pool.

11	 Return to the edit page.

12	 In the LQ Transcodes bin of the media pool, click the AERIAL_SFO_02.mov thumbnail.

13	 In the timeline, right-click the second clip and choose Conform Lock with Media Pool 
Clip. Doing so replaces the clip in the timeline with the selected source media, which 
now matches the clip in the reference movie. 

NOTE If the clip in the media pool and the clip in the timeline have the same 
timecode, the conform action will place the incoming clip using the same In 
and Out points as the original cut. If the timecodes don’t match, the first frame 
of the incoming clip will be aligned at the cut.

The contrast and saturation of the clips in the viewers appear to be different. This is 
because the reference clip was rendered with a Rec.709 color gamut, while the source 
media is in a log color gamut. You will address color management at the end of 
this chapter. 
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Fixing Translation Errors
You can continue to navigate down the timeline and look at the reference movie to check 
the clips, edit points, and effects to ensure that everything is successfully translated.

1	 Press the Down Arrow to jump to the next video cut at the start of clip 3, 
TAKE_OFF_SFO.

In addition to checking the timeline clips and their edit points, your conforming process 
should ensure that all transitions and effects are present. A simple side-by-side 
comparison cannot always do this, so you have the option to superimpose the 
reference movie on the timeline viewer. This procedure helps to verify if the clips are 
framed identically.

2	 Right-click the timeline viewer and choose Horizontal Wipe.

The timeline clip is displayed to the left, while the reference clip is displayed to 
the right.

3	 Drag the wipe left and right to compare the placement of the clip to the reference.

Using the wipe for comparison reveals a mismatch in the shot framing. To fix it, you can 
view a difference composite.
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4	 Right-click the timeline viewer and choose Difference to highlight where the 
clip is misaligned.

5	 In the timeline, click the TAKE_OFF_SFO clip and open the Inspector panel in the 
upper-right corner.

6	 In Transform controls, increase the Zoom value until the size of the cockpit windows 
appear the same (1.200).

7	 Because the windows and wings appear higher in the timeline, drag the Y position 
down until the windows and wings overlap (-100.00). When visually performing these 
matches, you will need to go back and forth between the position parameters to get a 
perfect fit.
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TIP You can use the Inspector’s anchor point to simplify the process of 
matching a reframed clip. First, click the Transform button in the lower left of 
the timeline viewer to activate onscreen controls. Then drag the anchor over a 
distinct object in the frame (like a window or text). When you now adjust the 
Inspector’s Transform controls, the zoom will expand from the new anchor 
position, simplifying the process of lining up the shot scale and position.

When you can no longer see a “double effect” in the viewer, the framing is successfully 
replicated. If you were working on images with identical color gamuts, the viewer 
would become black to signify that no visual differences remained between the clips.

8	 Right-click within the viewer and choose No Wipe to return to the normal 
timeline viewer. 

9	 Close the Inspector to bring back the offline reference viewer.

10	 Press the Down Arrow to navigate to the next video cut. This is the missing clip that 
was not found when the XML timeline was imported.

11	 Return to the media page. In the Media storage browser, locate the Other folder and 
open the Other LQ Transcodes subfolder.

12	 Drag the BA4662_54 and BA4662_55 clips into the LQ Transcodes bin of the media 
pool and return to the edit page.

13	 Press Command-+ (plus sign) in macOS or Ctrl-+ (plus sign) in Windows to zoom in to 
the offline clip in the timeline.

14	 Right-click the clip and choose Conform Lock Enabled. The clip is now receptive to all 
media that is associated with its metadata.

In the lower-left corner of the timeline clip, a red attention badge icon <!> indicates a 
potential metadata clash with another clip in the media pool.

15	 Double-click the attention badge on the clip.

The Conflict Resolution window appears, displaying all the clips in the bin that match 
the metadata of the clip in the timeline. You can now select the correct clip according 
to the reference movie.
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16	 In the Conflict Resolution window, select the water shot BA4662_55 and click 
Change to apply.

The correct clip is placed in the timeline to match the reference movie. To remove the 
now black-colored resolved badge and confirm the new clip as the correct one, you 
can lock the conformed selection.

17	 In the timeline, right-click the clip and choose Conform Lock Enabled.

18	 Continue to press the Down Arrow to check the remainder of the clips.

When you reach clip 08 (YELLOW_PLANE), you will notice that the clip has very 
different colors compared to the reference movie.
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It’s common practice for editors, directors of photography, or other creative directors to 
leave preliminary grades baked into the reference movie as a guide for the colorist. 
As a general rule, grading data does not come across in migration files unless the 
project is sent as a DRP file or it includes accompanying LUTs (Lookup tables) or CDL 
(color decision list) data.

It will not be necessary to do anything with this clip at this time, but it will be useful 
when you begin the grading process.

TIP To import LUTs into DaVinci Resolve, open the Project Settings and enter 
the Color Management tab. In the Lookup Tables pop-up menus, click Open 
LUT Folder. Drag your LUTs into the DaVinci Resolve LUT folder, and in the 
Project Settings, click Update Lists.

To set up a custom LUT folder path, open DaVinci Resolve > Preferences. In 
the System menu, open the General sidebar, and under LUT Locations, click 
Add. After adding your LUT location, open the LUTs panel on the color page, 
right-click the sidebar, and choose Refresh. Folders in your custom file path 
will appear as subfolders in the LUTs master folder, while LUTs will be 
imported directly.

Imported LUTs are also accessible in every clip and node contextual menu.

Although it’s natural to feel that something has gone wrong with your workflow when the 
timeline presents issues during XML migration, it is important to remember that this is a 
completely normal and anticipated stage of postproduction. It is encountered in projects of 
all calibers and stems from the fact that no single migration standard exists among the 
dozens of applications that you may use when collaborating on a film project.
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One of the major advantages of performing your entire postproduction workflow in 
DaVinci Resolve is its substantial reduction of migration and project management issues. 
An edit can be ingested, edited, graded, and delivered without the need to be conformed.

TIP When sharing a timeline with someone who is also working in Resolve, you 
have several options:

•	� export the timeline (from the media pool) in the native DaVinci Resolve .drt 
format for a conform-free migration

•	� export the entire project (from the project manager) as a .drp to share all project 
bins and timelines

•	� export the project archive (from the project manager) as a .dra to share the 
entire project and its contents

Associating HQ Footage with a 
Timeline for Online Workflows
The timeline you reconstructed for this section is currently associated with media from the 
LQ Transcodes folder. These low-quality video files are generated from the source media 
with the intention of providing the editor with light (small file sizes) video files that are easy 
to transfer and do not lag when played in real-time.

The accuracy of an image’s pixel data is not vital to editors because they are focused on 
constructing a narrative and bringing a good flow to the edit. However, when the timeline 
reaches the colorist, the quality of the image becomes paramount. Therefore, you will want 
to create a copy of the timeline that links to the HQ video files that are optimal for grading.

1	 In the edit page, in the media pool, open the Timelines bin.

2	 Right-click Airplanes – 01 LQ Timeline and choose Duplicate Timeline.

3	 Slowly click twice on the name of the new timeline and rename it  
Airplanes – 01 HQ Timeline.

4	 Double-click the HQ Timeline to open it in the edit page timeline window.

5	 In the media pool, click the empty HQ Transcodes bin to select the destination for 
the HQ media.

6	 In track V1, drag to select all its video clips on the timeline. Do not include the credits or 
audio in your selection.



120Associating HQ Footage with a Timeline for Online Workflows

7	 Right-click any clip in the timeline and deselect Conform Lock Enabled. Doing so will 
disable the clips’ lock on their media file paths and prompt them to acknowledge all 
media that shares similar metadata and timecodes in the media pool.

8	 In the File menu, choose Reconform from Media Storage.

The Conform from Media Storage window allows you to refine the media that is being 
associated with the clips in the timeline.

9	 Under Timeline Options, choose “Attempt to reconform to Selected Clips in timeline.”

10	 Under Choose Conform Folders, select the BMD 17 CC - Project 02 > HQ 
Transcodes folder.

11	 Under Conform Options, deselect Timecode.

12	 Select File Name, and choose “Tight filename match.”
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13	 Click OK.

The HQ Transcodes bin is populated with the higher-quality clips that also replace the 
LQ clips on the timeline. 

However, this clip state might be difficult to see in the HQ Timeline because the clips in 
the timeline appear exactly the same. You can adjust the appearance of the clips to 
verify that the link was successful. 

14	 In the HQ Transcodes bin, select all the newly imported clips. 

15	 Right-click one of them and choose Clip Color > Orange. All the clips in the timeline 
that were successfully switched to the higher-quality media will appear orange in 
the timeline.

Before

After

16	 To lock the HQ clips to the timeline, select them, right-click, and choose Conform 
Lock Enabled.

This method of changing file source locations gives you full control over the media used in 
the timeline without the need to import additional XML files or to change the file paths of 
the clips in the media pool. An important component of this workflow is a well-organized 
and consistently labeled file system, which is vital in all postproduction workflows.

Having successfully imported and prepared the XML timeline for grading, you can proceed 
with the knowledge that the timeline is accurate, and that you are in control of your footage 
quality at all times. However, the media in this project is currently in a log-encoded color 
gamut that does not give an accurate visual reproduction of the hues and tonal range of 
the recorded images. The next set of steps will manage the log-encoded content to output 
to the more visually accessible and grade-friendly Rec.709 color gamut.
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Maximizing the Dynamic Range
The grading potential of an image is determined primarily by its dynamic range, which is 
the range from its darkest point to its brightest point.

HD consumer and broadcast video cameras tend to record using a standard dynamic 
range based on the Rec.709 color standard. This standard ensures that the image looks 
as close to real life as possible and displays as such on an HDTV or computer monitor. 
However, professional digital film cameras, such as the Blackmagic URSA Mini Pro, can 
capture a wider dynamic range by using a nonlinear, or log gamma, curve. This curve gives 
you greater flexibility for manipulating the brightness, contrast, and colors without distortion.

Ungraded video in log color gamut

Ungraded video in Rec.709 gamma 2.4 color gamut

A byproduct of encoding footage with a log gamma curve, however, is that footage initially 
appears flat and with low saturation when viewed on an HDTV or computer monitor.

Therefore, a colorist must first correct the log gamma curve so that it appears correctly 
on the display. This process is called a display-referred color management setup. Because 
Resolve receives no direction on how the source media is meant to look, configuring that 



122 123Maximizing the Dynamic Range

look is left to the colorist. This process often employs LUTs to convert from log to Rec.709 
(assuming HD is the final output format).

However, DaVinci Resolve also includes a scene-referred color management setup that 
allows the colorist to assign color profiles to media based on how that media was captured. 
Each clip’s native color gamut and gamma curve are then converted to the desired output. 
The colorist no longer has to manage multiple LUTs for different sources or manually 
convert each clip from log to Rec.709 using standard grading tools.

Setting Up Color Management in a Project
It’s highly advisable to set up color management at the earliest possible stage of a project 
to ensure the color grading tools behave in an accurate and consistent manner.

1	 Open the Project Settings by clicking the gear icon in the lower-right of the workspace.

2	 Click Color Management in the Project Settings sidebar.

3	 In the Color Space & Transforms window, set the “Color science” menu to DaVinci 
YRGB Color Managed. Doing so will activate scene-referred color management and 
reveal the color management preset and output color space options.

The Resolve color management preset drop-down menu allows you to select from a 
variety of deliverable standards for broadcast, cinematic projection, and online 
streaming. When you select a preset in this drop-down menu, a brief description 
underneath will summarize the preset’s intended use.

4	 There is no HDR (high dynamic range) media in the Age of Airplanes Trailer project, so 
an SDR standard will be adequate. 

Also, after you complete these lessons, it is unlikely this project will be seen anywhere 
other than on your computer screen, for which the Rec.709 gamut is ideal.

Set the Resolve color management preset to SDR Rec.709.
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5	 Leave the Output Color Space as Rec.709 Gamma 2.4.

6	 Click Save to close the Project Settings.

Color management is set up in the project. However, you might not see an immediate 
change in your timeline or viewer because the media you have imported uses a default 
Rec.709 input color space. 

7	 In the media pool, open the HQ transcodes bin.

8	 Drag to select all the clips in the pool or press Command-A (macOS) or Ctrl-A 
(Windows).

9	 Right-click any of the selected clips and choose Input Color Space > 
Blackmagic Design Film Gen 1. This identifies the camera model, data level, and 
software version that were used to record the footage in this project.

By correctly setting up the input color space of the media, the colors of the timeline 
clips will shift from the Blackmagic Design log color space to Rec.709 with the HD 
standard 2.4 gamma curve. As a result, the clips will appear more vibrant and with 
more pronounced contrast.

TIP If the image in your viewer feels too flat when completing the exercises in 
this lesson, change the Output Color Space to Rec.709 Gamma 2.2, which is a 
more appropriate gamma curve for many standard computer monitors, or 
sRGB if you’re using a Mac display.

DaVinci YRGB color management applies to all the clips in a project. If certain clips 
come from different sources from the rest of the timeline, you can reassign their 
individual input color spaces through the media pool’s contextual menu (or the color 
page clip timeline).

TIP You could use a Smart Bin to filter clips based on their sources and then 
select them in batches when changing their input color space settings.

DaVinci YRGB color management offers a structured, solid foundation for color grading 
by remapping the starting point of video media (from any number of sources) to a 
single, grade-appropriate color standard. Its advanced tone mapping ability means that 
highlights are gently rolled, preserving maximum quality. Compare the treatment of the 
highlights in the reference clip (which underwent standard log-to-Rec.709 conversion) 
to the DaVinci YRGB color management tone remapping.
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This method of color management results in higher quality visual output, more 
consistency in the performance of the color page grading tools, as well as an easier 
delivery process in which the project preset color space can be remapped to any 
number of deliverable standards.

When You Don’t Know the Camera or Format
DaVinci YRGB color management operates at its best when you know and identify the 
correct input color space data. But identifying that data can be tricky when the origins of 
footage are unknown, or when color space data details were not included during file 
transfer. You can derive some useful information by examining clip properties, but doing so 
usually will not provide information about the camera model or gamma range. You can 
acquire the most definitive information by directly contacting the director of photography or 
the camera operator and requesting this information. If all else fails, you can bypass DaVinci 
YRGB color management and manually normalize the clips.

Changing the Output Color Space
One of the most powerful aspects of using a color-managed workflow in DaVinci Resolve 
is that you can change the output color space at any time based on your final delivery 
requirements.

Doing so is particularly helpful when you need to output multiple masters to different 
destinations. You may want one master for Rec.709 HD, another for Rec.2020 UHD, and 
yet another for P3 digital cinema. DaVinci Resolve manages the color transformations 
without the need to change anything on the color page.

1	 Open Project Settings > Color Management.

2	 Set the Output Color Space to P3-D65 ST2084 4000 nits.
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3	 Click Save.

The color space is changed, and the viewer reflects the updated results. On a standard 
computer monitor, the colors will now appear flat. However, if you had a calibrated HDR 
P3-D65 monitor capable of displaying 4000 nit luminance, the clips would look nearly 
identical to their appearance on your HD Rec.709 display. If you graded the media in 
the timeline, the final colors would similarly be remapped to adhere to P3-D65 ST2084 
standards. So, you could instantly switch your timeline grades between different 
monitor and deliverable standards.

Accurate Color Monitoring in DaVinci Resolve
Resolve was designed to work with industry-standard calibrated external displays 
connected via video output interfaces to enable critical color evaluation.

Most computer monitors are incapable of displaying the color gamut or gamma range 
required for broadcast and theatrical distribution. Additionally, most computer displays have 
their own color and contrast calibration as determined by the manufacturer, which is further 
altered by the workstation’s operating system. For this reason, their color accuracy cannot 
be guaranteed to carry across after delivery, even when moving between different video 
players on the same machine.

Ideally, you should use an external monitor and video interface for all grading work. 
Alternatively, you could use a color calibration probe to analyze your computer display and 
generate a LUT that will remap the colors to the correct standard.

4	 Open Project Settings > Color Management.

5	 Set the Output Color Space back to the default Rec.709 Gamma 2.4.

6	 Click Save.
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TIP If you know in advance that you will deliver content in multiple color gamut 
standards, consider starting your workflow at the widest gamut. For example, if 
delivering for web (Rec.709 Gamma 2.2), digital cinema projection (DCI-P3), and 
HDR broadcast (Rec.2100 ST2084), the best option would be to grade your 
project for HDR first. Then, duplicate the project and calibrate the Output Color 
Space to DCI-P3. Review the timeline, make the necessary highlight adjustments 
to complete the cinema grade, and then remap the Output Color Space to 
Rec.709 for the web deliverable. 

You can also change the gamma range separately from the color space by selecting Use 
Separate Color Space and Gamma above the color space menus.

Separating the color space and gamma settings gives you full control over the chrominance 
and luminance processing of your footage. You can indicate gamma ranges that are not 
part of the standard preset selection of the color space menus.

NOTE You will continue to work on the timeline created in this lesson over the 
next two lessons. If you would like to verify that your timeline is correct or are 
uncertain with the accuracy of your conforming, you may import Project 02 – Age 
of Airplanes Trailer COMPLETED.drp into the Project Manager and open 
Airplanes - 03 HQ Ungraded Timeline. If the media appears offline, click the red 
Relink Media button in the upper-left corner of the media pool and specify the 
location of the Project 02 media on your workstation. You can then use this 
ungraded, conformed timeline to complete the next two lessons in this book.

Lesson Review
1	 During project migration, what is a translation error?

2	 How do you designate a video file as an offline reference movie?

3	 When loading an XML file, why would you opt to “Ignore file extensions 
when matching”?

4	 What does File > Reconform from Bins allow you to do?

5	 Where do you activate DaVinci YRGB Color Management?
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Answers
1	 Translation errors occur when inconsistencies appear in a reconstructed timeline 

between programs.

2	 In the source viewer, disable Live Media Preview and activate Offline mode. Any clip 
you drag from the media pool into the source viewer will be associated as a reference 
clip with the currently active timeline.

3	 You would choose this option to specify differently formatted versions of transcoded 
media (offline or online) to use in the timeline reconstruction.

4	 This allows you to change the source of the media based on a different bin in the 
media pool.

5	 In Project Settings > Color Management, set Color Science to DaVinci YRGB Color 
Managed.Lesson 1
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Understanding Node-Based 
Grade Compositing
Node-based compositing is different from the layer-based system familiar to many NLE 
editors. Unlike layers, in which the visuals are compounded based on their order in the 
layer stack, nodes process a single RGB signal, modifying it along the way.

As each node affects the image, it outputs the altered signal via an RGB link until the final 
RGB data reaches the output node of the Node Editor. This output node presents the image 
in its final state to the viewer and determines how the media will look when rendered.

Nodes are capable of reusing information from previous nodes, substantially reducing 
the amount of processing power required to assemble and output a final image. This 
capability is particularly useful when working with keys, such as those generated by 
qualifiers and Power Windows.

The Anatomy of a Node
The Node graph is read from left to right. The RGB signal that constitutes the image begins 
at the leftmost green node—the RGB input—and travels through the links that connect the 
corrector nodes until it reaches the final node tree output to the right. The RGB signal must 
be uninterrupted for the node grades to be correctly compiled and output.

Standard corrector nodes have two inputs and two outputs.

Inputs Outputs

The green triangle and square shapes at the top of either side are the RGB inputs and 
outputs. These carry the pixel data of the image, which is manipulated within the node 
using the grading tools of the color page. Corrector nodes can accept only one RGB 
input but can output multiple RGB signals to other nodes.

The blue shapes are the key inputs and outputs. These enable you to transfer the key 
data generated by the Power Windows and qualifiers (or external mattes) to be used by 
other nodes.
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NOTE You can undo an action in DaVinci Resolve 17 by pressing Command-Z 
(macOS) or Ctrl-Z (Windows). The undo function is stacked to each clip in the 
timeline. So, when you undo, only the changes from the selected clip are 
removed, and not from any other clips on the timeline, even if you graded them 
more recently.

Understanding the Importance of 
Node Order
The RGB signal output of each node carries the full weight of its grade and directly affects 
the next node’s interaction with it. The following set of exercises demonstrate how nodes 
impact one another.

Node Order Demos
The node structures of every exercise in this segment can be found in the “Node demos” 
album of the gallery in the color page.

Influence of Color and Saturation Across Nodes
You can see how a node placed at an early pipeline stage influences the following nodes 
by removing its saturation and observing the results.

1	 Open the Project 02 – Age of Airplanes Trailer project.

2	 Enter the color page.

3	 Click clip 05 in the Airplanes – 01 HQ Timeline.

4	 Label the first node BW.

5	 Open the RGB Mixer palette, which is located in the left palettes.

6	 Select Monochrome (at the bottom of the palette) to turn the image black and white.

The RGB Mixer gives you full control over the strength of the individual RGB channels 
and is often used for tweaking black-and-white images to create an aesthetically 
pleasing balance of natural elements such as skin, sky, and trees.

7	 Drag up the red output’s R bar to increase the strength of the red channel in the 
image. This change will brighten the man’s face against the background and create 
a good contrast.
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8	 Create a second node and label it Sepia.

9	 Open the Color Wheel palette, and drag the Offset color wheel toward orange–yellow 
to give the image a sepia tint.

10	 Click node 01 BW and return to the RGB Mixer palette.

11	 Drag the blue output’s B bar up and down to increase and decrease the strength of the 
blue channel in the image.

The effect on the final sepia grade shows that the luminance and contrast created in 
the first node continue to impact the image even after a second node dramatically 
changes its appearance.

For an even clearer visualization of how the node order impacts the grade, you can 
switch the order of the two nodes.

12	 Click node 02 Sepia and press E to extract it from the pipeline.

13	 Drag the disconnected node onto the link in front of node 01 until a + (plus sign) appears.

TIP A quick way to switch the order of two nodes is to Command-drag 
(macOS) or Ctrl-drag (Windows) one node over another.

When reconnected, the image becomes black and white. Though the sepia grade is still 
performing its function in the first node, it is being completely overwritten by the BW node, 
which is turning the RGB signal monochromatic and sending it to the node tree output.
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Adjusting Contrast and Luminance on Nodes
With a clearer understanding of the function of the RGB inputs and outputs, you can now 
check how mild adjustments to luminance and contrast can still have substantial impact on 
an image’s signal quality.

1	 Press Command-Home (macOS) or Ctrl-Home (Windows) to reset the grade in clip 05.

2	 Label the first node Lift crush.

3	 In the Color Wheel palette, drag the Lift master wheel to the left until it reaches -0.10.

The clip will lose a great amount of detail in the shadows, and the bottom of the 
waveform trace will appear to be crushed against the black point.

4	 Create a new node, and label it Curves restore. 

You will attempt to restore the shadow data in this new node.

5	 Open the Curves palette and ensure that the YRGB channels are linked.

6	 Click the center of the curve to create a new control point, and drag it up to brighten 
the image.

The resulting image appears distorted. The fine detail in the man’s shirt is lost in the 
contrast, and his face becomes patchy and overexposed. This demonstrates a 
“destructive” workflow in which the changes made in one node clip restrict the 
RGB data used by the subsequent nodes.

Thankfully, you cannot really destroy RGB data in the pipeline. By using the correct part 
of the curve, for example, you can fully restore the data of the original image.
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7	 Right-click the control point on the curve to remove it.

Let’s gain a better understanding of how the video signal changes from one node 
to the next.

8	 Click node 01 in the node pipeline to review the curves palette histogram trace.

9	 Click node 02 to compare the histogram trace in the same graph.

01 Lift crush RGB input histogram 02 Lift restore RGB input histogram

The histogram changes in response to the current node state of the video signal in the 
pipeline. When grading, such changes can be extremely useful for determining where 
to click on the graph to target specific luminance and chrominance ranges. The 
histogram readout in node 02 signifies that the majority of the data is crushed against 
the lower left of the graph. 

10	 Drag the black point of the YRGB curve upward along the left side of the curves graph. 
Stop dragging when you are just under the first horizontal line from the bottom.

The black point of the curve is equivalent to the Lift master wheel, which is why you were 
able to retrieve the crushed details in the shadows. By dragging the center of the curve, 
you were impacting the gamma range, which targets a very different range of luminance.

TIP You can set the Curves palette histogram to react to your node adjustments 
as you make them. To do so, open the Curves palette options menu in the 
upper right of the palette, and choose Histograms > Output. The histogram 
now represents the outgoing RGB signal of the node instead of the input.
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Though you were able to restore the image in this instance and continue using the 
previously crushed shadows, you can imagine how more subtle changes to the 
brightness and contrast of an image in early nodes could impact the quality of 
adjustments made to the shadows and highlights in later nodes.

It’s important to keep in mind the potential of destructive grades. As a general rule, 
balancing, matching, and secondary grades should come before bold contrast 
adjustments and sweeping creative grades. It is far more acceptable to distort and 
crush data in final nodes because no other nodes rely on them for RGB info.

Breaking Rules to Preserve the Video Signal
In previous chapters, you normalized and balanced images with the intention of creating a 
“clean slate” to color grade. However, the proposed grading workflow in the first lesson also 
came with a word of caution: do not let these steps rigidly dictate all your grading. Certain 
scene compositions require a lateral approach that enhances the captured image instead of 
merely correcting it. Imagine a scene in which a cave explorer hears mysterious growling 
just as her flashlight goes out. Would you normalize such footage to the full height of the 
waveform scope? How about a night club scene in which the environment and talent are 
bathed in red light? Would it need to be white balanced?

As you gain experience with color grading, observe when these rules work in your favor, 
and when they work against you. In the following example images, a time-lapse of the night 
sky was graded two separate times. The first grade used the established grading rules, 
while the second took a creative approach with emphasis on the colors, stars, and tree 
silhouettes.

Normalizing, balancing, contrast Contrast, saturation, adding red to Gain

With the normalized version, it would be harder to achieve the clean, rich look of the second 
example. The highlights in the Milky Way have been expanded and flattened, losing too 
much detail, and the mild preservation of the hill and trees in the foreground was 
unnecessary, considering how much more dramatic they look when silhouetted.
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Impact of Dominance Color Grades on Surrounding Nodes
Another consideration when grading is choosing the order in which to apply color changes 
to an image. In this exercise, you will try to create a clip with a distinct blue cast, while 
retaining control over the skin tone in a subject’s face.

1	 Reset the grade on clip 05.

2	 To save time, the Balance node for this clip was already created. Open the gallery 
and ensure that the Stills albums button is enabled to show a List view of the 
available albums.

3	 Open the Base grades album.

4	 Right-click the INT 5 Balance still, and choose Apply Grade.

5	 Create a new serial node called Blue Look (node 02).

6	 In the Color Wheel palette, drag the Gain and Gamma wheels toward the blue–
cyan range to cool down the image, and then counteract the blue dominance in the 
shadows by dragging the Lift wheel slightly toward red.

7	 Use the Contrast and Pivot settings to refine the contrast and brighten the upper 
midtones of the image. Aim to create fine shadows on the man’s shirt.

8	 Finally, reduce the Saturation to 40 to remove the blue vibrancy and end up with a 
cold, desaturated image.
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This look has a strong, purposeful design. It could effectively convey a somber mood 
or suggest a different point in time in a nonlinear narrative. However, its impact on the 
speaker’s skin tone reduces its effectiveness and could end up being tiring to the 
Viewer’s eye.

9	 Create a final node (node 3) called Skin Tone.

The man’s face is close in hue to the color of the wall behind him, so using HSL curves 
might not be the most effective choice. A qualifier selection would give you a better 
chance of isolating the skin in this shot.

10	 Open the Qualifier palette, and click the man’s face to grab a sample.

Due to the RGB signal passing through the Blue Look node, the qualifier is forced to 
work with a very cold, contrasted version of the man’s skin. This is definitely not an 
ideal point in the timeline to be keying skin or to be grading it.

11	 Select the Skin Tone node and press E to extract it from the pipeline.

12	 Drag it onto the link between nodes 01 (Balance) and 02 (Blue Look).

13	 Reset the qualifier on the Skin Tone node, and select the skin again. In the Qualifier 
palette, adjust the HSL and Matte Finesse controls to get the best extraction. Remember 
to turn on the Highlight mode in the viewer to best observe the result of the selection.
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This time the qualifier gives you a much better result.

NOTE The qualifier continues to be actively influenced by the nodes 
preceding it. Changing the hue or brightness of an earlier node at any point of 
the grading workflow will impact the selection (and quality) of the qualifier.

14	 Use the Window palette to isolate and refine the selection of the man’s face.

15	 In the viewer, turn off the Highlight mode.

16	 Track the motion of his face in the Tracker palette and then return to the start 
of the clip.

17	 In the adjustment controls, raise the Sat value of node 02 Skin Tone to 60, and drag 
the Offset wheel slightly toward orange.
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Overall, the resulting grade is much more acceptable. You were able to derive a clean 
qualifier key for the skin tone and adjust it to act as a visual contrast to the blue grade. 
However, because Blue Look is the final node to impact the image before the node tree 
output, you know that the original skin tone hues will always be tinted blue no matter how 
much you grade the Skin Tone node.

This exercise demonstrates how you might determine the placement of nodes based on 
your RGB needs. For example, when using a qualifier, you almost always want to process 
the ungraded or balanced version of the image, free of any severe color or contrast impact.

In the upcoming exercises, you will see examples of how you can derive primary and 
secondary grades from the same point in the node pipeline and recombine them with the 
help of Mixer nodes.

Creating Separate Processing Pipelines 
with a Parallel Mixer Node
Mixer nodes allow you to combine multiple nodes into a single RGB output. The two Mixer 
node types, Parallel and Layer, have identical structures but process the incoming node 
data differently.

The Parallel Mixer combines grades by blending them to an equal degree. The result 
appears similar to working on a linear node pipeline with the main difference being that 
nodes are able to extract RGB data from the same point in the node tree.

1	 In the Airplanes – 01 HQ Timeline, click clip 05.
You will continue to work with the grade you constructed in the previous exercise. This 
time, the Blue Look and Skin Tone nodes will be placed alongside one another for the 
most optimal routing of the RGB signal between them.

2	 Right-click node 03 Blue Look and choose Add Node > Add Parallel or press Option-P 
(macOS) or Alt-P (Windows) to add a Parallel Mixer node.

A new Corrector node (node 05) is created, as well as a Parallel Mixer node that 
combines the RGB outputs of the two nodes before it.

3	 To reuse the qualifier selection of the skin tone, you can select node 02 Skin Tone and 
press Command-C (macOS) or Ctrl-C (Windows) to copy the node data.

4	 Select node 04, and press Command-V (macOS) or Ctrl-V (Windows) to paste.
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5	 ith the qualifier copied, you can delete the old node, 02 Skin Tone.

You now have a node structure in which both the Blue Look and Skin Tone nodes are 
using the same RGB data from the Balance node. Their respective grades are then 
combined at equal strength in the Parallel Mixer node. The mixer sends out a single 
RGB link to the node tree output.

In the viewer, you should notice only a subtle change to the skin tone. You no longer 
have a blue hue on the shadows of the man’s face, and the overall color appears more 
natural. If the appearance is too dramatic, you can select the Skin Tone node and 
reduce the Sat value in the Color Wheel palette, or drag the Offset color wheel point 
closer to the center.

Linear nodes Mixer nodes

Skin tone adjustment using:

The Parallel Mixer is perfect for performing organic and or natural-looking adjustments 
such as skin tone correction or hair work.
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Morphing Mixer Nodes
An alternative to Parallel Mixer nodes is the Layer Mixer node. In the next few exercises, 
you will explore the differences between the two in more detail; in the meantime, you will 
morph the current clip’s Parallel Mixer into a Layer Mixer node to see the impact it will have 
on the image.

1	 Click clip 05 on the Airplanes – 01 HQ Timeline.

2	 In the Node Editor, right-click the Parallel Mixer node and choose “Morph into Layer 
Mixer Node.”

This change has a jarring effect on the image. The skin tone now appears far less 
realistic, and the edge around the face is harsh and solid. This is because node 03 Skin 
Tone is being treated as an RGB image layer. The keyed face has 100% opacity and is 
overlaid onto the node 02 Blue Look image underneath.

In its current state, the grade is unusable. However, by adjusting to the opacity of the 
Skin Tone layer, you can still blend it into the Blue Look layer.

3	 Select node 03 Skin Tone.

4	 In the central palettes, open the Key mixer palette.

5	 Enter the Key Output Gain as 0.300 to reduce the opacity of the skin tone node.
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The face now blends much more naturally into the blue background node.

Both Parallel and Layer Mixer nodes provide an easy option to morph them from one state 
to the other, so you can experiment with grade structure and find the optimal balance and 
blends of nodes.

Having switched between the two nodes and seeing how differently they affect an image, 
let’s look more closely at how these mixers operate. Understanding their operations will 
help you understand when to choose one mixer over another.

Visualizing Mixer Nodes
A simple way to familiarize oneself with how mixers operate is to create a basic RGB 
graphic setup that will clearly display the relationship between the nodes.

First, you will need a plain grayscale background.

1	 Enter the edit page.

2	 Open the Effects Library by clicking the button at the top of the page.

3	 Inside Toolbox > Generators, locate the Grey Scale generator.
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4	 Drag the Grey Scale generator to the end of the timeline.

To work on the generator in the color page, you first need to transform it into a 
compound clip so it can take on video properties.

5	 In the timeline, right-click the generator and choose New Compound Clip.

6	 Name the compound clip Grey Scale.

7	 Enter the color page.

8	 With the Grey Scale clip (clip 12) selected, create a new serial node.

9	 Right-click node 02 and choose Add Node > Add Layer or press Option-L (macOS) 
or Alt-L (Windows) to add a Layer Mixer node.

10	 With node 02 selected, create another layer node to produce a stack of three 
layer nodes.
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11	 Label the nodes (from top to bottom) Red, Green, and Blue.

12	 Select the Blue node at the bottom of the stack.

13	 In the central palettes, open the Window palette, and click the circle button to create a 
circular window.

14	 Open the RGB Mixer palette and make the circle blue by dragging up the B bar of the 
blue channel.

15	 Move the circle window to the lower-right of the viewer. Your goal is to create three 
intersecting circles (red, green, and blue).

16	 Select the Green node and create a circle window in it.

17	 In the RGB Mixer palette, make the circle green by dragging up the G bar of the 
green channel.
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18	 Move the Green node window to the lower-left of the viewer.

19	 Finally, create a red circle in the Red node. Turn it red using the RGB Mixer and move 
it to the top.

The results demonstrate how nodes interact when combined in a Layer Mixer node. 
Their behaviors are reminiscent of layer-based systems in which the upper RGB input 
of the Layer Mixer constitutes the lowest layer and is compounded by each subsequent 
RGB input. The default status of the nodes is to have full opacity until a Power Window 
or qualifier introduces transparency.

20	 Right-click the Layer Mixer node and hover your pointer over the options in the 
Composite Mode submenu.

Doing so will allow you to preview how the colors of the nodes will interact under the 
different hue and luminance blending methods. Note that all the top nodes are blended 
until they reach the bottom layer (Red), which remains at full opacity.

21	 Select Lighten to apply the Composite mode.

22	 To remove the Blend mode, right-click the Layer Mixer node. Return to the Composite 
Mode submenu, and choose Normal.

Next, you’ll change the order of the node layers.

23	 Move your mouse pointer over the link between the Red node and the Layer Mixer 
to reveal the blue highlight. Drag the link to the bottom input of the Layer Mixer to 
disconnect the Blue node from the Layer Mixer.



146Visualizing Mixer Nodes

24	 Drag the RGB output of the Blue node toward the top input of the Layer Mixer.

The red circle now overlaps the green and blue. This further demonstrates how the 
RGB input order in the Mixer node works. Additionally, it emphasizes that the physical 
location of the nodes in the Node Editor has no impact on the grade and the final 
results in the viewer.

25	 To compare the interaction of the circles in the Parallel Mixer, right-click the Layer Mixer 
node and choose Morph into Parallel Node.

This operation changes the behavior of the three circles. Instead of treating the layers 
at full opacity, it adjusts their transparencies to show an equal amount of each. Unlike a 
blend mode, their luminance values are not targeted.

NOTE By default, the RGB mixer preserves image luminance, which produces 
a neutral grey in the area where the three circles intersect. Deselect Preserve 
Luminance in RGB mixer (in all three nodes) for the channels to compound 
their signal strength, resulting in pure white where the three channels overlap.

The composite blending options in Layer Mixer nodes can produce very dynamic looks. 
You can use them to emphasize some areas of your shots or even to compile graphic 
design elements.

The Parallel Mixer is ideal for applying realistic-looking grades on nodes that are 
seamlessly blended into one another while deriving their RGB data from the same level in 
the node pipeline.
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Compositing Color Effects 
with the Layer Mixer Node
In this exercise, you will use a Layer Mixer to construct an image that has several secondary 
grading needs. Unlike the interview example, the focus is not on seamlessly blending the 
colors of the image into each other but to work on each distinct element separately.

1	 Click clip 08 in Airplanes – 01 HQ Timeline.
In the previous lesson, the offline reference clip indicated that the water in this shot 
needed to be turned blue.

2	 In the viewer, drag the playhead closer to the end of the clip to better see the plane 
against the water.

3	 The end of clip 08 is in mid-dissolve with the following clip 09. To disable transitions 
and effects that are on the timeline in the edit page, click the Unmix button in the 
lower-left corner of the viewer.

4	 To bring up the reference video in the color page, right-click the viewer and select 
Reference Mode > Offline. Doing so will adjust the Image Wipe mode to use the 
reference clip associated with the timeline instead of using gallery stills.

5	 In the upper-left corner of the viewer, click the Image Wipe icon to compare the current 
clip to the one in the reference video.
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You have several ways to approach this secondary grade. You could use HSL curves or 
the qualifier, together with the RGB Mixer, wheels, or custom curves. When confronted 
with a specific grade problem, it is common to cycle through several options until you 
find the optimum grading solution. In this instance, you will use a combination of 
techniques, including the 3D qualifier and custom curves.

6	 In the Gallery panel, from the “Base grades” album, apply the 1.8.1 Balance still to 
normalize the luminance of the clip on the first node.

7	 Create a second node and label it Blue Water. You will use this node to turn the image 
blue with focus on getting the correct blue hue in the water.

8	 In the Primaries palette, drag the Hue adjustment control (20.00) until the water 
turns blue.

9	 Drag the Offset wheel towards cyan–blue to further saturate the water while 
refining its hue.

10	 Use the master wheels to brighten the overall image (Gain) but also emphasize the 
shadows in the foreground (Gamma).

11	 Neutralize the clouds reflected in the water by dragging Gain slightly toward magenta.

12	 Finally, improve the detail in the water by raising contrast (1.300).

Note that the plane will also be affected by these grade changes. That is acceptable 
because in subsequent layer nodes you will extract the plane and grade it separately.

13	 Press Option-L (macOS) or Alt-L (Windows) to add a Layer Mixer and a new node 
(node 04). Label the new node Yellow Plane.
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14	 Open the Qualifier palette and change the mode from HSL to 3D. This is the 
recommended qualifier mode for chroma key work due to its ability to intuitively predict 
hue and shadow fluctuations on green screens.

15	 In the viewer, drag the qualifier across the green water to make a selection. You can 
repeat this action as many times as necessary to build a reliable chromakey reference.

Every time you create a color sample, a swatch is placed in the 3D qualifier list to 
document the hues that are included in the selection.

16	 When finished, in the viewer, enable Highlight mode and change it to represent 
the B/W mode.

17	 Adjust the Matte Finesse controls to cover up any remaining unselected areas.
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18	 In the 3D Qualifier window, click the Invert button to focus the extraction on the plane 
instead of the water.

19	 In the viewer, disable the Highlight mode.

20	 In the Qualifier palette, deselect Show Paths to hide the selection lines.

You have successfully extracted the plane and now have full control over its 
RGB values.

21	 In the adjustment controls of the Color Wheel palette, decrease the saturation of 
the plane.

22	 Create a gentle s-curve on the Y channel of the custom curves to enhance the contrast 
and detail on the plane.

Using Key Inputs and Outputs to 
Share Matte Data Across Nodes
The key inputs and outputs allow you to reuse node mattes and further adjust them in the 
receiving node.

In this exercise, you have not yet addressed a remaining component of the composite: the 
flamingos at the end of the clip. In the reference video, the flamingos in the upper-right 
corner of the shot are graded pink. In the current grade, the birds look desaturated and flat. 
Because you have already keyed-out the green water in the Yellow Plane node, it will be 
enough to reuse its key data and add a custom curve window to isolate the focus onto the 
birds in the corner.

1	 In clip 08, click the Yellow Plane node.

2	 Press Option-L (macOS) or Alt-L (Windows) to create a new layer node, and label it 
Flamingos.
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3	 To reuse the matte data of the keyed Yellow Plane node, drag the key output square of 
the Plane node toward the key input triangle of the Flamingos node.

4	 Scrub to the end of the video until you see the area that the flamingos occupy in 
the frame.

To isolate the matte to include just the birds, you can use a Custom curve window.

5	 Open the Window palette and click the Curve window button. Label it 
Flamingos Matte.
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6	 Click around the perimeter of the flamingos in the image. When you’re done, remember 
to click the first point last to close the loop and generate a shape.

The birds appear in the shot only toward the end, so you will perform a rudimentary 
animation of the window across the screen. A simple way to animate windows in the 
color page is by using the Frame mode of the Tracker palette.

7	 Open the Tracker palette and switch the mode to Frame.

8	 Click the diamond-shape in the center of the keyframe controls in the upper-right 
corner of the Tracker graph.

Doing so places the end keyframe for the curve window.



152 153Compositing Color Effects with the Layer Mixer Node

9	 Drag the playhead left until the birds are offscreen, and then drag the curve window 
in their direction outside the viewer. The Tracker graph automatically places a second 
keyframe, and an animation is generated between the two.

The Tracker graph reveals some additional frames at the end of the clip. This is the 
content of the clip used in the transition with clip 09. 

10	 Drag the playhead to the end of the tracker graph and further refine the shape and 
placement of the window.

Finally, there is also a default frame in the Tracker graph at the start of the clip. 

11	 Use the keyframe controls to jump to the start of the clip and move the window 
offscreen.

12	 Scrub through the clip timeline to ensure that the window is following the 
birds’ movement.

You can now make the necessary grade adjustments to enhance the birds’ pink color.

13	 Drag the Gain master wheel left to darken the birds slightly.

14	 Drag the Gain color wheel toward magenta to turn the birds pink.

To simplify your pipeline and prepare it for further grading nodes, you can combine all 
the Layer Mixer nodes into a single compound node.
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15	 Drag in the Node Editor to select all the nodes except the Balance node.

You now can press Command-D (macOS) or Ctrl-D (Windows) to quickly bypass and 
evaluate the selected nodes without affecting the Balance node.

16	 Right-click any selected node and choose Create Compound Node.

This step is an effective organizational tool when working on clips with large node tree 
structures. Additionally, you can still bypass the node to disable the color composites 
without affecting the Balance node.

You still have access to the original Layer mixer structure within the Compound node.

17	 Right-click and choose Show Compound Node.
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18	 To navigate back to the main Node Editor, click the project name Project 02 – 
Age of Airplanes Trailer link at the bottom of the panel.

19	 If you want to return to the original node structure of the Compound node, right-click 
and choose Decompose Compound Node.

TIP Another method for decluttering the Node Editor is to hide node thumbnails. 
In the upper-right corner of the Node Editor, click the Options menu and deselect 
Show Thumbnails. Doing so will collapse the nodes to just their labels, numbers, 
and palette icons.

The exercises in this lesson gave you an overview of the potential of the Node Editor. 
Though you’ve practiced a variety of possible workflows, there is ultimately no single 
correct way to utilize nodes in grading. Continue to practice using nodes for more 
advanced grading and you will soon arrive at your own preferred style. Above all, aim for 
the dual goals of workflow efficiency and the preservation of image quality.

Check Your Work 
When you’ve completed these lessons, you can open the Project 02 – Age of Airplanes 
Trailer COMPLETED.drp to compare your work with the finished version of this timeline. If 
the media appears offline, click the red Relink Media button in the upper-left corner of the 
Media Pool and specify the location of the Project 02 media on your workstation.

Lesson Review
1	 Can a Corrector node have multiple RGB inputs?

2	 What are the blue symbols on either side of a node?

3	 True or False? A node key can be connected to the input of a node that is in the same 
parallel or layer mixer stack.

4	 In the Key palette, what does the Key Output Gain affect?

5	 True or False? You can add additional RGB inputs to Mixer nodes.
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Answers
1	 No. A Corrector node can have only a single RGB input, though it can have multiple 

RGB (and key) outputs.

2	 The blue symbols represent key input and output.

3	 True. A node output (both RGB and key) can be linked to any other input further down 
the pipeline, as well as to other nodes in a mixer stack.

4	 Key Output Gain affects the opacity of a selected node.

5	 True. Right-click a mixer node to add more inputs.
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Lesson 6

Managing Grades Across 
Clips and Timelines

Grading a film or video project requires a 
considerable level of attention to detail and 
the use of a variety of tools throughout 
both primary and secondary stages. 
However, once a look is established, a 
project often makes repeated use of 
existing grades that propagate throughout 
the timeline. An obvious example of this is 
when you are working on multiple clips that 
come from the same source file, or clips 
used from different takes of the same shot.

DaVinci Resolve 17 includes a wide variety 
of workflows that help reproduce and 
refine grades across clips. These include a 
straightforward copy and paste, extraction 
of individual nodes for isolated 
adjustments, and even the migration of 
grades across different timelines. In this 
lesson, you’ll examine the variety of 
workflows you will need to efficiently copy 
and manage grades within a single project 
and beyond.
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Copying Grades from Clips and Stills
When copying grade data across clips or stills, you copy the entire node pipeline of the 
original clip. This pipeline includes all primary grading adjustments, secondary selections, 
mixers, external keys, and compound nodes. Because secondary selections, such as the 
qualifier and Power Windows, tend to be specific to the clip they were generated on, you 
need to double-check and adjust their accuracy before continuing with your grade.

In the previous lesson, you applied a grade from a still in the gallery. You can perform the 
same action using current clips in your timeline.

1	 Open Project 02 - Age of Airplanes Trailer.

2	 Enter the color page.

3	 In the Airplanes - 01 HQ Timeline, click clip 06. Selected clips are always the target 
when copying grading data.

4	 Right-click clip 01, and choose Apply Grade. 

The node pipeline from the clip 05 interview clip is copied to the selected clip 06, 
overwriting any previous nodes. The clip-specific face tracking in the Skin Tone node 
(03) was not migrated, which gives you the opportunity to perform a new track to the 
new face motion in clip 06. However, if you ever want to retain the original track data 
when copying grades, in the Tracker palette options menu, you can choose Copy Track 
Data and Paste Track Data across clips.

Another useful tip when copying grades between clips and stills is to use your middle 
mouse button, if available.

5	 Click clip 04.

6	 In the gallery, open the Base Grades album. 

7	 Middle-click the 1.4.1. Balance still.

This simple motion transfers the still’s balance grade to clip 04.

In the next exercise, you will build upon the grade in clip 04 and start to experiment with 
different looks using local grade versions.
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Working with Local Versions
Versions enable you to associate multiple grades with a single clip in a timeline. You can 
use versions to preserve a grade at earlier stages of the grading process or when creating 
a series of shot-grading options to share with a creative supervisor for selection and 
approval. Each version remains intact and can be recalled when needed. Versions are 
easily accessible in the contextual menu of each clip and can be created, deleted, 
bypassed, and switched between local and remote.

In this exercise, you will begin by creating a new grade on a clip, and then you’ll apply 
preexisting grades from the gallery to quickly build up a set of local versions.

1	 In the Airplanes - 01 HQ Timeline, continue to work on clip 04.

2	 For a better representation of the clip’s content, drag the playhead to the middle of the 
clip where the plane is in view.

3	 Create a second node labeled Cross Process.

4	 Open the Custom curves palette. To create a cross-process look, you will want to push 
opposing complementary colors into the image highlights and shadows. This tends to 
result in a retro film camera look.

5	 Click the YRGB link to ungang the channels.

6	 Isolate the blue channel and drag the black point up to turn the shadows blue. Then 
drag the white point down to turn the highlights yellow.
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7	 Isolate the red channel, create a new control point in the upper midtones, and drag 
upward to add a slight red tint to the highlights.

8	 Create a new serial node 03 and label it Contrast.

9	 In the adjustment controls of the Color Wheel palette, increase the contrast of the 
image (1.100) and use the pivot to reduce the strong exposure in the sky (0.700).

10	 To sharpen the detail in the reefs under water, increase midtone detail (50.00) in the 
adjustment controls.

You have now successfully created the first look for this shot. By default, every clip 
begins as Local Version 1. You can rename the version to identify a specific look or 
purpose of a grade.

11	 In the timeline, right-click the clip 04 thumbnail, and under Local Versions, choose 
Version 1 > Rename.

12	 Enter the name Cross process and click OK.

You will apply several variants of grades on this clip. Each variant will be designated as 
a new local version. To save time, you will use the preexisting grades in the Clip 04 
grades album of the gallery.

13	 Right-click clip 04 and choose Local Versions > Create New Version. 
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Enter the name Bleach bypass.

14	 Reset the cross process grade by choosing Color > Reset All Grades and Nodes or 
press Command-Home (macOS) or Ctrl-Home (Windows).

This is a necessary step if you want to start with a fresh clip every time you design 
a new look. Otherwise, you can continue tweaking the image using the previous 
grade’s settings.

15	 In the Clip 04 grades album, middle-click the Bleach bypass still to apply the grade.

TIP When you hover over the stills in the gallery, a preview of their grades will 
appear over the clip in the viewer. To disable or change Live Preview 
behavior, click the three-dot options menu in the upper-right corner of the 
gallery. Click Live Preview to disable it or move your mouse pointer over 
Hover Scrub Preview to choose if the image will scrub in the Viewer and 
Thumbnail, Thumbnail only, or neither.

16	 To make another version, right-click the clip again and choose Local Versions > Create 
New Version. Enter the name Simple pop.

You could reset the grade again, but because you are simply overwriting the current 
grade with the still grade, that will not be necessary.

17	 In the Clip 04 grades album, middle-click the Simple Pop still to apply the grade.

TIP Press Command-Y (macOS) or Ctrl-Y (Windows) to create a new version 
in a clip.

18	 Right-click clip 04 and choose Local Versions > Create New Version. Enter the name 
Navy blue.

19	 In the Clip 04 grades album, middle-click the Navy blue still to apply the grade.

Having created a series of versions, you can now compare them in the viewer using a 
split-screen display.



162Working with Local Versions

20	 At the top of the viewer, between the Image Wipe and Highlight buttons, click the Split 
Screen button.

21	 In the upper-right corner of the viewer, choose Version.

The split-screen view is enabled, displaying all four grades in a grid in the viewer.

Comparing the versions might be difficult at the moment because they have been 
scaled-down to fit into the small viewer window. You can resize the viewer for full-
screen playback and optimal viewing.

22	 Choose Workspace > Viewer Mode > Cinema Viewer or press Command-F (macOS) or 
Ctrl-F (Windows).

In the next few exercises, you will apply the cross process look to other clips in 
the timeline.
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23	 In the upper-left corner of the split-screen view, double-click the Cross process version 
to select it.

24	 Press Esc to exit the full-screen mode.

25	 Right-click in the viewer and choose Split Screen > On/Off to disable the split-screen 
view or click the Split Screen button above the viewer.

TIP Press Command-B or Command-N (macOS) or Ctrl-B or Ctrl-N (Windows) to 
cycle through the versions of a clip in the viewer.

Remote Versions
In the contextual menu, under the Local Versions options, you may have noticed a 
similar section for Remote Versions. This area offers another method of retaining 
multiple grades in a clip.

Remote versions are different from local versions in two ways: first, when a clip is 
graded within a remote version, its grade affects all other timeline clips that were 
derived from the same source clip; second, the grade appears on all subsequent uses 
of the source clip in all other timelines of the active project (provided that the clips in 
those timelines are also using remote versions).

One popular application for remote version grading is for a DIT (digital imaging 
technician) using master timeline workflows. Upon ingesting, you can place all the 
media on a remote timeline and apply preliminary grading to the clips. When you 
eventually create a cut in the edit page or import an editor’s timeline, those remote 
grades automatically transfer to the new timeline. In short, local version grades are 
applied on a timeline basis, whereas remote versions are applied on a project basis.

Appending Grades and Nodes
In the previous exercise, you applied stills grades to a clip by choosing the Apply Grade 
contextual menu option or by pressing the middle button of your mouse. Doing so 
overwrites the existing grade on a clip and replaces it with the entire node tree of the 
copied grade. At times, you will want to apply just portions of a node tree or add the node 
tree after a clip has undergone balancing or matching.
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The following exercises will show you how to be selective in copying grade nodes.

1	 Click clip 02 on the Airplanes – 01 HQ Timeline. You will apply the previously created 
cross process grade to this clip.

Clip 02 is currently unbalanced with a strong yellow tint. You could normalize and 
balance it, but that would not necessarily optimize it for the cross process grade. As 
you learned in Lesson 2, clips must be matched to share grade data accurately. Without 
matching, grading tools will behave unpredictably, and the differences between the 
clips will continue to be obvious.

A match was already prepared for this exercise.

2	 Open the Base grades album and apply the 1.2.1. Match still to the clip. To more 
closely match clip 04, the clip has been brightened and cooled.

3	 Open the Clip 04 grades album.

A cross process grade is already prepared and stored in the gallery. If you directly 
apply the cross process still from the gallery, it will overwrite the match node you just 
applied to the clip. Instead, you will append the cross process grade to the current 
node graph.
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4	 Right-click the 1.4.1 Cross process still and choose Append Node Graph.

TIP You can also drag a still from the gallery onto a connection line in the 
node graph to append it to an existing grade.

Clip 02 now has its original match node followed by the cross process pipeline. 
However, the grade still does not look right. By appending the grade, you added all the 
nodes from the original cross process grade, including the original Balance node that 
was created specifically for clip 04. That node does not work in the context of clip 02 
and should be deleted.

5	 Select node 02 Balance and press the Delete or Backspace key.

You now have a clean cross process look on the second airplane shot that more 
closely resembles the one in clip 04. You’ll apply this same look to a third shot but 
without the Balance or Contrast nodes.
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Copying Individual Nodes from a Still
So far, you have used all the grading data stored within stills. You copied and appended 
the entire node pipeline to the Node Editor and tweaked the nodes based on the 
clips’ needs.

However, you also have access to a still’s node graph while it is still in the gallery. This 
allows you to apply very specific adjustments from a saved grade.

1	 Click clip 03 on the Airplanes – 01 HQ Timeline.

This clip looks relatively neutral but is distinctly different from the starting looks of 
clips 02 and 04. As in the previous exercise, you will apply a match still to prepare it 
for the cross process look.

2	 Open the Base grades album and apply the 1.3.1. Match and Contrast still to the clip.

Doing so significantly alters the look of the clip but is vital for ensuring a good base for 
the incoming grade. The Match node is there to mimic the bright blue tint of clip 02, 
while the Contrast node addresses the stark difference in location and shot angle to 
more closely match the final luminance ranges of clips 02 and 04.

You can now proceed to apply the cross process grade. Because the clip is balanced 
and already has correct contrast, you need only transfer the Cross Process node itself.



166 167Appending Grades and Nodes

3	 Open the Clip 04 grades album, right-click the 1.4.1 Cross process still, and choose 
Display Node Graph.

The node graph appears in a separate window with the node pipeline of the grade as 
it appeared in the Node Editor when the still was generated. To the right of the window, 
a tabbed interface allows you to apply only the color or sizing adjustments of the node 
graph (PTZR: pan, tilt, zoom, rotation). A button at the top allows you to switch to a 
node-based refinement of the parameters that you will include during copying.

4	 From the still’s node graph window, drag node 02 Cross Process to the Node Editor of 
clip 03. While holding down the mouse button, position the pointer over the connection 
link between node 01 Match and node 02 Contrast.

A + (plus sign) will appear over the link to signify that you can release the mouse button 
and attach the Cross Process node between Match and Contrast.

5	 In the still’s node graph window, click Close.

Having access to the node structure of every still facilitates cleaner, more precise 
workflows. You separate the primary balance and match nodes from the contrast and 
creative look nodes and copy only what is necessary for every new clip grade. As with all 
grading, you should tweak and refine the grades to ensure maximum visual quality 
and similarity.
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Saving Grades for Other Projects
The stills contained in the gallery albums of the color page will ordinarily be accessible only 
in the project. A different kind of gallery album, the PowerGrade, makes stills accessible to 
all other projects generated by the user (within the same database).

1	 In the Still Albums list of the gallery, open the Clip 04 grades album.

2	 Drag the Bleach bypass still to the PowerGrade 1 album near the bottom of the list.

3	 Click the PowerGrade 1 album to view its contents. The Bleach bypass will now appear 
in the PowerGrade 1 album of all the projects you create in the same database on your 
workstation.

The Gallery panel also has additional features contained in its expanded version.

4	 In the upper-right corner of the gallery, click the Gallery View button.

A separate window opens displaying the full contents of the gallery.

The Stills panel in the upper left features a collection of DaVinci Resolve looks and 
provides access to stills from other databases and projects on the same workstation. 
The Group Stills panel next to it displays the stills associated with the currently 
selected album.

At the bottom is the current project’s Gallery panel, and to the left is the Project 
Memories panel in which you can designate shortcuts to frequently used stills.
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TIP To save a still as a memory, drag it from the gallery onto one of the 
memory slots. You can apply these memories to clips on the timeline using 
shortcuts that correspond to the letter of the memory as expressed 
numerically. For example, memory B will have the shortcut Command-2 
(macOS) or Ctrl-2 (Windows).

5	 In the lower half of the full Gallery window, select the PowerGrade 1 album.

6	 In the DaVinci Resolve Looks list, select the Skin album and drag the Diffused still into 
the Powergrade 1 album in the Project Stills window below.

You’ve now moved one of the preset stills into the gallery and will be able to apply it to 
the current project.

7	 Close the Gallery view.

8	 Click clip 07 on the Airplanes – 01 HQ Timeline.

9	 Open the Base grades album and apply the 1.7.1. Balance still to the clip.

10	 Open the PowerGrade 1 album and append the Diffused still to the clip.
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Outside of using databases and PowerGrade albums, you can also share grades 
across different workstations by exporting them from the gallery.

11	 In the gallery, open the Clip 04 grades album and right-click the 1.4.1. Cross process still.

12	 In the pop-up menu, choose Export.

The still’s visual and grading information is exported and contained in two files. The 
DPX file format is an image format used for comparison and review. The DRX file 
contains the node tree and grading data. You need both files to migrate stills with 
grade information.

NOTE Selecting Export with Display LUT will export the DPX and DRX files in 
a format that is supported by monitoring applications. You can upload these 
files to camera viewers or monitor displays.

13	 Indicate a location on your workstation, create a new folder for the two files, and 
click Export.

14	 Open a file browser on your computer and locate the two files.
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You can share the DPX file as you would any regular image file without the need for 
Resolve. The DRX file is a DaVinci Resolve exchange file used to carry the grading 
parameters for the shot and can only be used together with the DPX. To import a grade 
into a new Resolve project, both files must be located in the same folder or directory.

Let’s import a grade that was created for one of the clips on the timeline.

15	 Return to the color page, and in the gallery, open the PowerGrade 1 album.

16	 Right-click and choose Import.

17	 In the file browser, locate the BMD 17 CC – Project 02 folder and navigate to Other > Stills.

18	 Select Punchy film_1.9.1.dpx and click Import.

Note that you only need to import the single DPX file. The DRX file is bound to the DPX 
and its grading data will be included in the still upon import.

19	 Apply the Punchy film grade to clip 09 (HAWAIIAN_LANDING) in the timeline.

TIP You can double-click a PowerGrade still to apply the grade to a selected 
clip on the timeline.

Here are some additional options for working with the gallery and stills that many colorists 
employ for organizational and practical purposes:

	� Right-click in the viewer and choose Grab All Stills. Doing so will generate a still for 
each clip in the timeline (either from the first or middle frame) and place them in the 
media pool. Colorists use this option to keep track of their grade process over time 
(day 1, day 2, and so on) or separate the stills into pass bins (balance, match, secondary, 
and so on).

	� Right-click in the gallery and choose One Still Per Scene. This choice will restrict the 
number of stills you generate from any given clip to a single still. This popular option is 
for colorists who frequently grab stills of their clips while grading and do not want their 
galleries to become cluttered with thumbnails.
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TIP You can create an ungraded (but fully labeled) node pipeline and save it as a 
still to use as a template for future grades.

Copying Timeline Grades Using 
ColorTrace
ColorTrace is a feature in DaVinci Resolve that enables the transfer of grading information 
from one timeline to another. It is a much faster and more organized method of copying 
mass grade data than using stills.

One scenario in which you may use ColorTrace is when multiple project types use the 
same source materials (film, trailer, teaser, behind-the-scenes, and so on). Another scenario 
is when an editor creates changes in a timeline that a colorist has already begun grading. In 
both cases, a major task would usually await the colorist: a still would need to be created 
for each clip in the old timeline and then carefully re-applied to each corresponding clip on 
the new timeline. This job is full of error potential because an overworked colorist might 
have to generate, organize, and retrack dozens (or hundreds) of stills in the gallery.

ColorTrace bypasses all that by presenting two timelines side-by-side and helping the 
colorist identify where their common media is located. The colorist then needs only to 
confirm (or deny) that the media is correct, and the transference of grading data is 
instantaneous.

1	 Enter the edit page, and in the media pool, open the timelines bin.

2	 Choose File > Import > Timeline.

3	 Navigate to the Project 02 – Age of Airplanes Trailer folder, open the XML subfolder, 
and select Airplanes – 02 Color Trace.xml. Click Open to import it.

4	 In the Load XML window, deselect the option to Automatically import source clips into 
the media pool and click OK.

A pop-up window will prompt you to indicate the bins where the timeline’s media 
are contained.
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5	 Expand the bin structure and deselect the LQ Transcodes bin to ensure that the 
media is linked only to the high-quality versions of the clips. Click OK.

NOTE AERIAL_SFO.mov will appear offline on the timeline because you have 
previously only used the LQ version of this clip. Enter the media page, 
navigate to the BMD 17 CC - Project 02 folder > HQ Transcodes and drag the 
HQ version of this clip into the media pool HQ Transcodes bin. Remember to 
set the Input Color Space of the clip to Blackmagic Design Film Gen 1 to 
ensure it is correctly color managed. Then change the clip color to orange to 
match the rest of the timeline media.

The Airplanes - 02 Color Trace edit will appear in the Timeline panel of the edit page. 
The orange color of the clips informs you that they are from the HQ Transcodes bin.

6	 Enter the color page to check the grade status of the clips.

None of the grades applied to the Airplanes – 01 HQ Timeline were transferred.

7	 Return to the edit page.

8	 In the media pool, right-click the Airplane – 02 Color Trace timeline, and choose 
Timelines > ColorTrace > ColorTrace from Timeline.
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9	 n the ColorTrace Setup window, expand the database folder and locate Airplanes – 
01 HQ Timeline.

Effects and Definitions
The Effects and Definitions panel underneath the Project list enables you to define a 
set of naming conventions for clips in the timeline with names that were changed since 
the original timeline versions.

An example is applying this feature in VFX workflows. Assume that the original 
filenames of two timeline clips were car.mov and sky.mov. Both clips were sent to the 
VFX department for some compositing work. The VFX department returns the finished 
composites under the names car_vfx.mov and sky_vfx. mov, and they are inserted into 
a new version of the timeline. When ColorTrace is used to transfer the grading data 
from the original timeline, the two VFX clips are not recognized due to their new 
filenames. By entering *_vfx in the Effects and Definitions panel, Resolve can exempt 
the suffix when associating the media between the timelines.

10	 Select the HQ Timeline and click Continue to proceed to the ColorTrace interface.

At the top of the interface, you’ll find options to switch between the Automatic and 
Manual modes of the feature.

Automatic attempts to locate the same clips used in both timelines based on source 
name, regardless of any change in position or trim.

Manual allows you to identify matched clips by selecting them yourself. Using this 
method, you can assign grades when the original filenames or metadata were changed 
between edits.
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The bottom of the interface provides additional information and control over the copy 
parameters. To the left is a table that compares the metadata of the source and target 
clips, which is useful when comparing the file paths of two clips to ensure that they are 
derived from the same take. To the right is a list of criteria that will be included or 
removed during the grade transfer.

The clips in the Target Timeline have colored outlines that indicate the grade match 
status of the clips:

	– Red—No match was found.
	– Blue—Multiple potential matches were found.
	– Green—A match was found.

You will need to review the Target Timeline to ensure that the matches are accurate.

TIP Select Hide Matched Clips at the bottom of the interface to remove all 
clips that are already matched in the timeline. Doing so will allow you to focus 
on the clips with no matches or conflicting matches.

11	 Clip 01 on the Target Timeline has a blue outline. Select it to see which clips are 
proposed as possible options in the Matching Source Clips list above it.
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Clip 01 clearly corresponds to the clip numbered as 09 in the source clips window. You 
can verify this by looking at the table at the bottom of the ColorTrace interface and 
checking the Name property of the source and target clips.

12	 Double-click clip 09 to confirm the match. Both clips’ outlines will turn magenta to 
confirm the selection.

13	 Clip 02 also has a blue outline. Select it, and double-click the corresponding clip 08 
above to confirm the correct match.

14	 Clip 03 has a red outline and offers no options in the Matching Source Clips list. You 
will address this clip manually after first confirming the automatic matches.

NOTE You can choose Set As New Shot to identify clips with no links to the 
original timeline. They will appear ungraded after the ColorTrace is performed.

15	 Clip 05 is the last clip with a blue outline. Select it and double-click clip 04 in the 
matching source clips list to confirm the correct match.

16	 At the bottom of the window, click Copy Grade to confirm the copying of grade data 
between the green and magenta clips.

17	 To resolve the red clips, click the Manual tab at the top of the window.

18	 In the Target Timeline, select clip 03.

The source timeline does not feature this clip. However, it is extremely similar to clip 02, 
which features a wider version of the same shot.

19	 In the source timeline, select clip 02 and click Paste to confirm the grade transfer.

20	 Click Done and exit the ColorTrace interface.

21	 Enter the color page to verify that all the clips that were graded in the 01 HQ Timeline 
were successfully copied to the 02 Color Trace timeline.
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NOTE Keying and tracking data is preserved when copying grades using 
ColorTrace. Check clip 06 in the 02 Color Trace Timeline to verify that the qualifier 
selection and window track successfully traveled to this new instance of the 
interview clip.

Just as migrating timelines requires conforming, the ColorTrace function also calls for some 
manual review to ensure that all grades have transferred correctly. Regardless, ColorTrace 
still substantially reduces your workload by managing the majority of the color 
transference process.

Copying Grades Using the 
Timelines Album
One of the quickest ways to transfer a grade between clips in different timelines is by using 
the Timelines albums in the gallery.

In the previous exercise, one clip in the Airplanes – 02 Color Trace timeline remained 
ungraded because its counterpart in the 01 HQ Timeline was also ungraded. In this 
exercise, you will perform a quick grade on the remaining clip and transfer it to the 
original timeline.

1	 In the Airplanes – 02 Color Trace timeline, click clip 08.

2	 In the Custom Curves palette, ungang the channels and adjust the R and B curves to 
give the nighttime footage a deep blue tone with orange highlights.

3	 In the Primaries palette, use the Gamma and Gain master wheels to establish a 
dynamic contrast between the dark foreground and well lit horizon.

Before After

4	 Use the pop-up menu above the viewer to return to the Airplanes – 01 HQ Timeline.

5	 In the Gallery panel, click the Timelines album.
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6	 Use the upper pop-up menu to switch the gallery to the Airplanes – 02 Color Trace 
timeline stills.

The gallery now displays the current state of all the clips in the 02 Color Trace timeline. 
Note that even the ungraded credits clip is included. This behavior helps you keep 
track of both graded and ungraded clips in various timelines.

7	 In the Airplanes – 01 HQ Timeline, select clip 10.

8	 In the gallery, middle-click clip 08 to transfer the graded night sky look.

The exercises in this lesson presented a broader list of options for grade setup and 
duplication. When copying grade data, it is important to consider your needs on a project- 
by-project basis. In most cases, a combination of one or more of these copying methods is 
ideal; in other cases, a mix of methods could be less efficient than employing a more 
broad-based solution such as ColorTrace.

Self-Guided Exercise
Complete the following exercises in the Airplanes – 01 HQ Timeline to test your 
understanding of the tools and workflows covered in this lesson.

Clip 01—Match this darker interview shot to the one in clip 05. Begin by disabling the Blue 
Look and Skin Tone mixer nodes in clip 05 and then apply a venetian blind wipe in the 
viewer to accurately assess and match the walls and subject skin tone in clip 01. Then, use 
any of the methods covered in these lessons to transfer the remainder of the node tree 
after the match node. Ensure the face window is tracked to the unique movements 
in clip 01.

Clip 07—Create a remote grade link between clip 07 in 01 HQ Timeline and clip 07 in the 
02 Color Trace timeline. Begin by reading the documentation about remote grading at the 
end of the “Working with Local Versions” lesson. In 01 HQ Timeline, right-click clip 07, and 
under Remote Versions, choose Version 1 > Load. Apply the Base grades balance node 
and then create a new serial node and develop a new look for the shot. Open the 02 Color 
Trace timeline and load remote grade version 1 on clip 07. The new look you created 
should automatically appear on the clip.
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When you’ve completed these lessons, you can open the Project 02 – Age of Airplanes 
Trailer COMPLETED.drp to compare your work with the finished version of these timelines. 
If the media appears offline, click the red Relink Media button in the upper-left corner of the 
Media Pool and specify the location of the Project 02 media on your workstation.

Lesson Review
1	 How do you create a new local version of a grade?

2	 Which shortcut resets a clip’s entire grade?

3	 How can you access stills saved in other projects and databases on the workstation?

4	 How do you copy just one node from the node tree of a still in the gallery?

5	 Yes or no? You can create keyboard shortcuts for your favorite grades and stills.
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Answers
1	 Right-click and choose Local Versions > Create New Version or press Command-Y 

(macOS) or Ctrl-Y (Windows).

2	 Command-Home (macOS) or Ctrl-Home (Windows) resets a clip’s entire grade.

3	 Click the Gallery View button to access the expanded gallery.

4	 Right-click the still, and choose Display Node Graph. Then drag the necessary node 
into the Node Editor of the active clip.

5	 Yes, you can create grade keyboard shortcuts in the form of Project Memories.



Part III

Optimizing the 
Grading Workflow
Lessons

	� Using Groups 
	� Adjusting Image Properties
	� Working with RAW Media
	� Project Delivery

Welcome to Part III of The Colorist Guide to DaVinci Resolve 17. This section covers more 
advanced node-based grading workflows and looks under the hood of the many Resolve 
processes that manipulate and render image data. As usual, the emphasis will be on 
image-processing efficiency as you adopt group grading workflows, adjust image 
properties, set up RAW materials, and deliver the final project.

Project File Location
You will find the content for this section in the folder BMD 17 CC - Project 03. Continue to 
follow the instructions at the start of every lesson to find the necessary folder, project, and 
timeline. If you have not downloaded the third set of content files, return to the “Getting 
Started” section in this book for more information.
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Time
This lesson takes approximately 
130 minutes to complete.

Lesson 7

Using Groups 

In this lesson, you will focus on an 
organizational feature of the color page 
that enables clip grouping based on 
shared visual criteria.

Although generating and organizing 
groups is incredibly simple, they open 
up a new grading workflow within the 
color page. In addition to applying 
group-wide grades via the Node Editor, 
the grouping feature allows timeline 
filtering based on group name and the 
activation of a split screen to compare 
clips in the same group.
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Cut Detection	 184

Creating a Group	 193

Applying Base Grades at the 
Pre-Clip Group Level	 196

Making Clip-Specific Adjustments 
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Automatically Tracking People 
and Features	 205

Creating a Unifying Look 
Using the Post-Clip Group Level	 216
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Self-Guided Exercises	 228

Lesson Review	 229
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Preparing Media Using Scene 
Cut Detection
Your final video project in this book involves a single, self-contained video file. Placing the 
video file directly into a timeline in DaVinci Resolve 17 would result in it being treated as a 
single clip, and all grading changes would affect it uniformly. To avoid this situation, you can 
place cuts throughout the timeline to separate the individual shots and allow for content-
specific grading. Unfortunately, doing this manually is time consuming.

Fortunately, the Scene Cut Detection feature in Resolve performs the heavy lifting for you. 
It can analyze edited video files prior to import to divide their content into subclips and 
facilitate clip-by-clip grading.

1	 Open DaVinci Resolve 17.

2	 In the Project Manager, click the New Project button and enter the name  
Project 03 - The Long Work Day Commercial.

3	 Right-click in the bin list next to the media pool and choose Add Bin. Label this 
new bin Video.

4	 In the Media storage library of the media page, locate the BMD 17 CC - Project 03 folder.

5	 In the folder, right-click the Project 03 - The Long Work Day SCD.mov file and choose 
Scene Cut Detection.

Left Viewer 
Previous Frame

Center Viewer 
Current Frame

Right Viewer 
Next Frame

Scene Detect graph Cut List
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The Scene Detect window appears. You will use this interface to run the edit analysis 
and import the resulting subclips. At the top of the window, three viewers display the 
current frame (middle), the previous frame (left), and the following frame (right). Below 
the viewers, the Scene Detect Graph displays the location of the video’s cut points 
after the analysis. To the right, the Cut List identifies the cuts and their timecodes.

6	 In the lower-left corner of the window, click Auto Scene Detect.

As the analysis is run, the assumed edit points are marked with green lines in the 
Scene Detect Graph, and their timecodes are recorded in the Cut List.

TIP The height of the green cut lines indicates Resolve’s level of confidence that 
a cut was correctly identified in that location. Cuts that fall under the magenta 
confidence line are omitted from the cut list and appear gray on the graph.

When a video has many jump cuts and whip pans, the scene detection might 
place many cuts beneath this confidence line. To include less confident cuts 
in the final Cut List, drag down the magenta line until the edit lines turn green.

7	 To review the edits, scrub through the timeline by dragging the orange playhead or 
click inside the Cut List and press the Up and Down Arrow keys to navigate and verify 
the cut points.

TIP You can also press P (previous) and N (next) to jump between cut points.

A correctly identified cut will display a unique image in the left viewer, followed by two 
similar images in the next two viewers.
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8	 Navigate through the edits in the Cut List until you reach scene 12.

Although Resolve detected a cut here, this is actually part of the same take. The false 
detection happened due to a headlight-caused lens flare that created enough of a 
visual change in the frame to make Resolve identify it as the start of a new shot.

9	 With the cut already selected, in the lower left of the Scene Cut Detection window, 
click Delete to remove it.

10	 Press the Down Arrow key to continue navigating through the Cut List and ensure that 
all cuts are correctly located.

Toward the end of the timeline, you will find a large cluster of cut points. Dissolves and 
transitions are prone to misidentification and may be identified as a series of rapid cuts.

11	 Drag the playhead in front of this cluster and press I to create an In point in the Scene 
Detect graph.

TIP Drag the scroll bar under the scene cut graph to zoom in on the cut 
points, if necessary.

12	 Drag the playhead after the cut cluster and press O to place an Out point.
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13	 Under the right viewer, click the scissors icon to delete this batch of false cut points.

14	 Ensure that no other cut points from the transition area remain. If one is still present, 
drag the mouse over it and press Delete.

15	 Press the Left and Right Arrow keys to move through the video frame-by-frame and 
identify the exact cut point between the last clip and the solid white color matte at the 
end of the timeline.

16	 Click Add to add the edit to the Cut List. A green line appears under your playhead to 
indicate an edit point. A new item also appears on the Cut List with the frame number 
(2352) and start timecode (01:01:38:00) of the cut.

You have now addressed all the issues on this timeline. At this point, you should have 
26 scenes in your Cut List.

17	 In the lower-right corner, click Add Cuts to Media Pool.

TIP When working on longer films, or with edits featuring jump cuts, reviewing 
scene cut detection can become a time-consuming (and fatiguing) process. 
You may choose to break up the task into several sessions, saving your 
progress as you go.

You can save a scene cut in progress by accessing the options menu in the 
upper-right of the window and choosing Save Scene Cut. In the same options 
menu, you can also open a previously saved scene cut file.

18	 If a dialog appears to inform you that your Project Settings don’t match the clips’ frame 
rates and video formats, click Change to adjust the project timeline to accommodate 
your media.

19	 Close the Scene Cut Detection interface.

The commercial will now appear in your media pool as a series of clips in the Video bin.

Before you can start grading your cut media, you will first place it in a timeline. To 
ensure that the clips fill the timeline in the correct order, you will organize your media 
pool by clip timecode.

20	 Switch to List view by click the List View button in the upper right of the media pool.

21	 Click the Start TC column title to sort the clips by their start timecodes.

The clips are now ready to be placed into a timeline.
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22	 Enter the edit page.

23	 Select all the media in the Video bin by selecting one clip and pressing Command-A 
(macOS) or Ctrl-A (Windows).

24	 Right-click any of the selected clips and choose Create New Timeline Using 
Selected Clips.

25	 Name the new timeline Project 03 - The Long Work Day and click Create.

A new timeline appears on the edit page populated with the 27 selected clips in the 
media pool.

26	 In the media pool, create a Timelines bin and place the timeline into it.

TIP In DaVinci Resolve Studio, scene cut detection can still be performed on 
media after it has already been imported and added to a timeline. Click to select a 
clip on a timeline, or use In and Out points to indicate a range of clip(s), and then 
choose Timeline > Detect Scene Cuts. The resulting cuts can be edited via the 
rolling trim tool or deleted using the Backspace key. Additionally, you will be able 
to apply dissolves between clips, if necessary.

You would ordinarily use this method of flattened video migration when working with 
remote clients that do not have access to servers or fast internet connections. Additionally, 
this workflow is often necessary when working on older projects in which the original 
media no longer exists, and only the master export file is available. In both cases, it’s 
crucial to use the highest-quality codec and file format possible and to avoid overlaid 
text, effects, or transitions that cannot be disabled in the flattened video file.
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Setting Up Color Management in the 
Davinci≈Wide Gamut
As in the previous project, you will use color management to remap the color space and 
gamma of the clips in the timeline prior to grading. In this exercise, you will look at a few 
additional features for more accurate tonal mapping.

1	 Enter the color page.

2	 Press the Up and Down Arrow keys to travel along the timeline and review the clips in 
the Project 03 - The Long Work Day timeline.

The footage appears flat and desaturated, which is indicative of a log color space. This 
indicates that you have access to a wide dynamic range within the image but currently 
have a poor starting point for your grade. 

3	 Open the Project Settings and navigate to the Color Management tab.

4	 Set Color Science to DaVinci YRGB Color Managed.

5	 Set the Resolve color management preset to DaVinci Wide Gamut.

The current setting is optimal for outputting the project to the majority of deliverable 
standards. You can further customize it to correctly remap the source media to the 
Timeline and Output color spaces.

6	 Change the Resolve color management preset to Custom. All the DaVinci Wide Gamut 
settings are transfered to a modifiable list of parameters.
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What Is DaVinci Wide Gamut?
The DaVinci Wide Gamut is an internal color space that encompasses the maximum value of 
image data that any given camera can capture. The color space is greater than BT. 2020 
(UHD/HDR), ARRI Wide Gamut, and ACES AP-1, which means visual data is not compressed 
or lost, no matter where it originates from.

DaVinci WG’s primary color values are set up to produce extremely accurate results, even 
when remapping color spaces from multiple camera sources. This results in perceptually 
consistent grading behavior among the color page’s palettes. In the Project Settings, the 
DaVinci WG is accompanied by the Intermediate gamma, which provides suitable internal 
luminance mapping of high precision image data for mastering in both HDR or SDR 
standards. 

Due to its large color space, DaVinci WG is ideal for master projects that can be graded 
and then remapped to generate a variety of deliverables for broadcast, projection, and 
online streaming.
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7	 Set the Input color space to Blackmagic Design 4.6K Film Gen 1. This was the camera 
and standard used to capture the footage.

The Timeline color space determines the behavior of the color page grading tools. 
When set to DaVinci WG, grading can be performed with greater color amplitude than 
other color space standards.

The Timeline working luminance will determine how high dynamic range images will be 
treated when mapped to the DaVinci’s Intermediate gamma standard. The custom 
setting, HDR 4000, will remap the signals of wide dynamic range images to be 
viewable on an SDR monitor while gently rolling off highlights to prevent clipping or 
bunching at the top of the waveform.

The Output color space can remain Rec.709 Gamma 2.4, which is ideal for computer 
monitors in a controlled lighting environment. 

8	 Click Save to exit the Project Settings.

The clips appear unchanged because their individual input color spaces are set to 
Rec.709 Gamma 2.4. Video media always adopts the timeline color space of a project 
upon the moment of import. You must change the input color space to reflect the 
active project settings.

9	 Press Command-A (macOS) or Ctrl-A (Windows) to select all clips.

10	 Right-click any clip and choose Input Color Space > Project - Blackmagic Design 4.6K 
Film Gen 1 at the top of the contextual menu. Setting the input color space to Project 
ensures that any future changes to the Input color space in the Project Settings 
immediately affects the clips on the timeline.

The appearance of the clips in the timeline is changed dramatically. Colors appear 
naturally saturated and contrast is raised.
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11	 Select clip 01 on the Project 03 – The Long Work Day timeline.

Gamma has been raised (0.15) for better visibility of frame.

The clip appears much darker, noisier, and more saturated than the rest of the footage 
because this clip was captured on a different camera than the rest of the media. The 
project-wide color management utilizes an input color space that does not correspond 
to this clip’s source gamut, so its colors are incorrectly remapped and distorted.

12	 Right-click clip 01, and choose Input Color space > Blackmagic Design 4K Film Gen 1.

Gamma has been raised (0.15) for better visibility of frame.
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Doing so corrects the remapping operation to use the input color space of the camera 
used to capture this clip. Though the image still appears very dark, the saturation is no 
longer distorted due to improper remapping. In situations when you are uncertain of a 
clip’s origin, it is best to set the Input Color Space to Bypass.

Creating a Group
When incorporating groups to a grading workflow, your first task is to choose a grouping 
strategy for your timeline. Depending on the project, you can base groups on locations, 
scenes, color temperature, shot size, or any criteria of your choice.

In the commercial project in this lesson, you will create groups to differentiate between 
scenes based on their locations and times of day.

1	 Click clip 06 and Shift-click clip 13 to select the eight consecutive garage clips in 
the timeline.

2	 Right-click any of the highlighted clips and choose Add into Current Group.

A green link symbol appears in the lower-right corner of the clips to indicate their 
group relationship.

3	 Right-click any of the grouped clips and choose Groups > Group 1 > Rename.

4	 Enter the group name Garage. These clips will now be linked when you start utilizing 
the group-level Node Editor in later exercises.

Upon closer inspection, it appears that clip 13, the highway shot, does not belong in 
this scene and should not be included in this group.

5	 Right-click clip 13, and choose Remove from Group. 

You can also use groups for filtering purposes.

6	 In the timeline, Command-click (macOS) or Ctrl-click (Windows) clips 02 and 13.
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7	 Right-click one of them, and choose Add into a New Group.

8	 Enter the group name Highway.

The link symbols on the Garage group disappear and are now visible only in the 
Highway group. From now on, the green link symbols will appear only when a grouped 
clip is selected.

The two Highway clips are relatively far apart on the timeline, so matching them could 
be tedious if you have to constantly navigate up and down the timeline to 
compare them.

9	 Choose Clips > Grouped > Highway.

The two highway clips are now located side by side, and you can quickly assess and 
match them by pressing the Up and Down Arrow keys.

10	 Select Clips > All Clips to remove the timeline filter.

You’ll need to create one more group to prepare for the exercises in this lesson.

11	 Scroll down the timeline, select clips 19 to 26, and add them to a new group 
called Home.
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Adopting Groups in a Classic Color Grading Workflow
With your clips sorted into groups, you can now choose the modes in which their grading 
will be targeted—from individual adjustments to group-wide uniform changes. Doing so will 
enable a much faster and more precise workflow in which you’ll no longer need to 
duplicate and reapply grades to individual clips. By reducing this duplication of effort, you’ll 
also have less chance that mistakes will creep into your workflow. Instead of readjusting 
specific nodes on multiple clips or keeping track of dozens of stills, you may tweak a group 
grade to amend all a scene’s clips at once.

The following figure shows how the classic color grading workflow, previously expressed 
as a node tree structure in Lesson 1, can be translated into group-based node structures.

The following is a list of available grading modes in the Node editor and their relationships 
to the traditional grading workflow:

	� Group pre-clip permits you to apply preparatory grading adjustments such as 
gamut mapping, color chart auto-correction, or color space transform (the OpenFX 
equivalent of using color management in the Project Settings). At this stage, you can 
also normalize footage with common luminance ranges and address obvious tint or 
temperature issues in the dailies.

	� Clip mode enables you to address the individual needs of each clip in a group, 
including normalization, balancing, matching, and secondary grade adjustments.

	� Group post-clip is best utilized for creative scene grading. By this stage, your clips 
should be matched, and their individual secondary requirements met. Matching these 
clips ensures that the creative grade is uniformly applied and requires only minimal 
tweaking on a clip-by-clip level.
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	� Timeline will affect every clip on the active timeline of your project. Color correction 
and creative grading is not recommended at this stage, but you could use this mode 
to implement artificial grain and film effects, apply vignettes to short-form projects, or 
remap the color space of the timeline via Color Space Transform FX.

This breakdown suggests the order in which to address and process visual data, but you 
should not see it as a strict order of grading operations. As with any standard grading 
workflow, it’s entirely acceptable (and expected) to jump between group levels to make 
adjustments throughout the grading process. Note that the output of earlier modes is the 
direct input of later modes (that is, the pre-clip output leads to the clip input). It is therefore 
helpful to think of the group modes as being one long pipeline.

Applying Base Grades at the 
Pre-Clip Group Level
In the pre-clip group level, you can make adjustments that will affect the individual clip-
level RGB input video signals of all the clips in the group. 

It’s important to keep in mind that all the clips in a group are affected by these changes, so 
you must avoid focusing too strongly on achieving a perfectly neutral appearance in any 
single shot. Instead, pick a key shot that is representative of most of the footage in the 
group and apply the necessary grades, LUTs, or ResolveFX to establish a good starting 
point for matching at the next grading stage.

Using a Color Chart to Balance a Group
One method for normalizing the tonal range and balance in a sequence of clips is to use 
the calibration charts that were captured at the start of the scene shoot. Calibration charts 
allow for automated balancing that gives you a much more accurate output than regular 
auto-balancing due to their reliable luminance ranges and meticulously designed 
color swatches.

1	 Change the Clips timeline filter to display only the clips in the Home group.

These clips feature a color checker clip that you can use to quickly calibrate the 
group’s color space and gamma. A shot of the color checker is usually captured at the 
start of every new scene, light change, or location during filming to facilitate the quick 
normalization of clips in that sequence.
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2	 In the pop-up menu at the top of the Node Editor, switch to Group Pre-Clip mode. All 
the adjustments you are about to make will be applied to the whole group.

3	 In the Home group timeline, click clip 01.

4	 Label node 01 as Color Match.

5	 In the left palettes of the color page, open the Color Match palette.

6	 In the pop-up menu in the lower-left of the viewer, choose the Color Chart tool.
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7	 Drag the corners of the color chart interface to the corners of the color checker chart 
in the image. Ensure that the small squares in the middle of the color chart outline are 
filled with the colors they are meant to be analyzing. Any interference with the black 
chart borders or the man’s fingers will affect the quality of this analysis.

8	 At the top of the Color Match palette, verify that X-Rite ColorChecker Classic - 
Legacy is chosen. This selection is based on the version and type of color checker 
chart in use.

9	 Set the Source Gamma to Blackmagic Design 4.6K Film.

Source Gamma must be set to the encoded gamma (or EOTF) of the original image, 
regardless of whether color management is enabled. This allows the Color Match 
palette to internally compensate for the tonal encoding of the image and accurately 
calibrate the image color values.

10	 Set the Target Gamma to Blackmagic Design 4.6K Film. 

It may feel counterintuitive to use the same setting for both source and target, but it 
makes sense when you consider that the color match palette is not currently being 
used for the purpose of remapping between two gamma standards. In this case, you 
are only interested in calibrating the colors based on the source lighting.

11	 Set the Target Color Space to DaVinci Wide Gamut to map the result to the Timeline 
color space.

12	 At the bottom of the Color Match palette, click Match. You will see a slight shift in color, 
most notably in the skin of the man, as the clip is balanced according to the chart.

The rest of the clips in the Home group have now adopted the automated color balance. 

You’ve created a better starting point for all the clips in the scene while retaining the 
full gamma range and color quality to perform individual balancing, matching, and 
creative grading down the line.
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TIP When working on a project that utilizes conversion LUTs, the pre-clip group 
level is the stage at which the LUTs are applied.

Making Clip-Specific Adjustments 
at the Clip Group Level
By default, the standard Node Editor applies grade changes on a clip-by-clip basis. It’s the 
ideal way to match footage and make secondary amendments. When working with groups, 
you continue to have access to the Node Editor in Clip mode.

Matching Shots at the Clip Group Level
Before you can apply a creative grade to a group of clips, it’s important to ensure that all 
those clips match in terms of tint, temperature, and luminance level distribution.

1	 Filter the timeline to show only the Garage group clips.

2	 Switch the Node Editor to Clip mode.

3	 Select clip 01. At first glance, the shot appears to be substantially brighter than the 
other clips in the scene.
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4	 Drag the viewer playhead to the end of clip 1.

After the man enters the garage, the shot appears to be exposed similarly to others in 
the sequence and will not require aggressive matching.

5	 By default, thumbnail images in the timeline represent the first frame of a clip. Drag 
within the thumbnail of a clip to change the frame represented in the thumbnail.

When comparing and balancing clips, remember that the first frame is not always the 
most reliable choice for matching, and you should always play through the entire clip 
before making a grading decision. In this case, you can leave clip 01 as it is.

6	 Select clip 04. This shot is definitely darker than the rest of the sequence.

7	 Right-click clip 05 and choose Wipe Timeline Clip to enable the Wipe mode in 
the viewer.
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8	 Open the Sizing palette in Reference Sizing mode, and pan and zoom clip 05 to more 
clearly see the man in the wide shot.

9	 Press Option-F (macOS) or Alt-F (Windows) to expand the viewer and get a better view 
of the differences between the clips.

10	 Open the waveform scope (in RGB mode with Colorize enabled) to view a graphic 
representation of the chrominance differences between the clips. Just as in the viewer, 
the waveform is split along the wipe line.

11	 Label node 01 in clip 04 as Match.

12	 Drag the Gain master wheel right to brighten the highlights of the image. Aim to match 
the waveform highlight spikes that represent the light sources reflected on the garage 
floor of the reference image.

13	 Drag the Lift master wheel right slightly to brighten the shadows. Keep an eye on the 
man’s suit to ensure a good match in the viewer and waveforms.

14	 Finally, drag the Gamma master wheel right to match the overall waveform distribution 
in lower midtones. Use the green channel of the RGB waveform as a match reference.

While the tonal distribution of the image now looks accurate, there is now a strong 
green cast throughout the image. This color imbalance can be addressed more 
accurately using the Color Bars.

15	 Switch the Primaries palette mode to Bars.

16	 Drag down the green Lift bar to neutralize the suit and garage shadows.
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17	 Drag the red Gamma bar down to address the resulting red tint.

The Waveforms Don’t Match. Are the Clips Really Color Matched?
When matching clips using waveforms, your goal is not always to make the waveforms look 
identical. Rather, it is to use the reference waveform as a guide to inform the overall spread 
of the luminance data, the heights of the brightest parts of the image, and the depths of 
the shadows.

In this example, clip 04 will always have a waveform concentrated at the bottom of the graph 
because it features a mid-close-up of the man and his dark suit.

In clip 05, the suit occupies a very small part of the shot and appears in the waveform as a 
small dip to the shadows—the depths of which are now matched. Likewise, the lights in both 
waveforms follow a similar trajectory.

Lastly, the overall waveform in clip 04 is spread out to a similar distance to clip 05. Bypass 
the grade in clip 04 to compare how compressed the waveform used to look.



202 203Making Clip-Specific Adjustments at the Clip Group Level

18	 Press Option-F (macOS) or Alt-F (Windows) to exit the Enhanced viewer mode but 
leave the Wipe mode on.

19	 Reset the Reference Sizing mode of the Sizing palette and drag the wipe line to the 
center of the viewer.

20	 Click clip 07.

The clip colors are already a good match for the rest of the timeline, but the shot is 
too bright overall, which will affect the quality of the post-clip grade.

21	 Label node 01 as Match.

22	 Drag the Offset master wheel left to darken the shadows to the same level as the 
reference clip. A good reference to watch as you adjust the image luminance is the 
garage ceiling, which should match in all shots.

Intermediary Matching Between Clips
At times, you will want to grade shots to show a gradual change in color or temperature 
between clips. Doing so is not strictly a color match, but rather an intermediary grade 
designed to transition between clips with different looks without jarring a viewer’s 
perception of the scene.

In this exercise, two clips captured at sunrise are intercut with media captured later in the 
day. You will match the daylight clip between them, and then grade the preceding clip to 
suggest a natural change in sunlight from the first half of the timeline to the second.

1	 Filter the timeline to show only the Home group clips.

2	 Command-click (macOS) or Ctrl-click (Windows) clips 04 to 07 to select them.

3	 In the viewer, enable Split Screen mode.

4	 In the pop-up menu in the upper right of the viewer, choose Selected Clips.
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5	 Press Option-F (macOS) or Alt-F (Windows) to expand the viewer.

6	 In the split screen viewer, ensure that clip 06 (lower-left) is selected.

7	 Open the Node Editor and label node 01 as Match.

8	 Drag the Gain wheel toward yellow until the color of the sky matches the skies in the 
surrounding clips.

9	 Reduce the contrast in the adjustment controls until the window frames and furniture 
shadows have the same low contrast as the surrounding sunrise clips.

10	 Copy the Match node grade of clip 06 into the first node of clip 04.

To ensure a smooth transition between clips 03 and 05, you’ll want to reduce the 
severity of the grade in clip 04.

11	 Open the Key palette and change the Key Output Gain to 0.600. The grade intensity is 
halved, and the original colors of the image now show through for a smooth transition 
between the first and second halves of the scene.

12	 Press Option-F (macOS) or Alt-F (Windows) to exit the Enhanced viewer mode.

13	 Exit the split screen viewer.
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Automatically Tracking People 
and Features
The Magic Mask is a DaVinci Neural Engine-powered selection tool that can identify and 
track human figures or specific physical features based on user-applied strokes in the 
viewer. Additional track, stroke, and matte finesse controls allow for the refinement of 
selections to achieve an optimal result. As with previous secondary grading tools, the 
resulting masks can then be graded using the standard primary palettes.

NOTE The following exercises require DaVinci Resolve Studio to complete.

Tracking a Person
The default Person mode allows you to identify the full figure of a person with one 
establishing stroke in the viewer. The Magic Mask will identify a body in the frame and 
provide you with a preliminary selection overlay that you can refine before tracking their 
movement throughout the shot. In this exercise, you will track a person with the intention 
of grading the scene around them.

1	 Turn off the timeline filter to show all clips.

2	 Select clip 25.

3	 Label node 01 as Track.

4	 Open the Magic Mask palette, which is located in the central palettes.
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The Magic Mask palette is made up of three areas:

	– Toolbar features the selection mode, tracking controls, stroke tools, and mask overlay.
	– Stroke List catalogs the strokes you draw and displays their individual timeline tracks.
	– Adjustment Controls and Matte Finesse in the sidebar are used to refine the 
resulting mask. Most of the matte finesse controls operate similarly to those in 
the qualifier palette.

5	 In the viewer, click and drag to create a short stroke on the back of the man’s head. 
Short strokes are better, as they are less likely to drift off when tracking.

A new Person category and stroke item appear in the Stroke List of the Magic 
Mask palette.

6	 Click Toggle Mask Overlay in the Magic Mask palette.

The initial mask analysis will appear in the viewer. 
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NOTE If the stroke is not visible in the viewer, ensure that the Magic Mask 
palette is active and the onscreen controls in the lower-left corner of the 
viewer are set to qualifier.

7	 In the Magic Mask toolbar, click Track All Frames Forwards.

A successful track is indicated by a blue line in the Stroke 1 timeline. 

8	 The top of the Magic Mask sidebar features a Quality parameter that determines the 
accuracy of the mask analysis. In cases where a garbage matte or rough approximation 
will do, Faster will provide a quick result at the expense of quality. In cases where 
precision is crucial, Better is the preferred option, but comes at the expense of 
processing time and computational power. 

Click Better and drag the timeline playhead to review the improved result. If your 
workstation struggles to play back the clip, change the setting back to Faster. 

9	 Another adjustment control unique to the Magic Mask is Smart Refine. This tool allows 
you to expand or contract the mask based on the internal image analysis. This means 
Smart Refine will prioritize preservation of areas that it is certain are part of a person, 
while discarding mask artifacts and areas in which it has less confidence.

Drag Smart Refine until you are satisfied with the mask selection in the viewer.

10	 The Mode drop-down menu allows to change how the mask is modified by the Radius 
parameter beneath. To uniformly contract the mask, leave the Mode set to Shrink and 
drag the Radius parameter to eliminate any remaining selection around the man.  

11	 In the matte finesse controls, drag the Blur Radius (20.0) to soften the edge 
of the mask.
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To grade the scene around the man, you will first need to invert the selection.

12	 Click Invert Mask on the right side of the Magic Mask toolbar.

13	 Click Toggle Mask Overlay again to remove the red highlight from the viewer.

14	 To remove the blue stroke from the viewer, click the onscreen controls pop-up menu in 
the lower left of the viewer panel and choose Off.

TIP A quick method to remove the Magic Mask onscreen overlays is to open 
a different tool in the central palettes, such as the Custom Curves or 
Color Warper.

With the selection complete and the overlays hidden, you can resume the 
grading process.

15	 In the Primaries palette, increase the Midtone Detail (80.00) to sharpen the details on 
the beach and enhance the ripples in the water.

16	 Use the Offset master wheel to brighten the background, and drag the Offset wheel 
toward orange to emphasize the warm sunrise.

17	 Use the Contrast and Pivot to create a dynamic look with emphasized shadows 
and highlights.

Before After

As you can see, the Magic Mask is incredibly intelligent when it comes to reading the 
motion of the human body. In this case, the Magic Mask was able to recognize a man as he 
walked into the shot, revealing his legs and arm. In clips with multiple people, you can use 
additional strokes to mask and track each person.
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NOTE Although the Magic Mask produces incredibly satisfying results, it’s 
important to note that it is ultimately a color grading tool, not a compositing tool. 
The intention behind the Magic Mask is to provide a secondary grading selection 
far quicker than manual tracing and with far more accuracy than the default Power 
Window shapes. Its results are designed to produce optimal results when used 
with the primary grading palettes on the color page.

Masking Physical Features
The Magic Mask’s Features mode allows you to mask individual physical properties like 
faces, limbs, and articles of clothing. Like the Person mode, it exhibits a great deal of 
intuition and has been tested on a wide variety of video samples ranging from top hats 
and skirts to sandals and suits of armor. In the following exercises, you will track specific 
features, while also correcting strokes that have drifted from their reference point.

1	 Select clip 06.

2	 Label node 01 as Face.

3	 Open the Magic Mask palette.

4	 Play clip 06 to review it. 

Due to the dark environment and changing lighting in the garage, the man’s face is 
underlit. You will use the Magic Mask to track and brighten his face.
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5	 Drag the viewer playhead to the last frame of the clip. Tracking from a forward face 
angle will produce a more accurate result than the profile at the start of the clip.

6	 Change the Magic Mask palette mode to Features.

7	 In the features pop-up menu, select Face.

8	 In the viewer, drag a stroke over the man’s left eye.

9	 Click Toggle Mask Overlay to review the Face selection.

The selection has successfully captured his face, ear, and hairline. The Face feature 
only classifies the area above the chin as the face. To capture his neck, you’ll need to 
introduce a second mask. 

10	 In the features pop-up menu, select Torso (Exposed Skin).



210 211Automatically Tracking People and Features

11	 In the viewer, drag a stoke in the middle of his neck.

With the feature selections successful, you can proceed with the track.

12	 In the Magic Mask toolbar, click Track All Frames Backwards.

As the track runs, the man turns his head, and the left eye stroke drifts away. This can 
sometimes occur when you track a person in motion and the reference point changes 
or becomes obscured. You will need to fix this corrupted track.
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13	 Starting from the last frame (the starting point of the track), drag the playhead 
backward until you find the last usable frame of the track. This will be the frame just 
before he turns his head, and the stroke gets lost.

14	 In the viewer, select the eye stroke with your mouse and reposition it to his right eye.

15	 In the Magic Mask toolbar, click Track All Frames Backwards. This action will continue 
the track from the new stroke position and overwrite the bad track data.

16	 Drag the playhead to review the completed mask overlay track. Notice that when 
the stroke position was changed, it is seen in the viewer as a static change from one 
keyframe to the next.

17	 Use the Magic Mask sidebar to fine-tune the overlay, and drag the Blur Radius (30.0) 
to soften the edge of the mask.

18	 Click Toggle Mask Overlay and hide the onscreen controls.

19	 To brighten the man’s face, drag the Gamma master wheel (0.02) to the left.

The Magic Mask strokes are designed to be dragged within the viewer to optimize their 
tracking position. Each stroke change is treated as a static keyframe, meaning there is no 
dynamic animation or distortion from one stroke position to the next. Strokes can be 
moved as many times as needed to provide the Magic Mask with optimal tracking data, 
including moving (and analyzing) the strokes one frame at a time.
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Fixing Difficult Tracks
Despite its accuracy and intuition, the Magic Mask is actually designed for working with 
difficult-to-track data. It is possible to isolate specific stokes when tracking, track one frame 
at a time, and introduce subtractive stokes to eliminate unwanted areas from the final mask. 
This exercise will require you to use a combination of these techniques to produce a 
clean result.

1	 Select clip 09.

2	 Create a new node and label it Masks.

3	 Open the Magic Mask palette.

4	 Drag the playhead to the center of the clip for an optimal starting point for the track.

5	 Change the Magic Mask palette mode to Features.

6	 In the features pop-up menu, select Hair.

7	 In the viewer, drag a stroke horizontally across the man’s hair.

8	 Click Toggle Mask Overlay to review the selection.

9	 In the features pop-up menu, select Clothing (Top).

10	 Drag a short stroke that includes both the man’s suit and shirt for a more 
accurate analysis.

11	 In the Magic Mask toolbar, click Track All Frames Forwards.

12	 Should the hair or suit masks start to fail, move the playhead back a few frames, 
reposition the strokes in the viewer, and rerun the track analysis.
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13	 If the stroke disappears from one frame to the next, select the appropriate feature from 
the pop-up menu and click in the viewer to add another stroke. Each new stroke will 
appear in the Stroke List of the Magic Mask palette.

Once the second half of the clip is successfully analyzed, you’ll need to return to the 
starting point of the track and analyze backward.

14	 Use the button on the far left of the analysis controls to jump to the first frame of the 
tracked area.

15	 Click Track All Frames Backwards.

16	 Once again, move the strokes and rerun the analysis until you get a clean result.

It’s possible that you will see some artifacting in the mask next to the man’s neck. 
This can be resolved using subtractive strokes.

17	 Drag the playhead forward until you see the first frame with a distorted mask selection.
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18	 Ensure the features pop-up menu is set to Clothing (Top).

19	 In the toolbar, select the subtractive stroke tool.

20	 In the viewer, draw a stroke on the mask overlay that is spilling outside the man. 
Subtractive strokes appear red in the viewer.

TIP To delete a stroke, right-click the stroke in the Magic Mask palette stroke 
list and choose Delete Stroke. 

You’ll want to track this new stroke separately to avoid overwriting the successful track 
data on the other strokes.

21	 Click the Magic Mask options in the upper-right corner and choose Track Selected 
Track Only.

22	 Select the red Stroke 2 in the Stroke List. 

23	 Click Track One Frame Backwards.

Continue to track one frame at a time, moving the subtractive stroke over the mask spill 
until you get a clean selection of the man’s hair and clothing.
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24	 Use the Magic Mask sidebar to fine-tune the mask outline and drag the Blur Radius 
(20.0) to soften the edge of the mask.

25	 Click Toggle Mask Overlay and hide the onscreen controls.

26	 Slightly darken the shadows with the Lift master wheel (-0.00) and gently raise the blue 
Lift bar to match the color of the suit to the one in the preceding clip.

TIP Another unique parameter to the Magic Mask’s sidebar is the Consistency 
parameter, which is designed to reduce mask jitter. Jitter is most likely to occur in 
masks that feature rapid movement or a high volume of edge detail, such as loose 
clothes blowing in the wind or curly hair. Increase Consistency to analyze the 
surrounding frames of a mask and produce a more static average of the selection 
on any given frame.

Masking the motion of a person manually can take hours or days. Traditionally, this involves 
breaking up the human figure into a dozen dedicated windows and then animating them to 
match the person’s movement. The Magic Mask produces accurate travelling mattes 
instantly, allowing you to focus more of your time on the color grading process.

Creating a Unifying Look 
Using the Post-Clip Group Level
When you achieve color consistency and address the individual secondary needs of the 
clips within your groups, you’re ready to move on to the final post-clip group level in which 
you will design and apply creative grades on a scene-by-scene basis. At this stage, other 
members of the creative process, such as the director and director of photography (DOP), 
usually get involved to discuss the aesthetic needs of the film. 
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Applying a Post-Clip Grade with an External Reference
In this exercise, you will work with a reference image that a client has shared with you. 
You will import it into the gallery and treat it as a still for visual comparison.

1	 Filter the timeline to show only the Garage group clips.

2	 Switch the Node Editor to Group Post-Clip mode.

3	 Click clip 07. This is the key shot you will use to grade the rest of the group.

4	 To import an external reference image, right-click in the Gallery and choose Import.

5	 In your file browser, navigate to the BMD 17 CC - Project 03 folder and open the 
References subfolder.

If you do not see any images in the folder, ensure that your browser window is 
specified to identify all files as opposed to just the default .dpx format files.

6	 Select the FK_Bridge_Reference.png image and click Import.

7	 Double-click the still to wipe it in the viewer.
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Clients often use visual references from photographs, art, or even existing films/TV 
shows to communicate their desired looks for a project. In this case, the highly stylized 
reference image points toward a high contrast, saturated scene with neutral shadows 
and cool midtones.

First, let’s match the contrast and cold look of the reference shot.

8	 Label node 01 as Dark Blue.

9	 In the Custom curves palette, drag the master curve black point across the bottom of 
the graph until the shadow under the car is almost pitch black.

10	 Shape the master curve into a gentle S-curve to add contrast to the midtones, while 
bringing some intensity into the lights within the image.

11	 Drag the Gamma wheel toward blue to create a strong, cool tone.

You can address the over-saturated blue headlight reflections on the floor in the Lum 
vs Sat curve of the curves editor.

12	 Click the white swatch under the curve grid to generate an anchor next to the 
rightmost point of the saturation graph. The area between the two points represents 
the most saturated parts of the frame. 

13	 Drag down the rightmost point until the reflections are not overly saturated. You’ll 
notice that the area immediately around the reflections is not affected as strongly.

14	 Drag the white swatch anchor point left to expand the region you are targeting. If 
necessary, click the right side of the curve to create a new adjustment point and drag 
it down until the edges of the reflection are no longer saturated. Keep an eye on 
the other colors in the image to ensure that you are not desaturating any prominent 
elements such as the columns or the hood of the car.
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The overall temperature and tonal range of the scene is complete. You can now place a 
second node to enhance the garage’s red columns and pipes.

It’s not common to create secondary grades in post-clip group node graphs, but when 
the scenes have a consistent color scheme, it can work.

You will get a better secondary grade result if you use the original RGB signal of the 
clip instead of the RGB signal coming out of the heavily-graded and contrasted Dark 
Blue node.
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15	 Create a new Parallel Mixer node, and label it Red Pipes.

16	 In the HSL curves, open the Hue vs Sat HSL curve.

17	 Click the red swatch at the bottom of the palette and increase the Sat by 50%. Doing 
so enhances the reds in the image but also makes them a little distracting due to their 
unnatural brightness.

18	 In the Hue vs Lum HSL curve, click the red swatch and reduce the Lum by 50%. This 
darkens the red colors and matches them more closely to their environment.

TIP To bypass the entire node tree within a specific level grade, press 
Option-D (macOS) or Alt-D (Windows). Doing so will leave your other node 
levels intact so you can assess the changes you have made within the 
current clip level.
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Adjusting Clips After a Post-Clip Grade
Occasionally, a post-clip grade will emphasize or reveal inconsistencies in the clips, which 
will result in mismatched grades. In such cases, you’ll need to return to Clip mode in the 
Node Editor to make further adjustments.

In this exercise, you will return to the Clip mode to apply an effect to the key shot and then 
fix a discrepancy that was revealed in one of the shots on the timeline.

1	 With clip 07 still selected, return the Node Editor to Clip mode. You will apply an effect 
to the final clip to make the headlights more dramatic.

2	 Create a second node and label it Headlights.

3	 Open the Open FX panel.

4	 Find the ResolveFX Light category and drag the Aperture Diffraction effect onto the 
Headlights node.

The result is an optical effect that mimics the diffraction of light. The settings in the 
OpenFX panel allow you to refine the pattern, intensity, and color of the effect.

5	 Under Aperture Controls, change the Iris Shape to Square.

TIP In the Output category of the Aperture Diffraction settings, change Select 
Output to Diffraction Patterns Alone to get a clearer view of the light patterns 
as you adjust the settings. Change the output back to Final Composite to see 
the final result.

6	 Under Compositing Controls, increase the Brightness to 0.600.

7	 Increase the Colorize value to 0.200 and use the swatch underneath to change the 
color to magenta.



222Creating a Unifying Look Using the Post-Clip Group Level

8	 To reduce the effect intensity, expand the Global Blend parameter at the bottom of the 
settings and set Blend to 0.700.

This simple effect dramatizes the final shot of the sequence as the car drives away. 
A variety of light-based effects in the Open FX panel enable you to stylize your shots 
and make features “pop” in subtle or exaggerated ways.

Next, you will check the remainder of the garage sequence to ensure that all 
shots match.

9	 Navigate the timeline and check the other clips for consistency.

You can see that the upper midtones in clip 06 are substantially bluer when compared 
to the environments in clips 05 and 07. Clip 06 is also fairly dark, which is making it 
difficult to see the actor’s face.

10	 Click clip 06. 

11	 Right-click clip 07 and select Wipe Timeline Clip.
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12	 Change the Node Editor to Clip mode.

13	 Label node 01 as Match.

14	 Switch the Primaries palette to Log mode and drag the Shadow master wheel right to 
brighten the shadows of the image, revealing the man’s face more clearly.

15	 Drag the Shadow wheel control point toward orange.

The overall blue dominance of the shot is reduced, and the man’s face is more 
clearly visible.

16	 Disable Wipe mode in the viewer.

The convenience of the group grading workflow is that no single stage or node is 
permanent. It’s easy to jump between the different stages and tweak them as required, 
all while seeing the final output in the viewer.

Applying Timeline-Level 
Grades and Effects
The Timeline level is available in the Node Editor whether or not you use a groups 
workflow. As the name implies, adjustments made at this level affect every timeline clip 
uniformly. This functionality can sometimes be useful for image property applications such 
as custom blanking, color space transforming, gamut mapping, adding a vignette, or 
inserting film grain/analog video effects. It is not as strongly advised for grading purposes, 
but you can apply it to great effect in short video projects with consistent base colors.

In this exercise, you will apply an analog video look to your entire project, followed by the 
data burn-in details that will make it easier to keep track of timecodes and clip names 
during the feedback stage of postproduction.
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Apply an Analog Video Look to an Entire Timeline
Artificial film grain and analog video artifacts are occasionally added to digital media for a 
variety of reasons. In some cases, the film needs to look outdated as a component of the 
storyline (such as flashbacks, home movies, found footage, and so on). Film grain and 
damage can also add realism to shots with artificially imposed elements or CGI graphics by 
making them appear to have been captured on tape or a celluloid film camera. Finally, film 
grain and damage is also an aesthetic choice made by many filmmakers.

NOTE This exercise requires DaVinci Resolve Studio to complete.

1	 Turn off the timeline filter to show all clips.

2	 Switch the Node Editor to Timeline mode.

By default, the Node Editor appears without a node 01, which acts as a useful reminder 
that this stage of the grading workflow is optional and can cause significant 
repercussions in the appearance of the entire timeline.

3	 Press Option-S (macOS) or Alt-S (Windows) to create a new serial node that will already 
be connected to the RGB input and node tree outputs.

The blue outline around the node is another visual reminder that you are not in any of 
the standard grading node levels.

4	 Label node 01 as VHS.

5	 Open the OpenFX panel.

6	 Find the ResolveFX Texture category and drag the Analog Damage effect 
onto node 01.
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7	 Press Shift-F to expand the viewer and improve access to the Analog Damage 
panel settings.

The top of the panel features a preset pop-up menu with a collection of common 
analog looks—early B&W television, transmission technologies from the 70s/80s, VHS, 
and so on. Beneath, individual parameter controls enable you to adjust a wide variety 
of damage components such as vignetting, noise, scan lines, chromatic aberration, 
jitter, and screen curvature.

8	 Set the preset to Old VHS.

9	 To remove the visible frame on the left, open the Scan category. Adjust the 
H-Shift to 0.050.

10	 To remove the horizontal black lines running throughout the sequence as it plays, reset 
V-Hold to 0.000.

Before After

11	 Click Play to review the result. All the clips on the timeline are affected by the VHS 
look. Press Shift-F to exit the full-screen viewer.
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12	 Before moving onto the next exercise, bypass the VHS node. The Analog Damage 
effect is processor-intensive, so it’s a good idea to disable it until you are ready to 
export the project.

TIP The Film Grain FX in the ResolveFX Texture category can similarly be applied 
to achieve the look of celluloid film on digital footage. It comes with a variety of 
film stock presets (8mm, 16mm, 35mm) as well as a collection of grain parameters 
for optimal customization on a timeline or clip-by-clip basis.

Adding Data Burn-In to the Viewer and Final Video
Another common feature applied on a timeline basis is data burn-in, which overlays a 
timecode, clip data, or any number of designated text metadata over the viewer. It works 
independently from the Node Editor, and you can use it in-program for editorial purposes, 
as well as for the final delivery of the video.

1	 Choose Workspace > Data Burn-In.

The left side of the Data Burn-In window features a wide selection of data options 
that you can superimpose over the video. The right side of the interface changes 
depending on the option you select and allows you to adjust the placement of text, 
font, color, and so on.
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The Project and Clip buttons at the top of the Data Burn-In window allow you to apply 
the data on a timeline or clip basis. This choice can be useful when you’re trying to 
leave comments for specific clips—for example, when communicating with the audio 
or VFX department about the requirements of specific shots.

2	 Select Record Timecode to display the timeline’s timecode on the video.

3	 Select Source Clip Name to display the name of each clip as it plays in the video. 
Note that in this case, because all the clips are sourced from a single flattened video 
file, they will all have the same source clip name.

4	 Select Custom Text1, and in the Custom Output Text field, type  
PLEASE DO NOT DISTRIBUTE.

5	 In the Data Burn-In options, deselect Gang Render Text Styles. This will enable you to 
modify the individual appearances of the data burn-in fields.

In this case, you will use the Custom Text field to act as a form of distribution protection 
for your video.

6	 Remove the black box behind the text by reducing the Custom Text Background 
Opacity to 0.

7	 Change the Font to Open Sans.

8	 Increase the Text Size (140) to fill the viewer.

9	 Reduce the Text Opacity (0.20). 

10	 Reposition the text to the center of the viewer using the Position Y parameter.

TIP To apply a watermark over a video, use one of the Logo options in the 
Data Burn-In interface. You can import a custom image/logo file and adjust its 
opacity using the transform controls.

11	 Close the Data Burn-In window.



228Self-Guided Exercises

Data Burn-In options can be extremely useful for inserting quick and accurate 
communications between departments and clients. Instead of describing clips visually, 
exact clip source names can be used in feedback. Likewise, the precise timecodes ensure 
that your collaborators are not using the general timecodes of their video players (which 
usually lack frame data).

NOTE The Data Burn-In windows includes fields such as Reel Name, Shot, Take, 
and many others that display the information entered into those respective fields 
in the Metadata panel of the media page.

By combining the knowledge you gained in previous exercises with the group-driven 
workflow of this lesson, you can design extremely efficient project workflows that clearly 
divide and allocate the purposes of each group level and node.

Self-Guided Exercises
Complete the following self-guided exercises in the Project 03 - The Long Work Day 
timeline to get more practice with groups, primary and secondary grading, and creative 
grade construction. Note that these exercises are designed to allow you to practice group 
grading, not to produce a single cohesive color narrative.

Home Group
	� Create a post-clip group grade on the Home group. Import the GC_Island_

Reference png image from the BMD 17 CC - Project 03 > References subfolder into the 
Gallery as a reference. Aim to create a bright, warm look with a bit of contrast. Use HSL 
curves to emphasize the blue color of the sky and water outside the windows.

	� If necessary, adjust the Key Output gain on clips 04 and 06 to better match new 
group grade.

	� In clip 02, use the Magic Mask to track the man, while excluding his coat. Invert the 
mask selection and use Lum vs Sat to desaturate his surroundings. Use Smart Refine 
if edges of color remain visible around him.

Highway Group
	� Balance clip 02 by reducing the red in the shadows and then brighten the overall 

shot. Match clip 01 to clip 02, paying particular attention to the color of the road in 
both shots.

	� Add the Motion Trails OpenFX to clip 02 and increase the Trail Length to 8 to introduce 
motion blur to the footage.
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Office Group
	� Add clips 03–05 to a new group called Office.
	� Match the brightness of clip 03 to the other clips.
	� In clip 02, use the Magic Mask to track the man’s face and hands, and then use 

adjustment controls to add contrast and detail to the man’s skin.
	� Perform post-clip group grade on the Office group. Begin by normalizing the 

brightness in the room by spreading the waveform upward. Then create a Look node 
in which you add cyan to the lower midtones while maintaining neutral shadows. 
Return to Clip mode in the Node Editor to tweak any inconsistencies revealed in the 
group≈grade.

Morning Group
	� Add clips 16–18 to a new group called Morning.
	� Perform contrast and color matching on the clips the Morning group using clip 02 as 

the key shot. 
	� Perform a post-clip group grade in the Morning group. Use the Color Warper to gently 

tint the mountains red and turn the skies yellow. Return to Clip mode in the Node Editor 
to tweak any inconsistencies in the group grade.

When you’ve completed this exercise, open the Project 03 - The Long Work Day 
Commercial COMPLETED.drp and review the finished Lesson 7 Timeline COMPLETED to 
compare it with your work. If the media appears offline, click the red Relink Media button in 
the upper-left corner of the media pool and specify the location of the Project 03 media on 
your workstation.

Lesson Review
1	 True or False? A clip can belong to more than one group.

2	 Which group level is ideal for performing shot matching?

3	 True or False? Placing clips into groups allows you to bypass the normalizing/balancing 
stages of the grading workflow.

4	 Which Magic Mask feature can be used to mask a pair of gym shorts?

5	 How is Data Burn-In enabled?
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Answers
1	 False. A clip can have only one pre-clip and post-clip Node Editor mode. Adding a clip 

to a group will remove it from any previous group it was in. 

2	 Clip mode is ideal for performing shot matching.

3	 False. If the clips in a group do not match each other, their differences will continue to 
be evident when a group grade is applied.

4	 Clothing (Bottom).

5	 Choose Workspace > Data Burn-In.
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Lesson 8

Adjusting Image 
Properties

Though image colors tend to be 
a primary concern of the colorist, you 
can also make many transformative 
changes to footage to better 
accommodate the narrative 
and aesthetic output of a project. Such 
changes can include alterations to the 
scaling and positioning of the frame, 
noise reduction, and keyframing grades 
to change over time.

Applying such changes can impact the 
speed at which your computer is able to 
render and play the clips. For this 
reason, it’s helpful to leverage the 
multiple caching methods in Resolve to 
ensure the quickest render on a clip and 
node basis, using both automatic (smart) 
and manual (user) methods.
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Understanding Timeline Resolutions 
and Sizing Palette Modes
In the following set of exercises, you will address the variety of ways in which you can 
impact the frame of your project in DaVinci Resolve 17. Specifically, you will change the 
project resolution, reframe individual shots, and sample portions of an image at the 
node level.

Changing Timeline Resolutions
In this exercise, you will change the project resolution to evaluate how doing so impacts 
the image quality and secondary grades of the clips in your timeline. 

TIP To disable the group grades while working on this clip, enter the Group 
Post-Clip Node Editor and press Opt-D (macOS) or Alt-D (Windows)

1	 Select clip 05 on the Project 03 - The Long Work Day timeline.

2	 Create a new node called Vignette.

3	 In the Window palette, apply the Vignette preset. Reposition and resize it to focus on 
the man at the window.
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4	 Drag the Gamma master wheel left to darken the edges of the frame and then drag the 
control point toward blue/cyan to give the room a cool look.

5	 Open the Project Settings and enter the Master Settings tab.

6	 Change the Timeline resolution to 3840 x 2160 Ultra HD, which is a 1.77:1 aspect ratio 
4K resolution with the same aspect ratio as 1920 x 1080 HD.

TIP When rescaling media to a higher resolution (for example, converting 
720p content to a 1080p timeline or 1080p to a 4K timeline), you can activate 
a high-quality upscaling feature called Super Scale. To do so, right-click a 
low-resolution clip in the media pool, and choose Clip Attributes. In the Video 
tab, in the Super Scale pop-up menu, choose 2x (or higher) to double the 
resolution. Doing so will substantially improve the method by which the image 
is upscaled in higher-resolution projects, although it is a processor-intensive 
operation that may compromise real-time playback.
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7	 Click Save to exit the Project Settings.

8	 If the video appears zoomed in, press Shift-Z to fit the video frame to the viewer panel.

1920 x 1080 3840 x 2160

Compare the difference between the two resolutions. Note that the clip’s frame and 
positioning in the viewer has not changed. Additionally, the Power Window is rescaled 
to the new resolution while maintaining the placement in relation to the media clip. The 
only evidence of change is the new anchor handle length in the center of the 
Power Window.

This behavior is one of the most invaluable features of Resolve when grading and 
applying effects. The program is resolution independent, which allows you to change 
the frame size and aspect ratio of a project without affecting the positions of clips, 
images, secondary grades, effects, and generators created on the cut, edit, Fusion, 
or color pages.

9	 Delete the Vignette node.

4K to 1080p to 4K Workflow
Switching the timeline resolution is an effective method for optimizing workstation 
performance during editing. It ensures that clips are rendered and played in real time 
without lag and without altering the quality of the final film. A common workflow for 4K 
footage is to set the timeline to 2K or 1920 x 1080 during the editing process, and then reset 
it to 4K prior to rendering. 

Be aware that the grading potential, as well as the accuracy, of key- dependent secondary 
grading tools (such as the Qualifier) is reduced at a lower image resolution. Therefore, you 
are advised to change the timeline to the full media resolution before grading.
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Reframing Individual Clips
The Sizing palette becomes an increasingly versatile tool when you take advantage of 
its sizing modes. These modes allow you to switch the sizing focus from clips to entire 
timelines or to individual nodes. In this exercise, you will rescale and reposition clips on 
an individual and timeline basis.

1	 Enter the Project Settings and reset the Timeline resolution to 1920 x 1080 HD.

2	 Click clip 15.

3	 Label node 01 as Balance and use the Primaries palette to brighten the image and 
remove the blue tint from the highlights.

4	 Enter the Sizing palette and set the Zoom value to 1.500 to scale up the image.

5	 Click clip 12.

Notice that clip 12 was not affected by the reframing of clip 15. In fact, every clip in the 
timeline, with the exception of clip 15, has remained unchanged because clip 15 was 
changed at the clip level (Input Sizing) in the Sizing palette.

6	 Return to clip 15, and reset the Sizing palette.

7	 In the upper right of the Sizing palette, in the pop-up menu, choose Output Sizing.

8	 Set the Zoom value to 1.500 again.

9	 Click the other clips in the timeline to verify that they were altered by the 
change in scale.

Sometimes, rescaling makes sense on a timeline-wide basis, such as when 
appropriating media to a different resolution or aspect ratio. However, reframing tends 
to be much more specific as to the visual content of each shot.

Let’s reframe shots 12 and 15 based on content.
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10	 Change the Sizing palette mode to Input Sizing.

11	 In clip 15, change the Pan to 45.00, and the Tilt to 50.00.

12	 In clip 12, change the Pan to -70.00, and the Tilt to 150.00.

13	 Switch between the clips to verify that they retain their Output Sizing zoom but have 
adopted different pan and tilt values.

NOTE Output sizing is also commonly used to adapt footage with a different 
aspect ratio to a certain standard—for example 4K DCI will appear to have 
horizontal blanking in a 4K UHD timeline. Output sizing can be used to quickly 
fill the frame of the video.

These changes used two modes (Input and Output) of the Sizing palette. Previously, 
you rescaled and reframed a wiped still using the Reference Sizing mode.

The full list of sizing modes and their impact on the image is as follows:

	– Edit Sizing reflects the transform changes applied to a clip in the Inspector of the 
edit page.

	– Input Sizing reflects the sizing changes made to a clip in the color page. It targets 
clips on the same level as Edit Sizing but isolates the function to the color page.

	– Output Sizing applies to the entire timeline.
	– Node Sizing applies to the selected node in the Node Editor.
	– Reference Sizing applies to the reference movie or still that is visible in the viewer’s 
wipe mode.

TIP To apply blanking to your timeline, click Timeline > Output Blanking and 
choose an aspect ratio. This method preserves the original video resolution 
while permitting you to change the project aspect ratio.
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Custom Resolutions and Aspect Ratios
Under the Timeline resolution presets of the Project Settings, you may enter a custom 
resolution that will result in a non-standard video resolution at the aspect ratio of your 
choosing. Be aware that changing the aspect ratio or resolution to a non-industry standard 
value could mean that it may not be playable on some projectors or video players. When 
outputting to equipment that only recognizes standard video formats, it’s a safer option to 
use a common (preset) resolution and apply custom blanking to change the aspect ratio.

Sampling Visual Data with Node Sizing
The ability to change an image’s sizing data at the node level permits some interesting 
creative and practical application. You could clone an image to display multiple versions 
of it within the viewer or perform visual repair by sampling portions of the image for 
cover-up work.

In the following exercise, you will use node sizing to produce a creative layered look.

1	 Reset the Input and Output sizing data from the previous exercise.

2	 Click clip 15.

3	 Create a new serial node called Backplate.

4	 Press Option-L (macOS) or Alt-L (Windows) to create a Layer Mixer node.

5	 Rename the new node (node 04) that is connected to the Layer Mixer as Crop and 
select it.

6	 Open the Window palette.

7	 Activate a linear window and reposition the corners to capture the front half of the car.
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8	 Change all the Softness values to 0.00 to give the window a sharp edge.

9	 Open the Sizing palette and set it to Node Sizing mode. From now on, all changes to 
the Sizing palette will affect only the Crop node.

10	 Change the Zoom to 2.0 to scale up the linear window and its contents. 

The backplate remains unchanged.

11	 Pan the window (375.000) until you can no longer see the backplate to the right of 
the viewer.

12	 Tilt the window upward (300.000) to see more of the road in the scaled-up node.

13	 Select the Backplate node.

14	 In the Sizing palette, pan the image left (-300.000) to place the car in the left-half 
of the viewer.
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15	 Reselect the Crop node to begin grading the car close-up.

16	 Drag the Offset wheel toward blue to give the shot a cool metallic look.

17	 Drag the Lift wheel toward red to slightly offset the blue in the shadows.

18	 Drag the Gain master wheel right to brighten the highlights.

19	 Play the clip to display the two versions of the footage simultaneously.

In layer-based compositing systems, this effect would be possible only by creating a 
second video track, duplicating the clip over itself, and applying a crop tool. Due to its 
less efficient method of reusing video data, layer-based compositing tends to be more 
processor-intensive. Nodes provide a much cleaner approach to the duplication and 
resampling of RGB signals.

Creating Cover-Ups with Patch Replacer ResolveFX
You can also use node sizing for more practical compositing solutions, such as sampling a 
portion of the video to cover up an undesirable artifact. This type of painting or cover-up 
work is often used to fix continuity errors, conceal visible booms, and improve set design.

In this exercise, you will use the advanced Patch Replacer ResolveFX to quickly 
perform cover-up work and automatically adjust the grade of the sampled area to match 
the destination.

NOTE DaVinci Resolve Studio is required to complete the following exercise.
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1	 Click clip 05
This is a visually interesting shot with good set design and a great choice of location. 
However, one minor element is distracting from the luxurious office: the wall 
thermostat. Your aim is to remove the thermostat by covering it with a sample of a 
portion of the wall.

2	 Create a new serial node and label it Coverup.

3	 Open the Open FX panel.

4	 From the ResolveFX Revival category, drag the Patch Replacer effect onto the 
Coverup node.

Two oval outlines appear in the viewer. The left oval represents the source patch, 
which is actively sampling the portion of the video under it. The right oval with the four 
corners is the target patch that’s receiving visual data from the source and actively 
grading it to match its surroundings.

5	 Drag the target patch over the wall and resize it to outline the thermostat and 
its shadow.

6	 Drag the source patch over an empty area of the wall near the target.

7	 If necessary, zoom in on the viewer to refine the placements.
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TIP To navigate inside the viewer after zooming in, hold down your middle 
mouse button and drag in the viewer. If you do not have a middle mouse 
button, you can Shift-Option-drag (macOS) or Shift-Alt-drag (Windows) to 
move horizontally and vertically within the viewer.

The cover-up is successful, but only on the first frame of the clip. As soon as you play 
the video, the thermostat is revealed from behind the Coverup node. To complete the 
composite, you will need to track the effect to the camera movement.

8	 Press Shift-Z to fit the video frame to the viewer panel.

9	 Open the Tracker palette, and in the upper-right pop-up menu, change its mode to FX. 

To perform motion tracking, you will need to specify a tracking point. Ideally, you will 
want to identify the element you are covering up or a trackable area that is on the same 
plane as that element. In the case of this clip, the original thermostat is an ideal 
tracking point.

10	 Click the Coverup node name to bypass that node and reveal the thermostat under 
the patches.

11	 In the lower-left corner of the Tracker palette, click the Add Tracker Point button.

Blue crosshairs appear in the center of the frame. These crosshairs indicate the area 
of the image that will be analyzed for tracking.
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12	 Drag the crosshairs over the thermostat on the wall.

The crosshairs turn red when the default position is altered.

13	 In the Tracker palette, click the Track Forward button to perform the track analysis.

14	 After tracking is completed, click the Coverup node name to see the patches.

15	 If necessary, in the lower-left corner of the viewer, turn off the onscreen controls to 
hide the patch and tracking point outlines.

16	 Play the clip to check the accuracy of the cover-up. Make further adjustments to the 
size and placement of the source and target patches, if necessary.

The result is a clean cover-up of the wall that is ready for further editing and grading.
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TIP You can also perform this type of cover-up effect using node sizing. With a 
Backplate node in place, create a Layer node and use a Power Window to sample 
a clean portion of the video. In the Sizing palette, move the Layer node over the 
portion of the image you want to cover up. In the case of moving camera shots, 
begin the workflow by tracking the video with the standard window tracker before 
moving the Power Window over the sample area.

Node-based cover-ups are frequently employed to address the aesthetic needs of a scene 
or to resolve issues that were not noticed during the shoot (for example, removal of visible 
set equipment or covering spots on actors’ faces). These workflows tend to work best on 
footage with little movement and good sample areas.

TIP Another tool that you can use for cover-up work is the Object Removal effect 
(also in the ResolveFX Revival category). Whereas the Patch Replacer samples 
data from the current video frame, Object Removal uses the data from surrounding 
frames to cover up a moving object. To remove an object, first draw a Power 
Window around it and track it through the shot. Then, drag the Object Removal FX 
node onto that node. Click Scene Analysis in the OpenFX Settings and wait. If the 
object you’re removing is moving but the camera is locked, enable Assume No 
Motion. If enough visual data is available, the object will be successfully removed.

Using Keyframing
To understand keyframing, you need only to grasp the concept that you need just two 
keyframes to create any animation. And those keyframes need to communicate just two things 
to the program: their points in time and their values. By placing the keyframes at different 
points in the timeline, you indicate the length of time through which the change occurs, and 
by giving those keyframes individual values, you specify the nature of the change.

Animating Position Values with Dynamic Keyframes
Dynamic keyframes uniformly adjust parameter values across frames, which creates the 
effect of smooth change over time. In this exercise, you will animate the transform values 
and the color grade of a clip to imitate a camera move and sunrise effect.

1	 Select clip 01 on the Project 03 - The Long Work Day timeline.
This video was captured late in the evening and appears very dark. Before you can 
begin grading it creatively, you should expand its luminance range to take advantage 
of the colors and contrast.
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2	 Label node 01 as Normal.

3	 Drag the Gamma master wheel right (0.25) to increase the waveform spread, and then 
drag the Shadow master wheel right (0.20) to further brighten the dark foreground. 
Some noise issues are revealed in the low-light conditions. You will resolve these after 
the grade is completed.

The clip is a locked establishing shot. Even though it was captured in real-time, it has a 
time lapse feel to it. In the next few exercises, you will introduce animation to the shot 
to imitate the fast passage of time in the environment.

Your first goal is to create a pan-and-zoom movement starting from the wide shot and 
ending on the city skyline.

4	 To the right of the palettes in the color page, open the Keyframes Editor.

The palette currently includes animation controls in two categories: the individual 
controls of node 01 (Corrector 1) and the Sizing value of the overall clip.

5	 Create a new serial node and label it Sunrise. Corrector 2 appears in the list of the 
Keyframes sidebar.

Each new node you create will receive its own corrector header in the 
Keyframes Editor.
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6	 To prepare to animate the motion in the image, expand the Sizing category.

7	 Click the diamond-shaped keyframe symbol next to Input Sizing to activate animation 
in that parameter.

8	 While on the first frame of the clip, right-click the circular keyframe next to Input Sizing 
and choose Add Dynamic Keyframe.

The circular keyframe becomes diamond-shaped.

9	 Drag the playhead to the end of the clip duration in the Keyframes timeline.

10	 With the Sizing palette in Input Sizing mode, change the Zoom to 1.500, the Pan to 
-400.000, and the Tilt to -200.000.

Two new dynamic keyframes are automatically added to the Keyframes timeline—one 
for the Input Sizing parameter, and one for the general Sizing header in which it 
is contained. Additionally, two dimmed triangles indicate that a dynamic animation 
was generated.

11	 Play the clip to watch the animation in action. The shot begins with a wide view of the 
city and then quickly zooms in on the skyline in the distance.

TIP If you click the Loop button in the viewer playback controls, the playhead 
will play the same clip over and over instead of continuing to the next clip.
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Changing Color Values Over Time 
with Dynamic Keyframes
Next, to animate the color values of the clip, you’ll directly target the keyframe controls 
within the nodes.

1	 Drag the playhead to the first frame of clip 01.

TIP You can click the Expand button in the upper-right corner of the 
Keyframes Editor to increase the interface size. Doing so will move all other 
palettes to the left of the color page, thereby giving you more room to focus 
on keyframing.

2	 Select node 02 Sunrise.

To imitate the look of the sun rising, you will first need to create a pre-dawn look.

3	 Drag the Gamma master wheel to the left to darken the midtone ranges of the image, 
and then drag the Gamma color wheel toward blue to cool the temperature of the shot.

4	 Reduce saturation to 35.00 to imitate the limited perception of color in dark 
environments.

5	 In the Keyframes palette, expand Corrector 2.

6	 Click the keyframe symbol next to Color Corrector to activate keyframing.

7	 Right-click in the Keyframes timeline, and choose Add Dynamic Keyframe.

8	 Drag the playhead to the last frame of the clip.

9	 Return the Saturation to 50.0 to more accurately represent the colors in the scene.

10	 In the Primaries palette, click the reset arrow above the Gamma wheel to remove the 
dark, blue look.

11	 Increase the Contrast (1.300) to create a silhouette effect on the skyline.

12	 Drag the Gain color wheel toward yellow to warm up the image.
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13	 Increase the Highlights (50.00) in the adjustment controls to brighten the sunlight on 
the horizon.

TIP Press the [ (left bracket) and ] (right bracket) keys to navigate between 
keyframes in the Keyframes palette. This shortcut can save you time when 
comparing the different stages of an animation.

14	 Play the clip to see the colors animate over time.

A common reason for keyframing color grades is to address color temperature 
fluctuation. Shoots in which the camera operator frequently maneuvers from indoor 
to outdoor locations (documentaries, wedding videography, and so on) benefit greatly 
from these types of animated grade workflows.

TIP OpenFX can also be keyframed. When an effect is added directly to a 
pipeline, it will appear under its own name in the master list of the Keyframes 
palette. When an effect is dragged onto a corrector node, it will appear in the 
list under the appropriate corrector header.

Applying Dynamic Attributes
Though the animation in this example was successful, the zoom still appears a little artificial 
due to the linear nature of the animation. In this exercise, you will simulate a more realistic 
camera zoom by altering the animation speed and style using dynamic attributes.

1	 With clip 01 still selected, select and right-click the first keyframe in the Input Sizing 
parameter.

2	 Choose Change Dynamic Attributes.
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The dynamic attributes pop-up interface controls the behavior of the animation from 
the currently selected frame to the next frame.

3	 Set the Start Dissolve value to 2. The almost-horizontal shape of the line at the start 
indicates that change will be slow and gradual, before it accelerates and finishes in a 
linear fashion.

4	 Click OK to confirm the change.

5	 Play the clip and note the slow start to the animation. This move makes the simulated 
zooming effect more realistic.

Mastering keyframe animation can take some getting used to, but in time, and with 
consistent practice, generating keyframes and creating changes can become a common 
and frequently utilized part of your grading workflow.
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Using Static Keyframes
When creating a new keyframe in the editor, the alternative to dynamic keyframes is static 
keyframes. Static keyframes do not animate the change between values. Instead, they 
abruptly change the value when the playhead reaches that keyframe.

You can combine static and dynamic keyframes within a single animation, such as when a 
change needs to be gradual but then abruptly appear/disappear at the start or end of the 
animation—for example, with a lightbulb that lights up abruptly and then gradually increases 
in brightness and temperature.

Applying Noise Reduction
Resolve’s noise reduction feature runs on a powerful video engine that is able to 
distinguish noise from environmental data by performing a temporal analysis of the 
video frames. This feature enables a strong reduction of noise while preserving a high 
level of detail in the subjects of the image. Applying the additional spatial method of noise 
reduction further cleans up the image by analyzing and removing repeating noise patterns.

NOTE DaVinci Resolve Studio is required to complete the following exercise.

1	 Continue to work on clip 01 in the Project 03 - The Long Work Day timeline.

2	 Drag the playhead to the last frame of the clip to see the scene at its brightest.

Due to the low-light conditions in which this footage was captured, the brightening of 
the gain has revealed digital noise in the shadows and midtones.

3	 For a better view of the noise detail in the image, change the viewer Zoom to 200%.
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4	 Create a new serial node after Sunrise (node 03) and label it Denoise.

5	 Open the Motion Effects palette.

This palette is divided into three control areas:

	– Temporal NR analyzes the video across several frames to detect moving subjects 
and backgrounds. It excludes moving elements from the most aggressive noise 
reduction processing to prevent unwanted blurring of vital information.

	– Spatial NR softens high-frequency noise while retaining the data in levels of high 
detail. This tool is extremely effective for reducing fine-grain noise that Temporal 
NR missed.

	– Motion Blur is not a noise-reduction tool but uses the same analytical engine to 
produce its results. This tool helps make action shots more dynamic by allowing you 
to add motion blur to moving subjects.

6	 Under Temporal NR, you will first need to choose the number of frames that will be 
averaged to separate the detail from noise. For this shot, which features no camera 
movement or moving subjects, an analysis of 2 frames is sufficient.

The higher the number, the more accurate the analysis will be, but at the expense of 
extra processing time. However, a higher analysis rate could also produce artifacts in 
shots with overlapping moving subjects.

7	 The Mo. Est. Type (Motion Estimation Type) setting enables you to indicate the method 
used to detect motion in the image. A setting of Faster prioritizes speed of output over 
quality, whereas Better produces a finer result at the expense of extra processing time. 
When there is no movement in a shot, choose None to exclude motion analysis from 
the result and apply noise reduction to the entire image.

For clip 01, choose Better. This will prevent the ripples in the water from being too 
aggressively denoised and takes into account the Input Sizing animation.

8	 Motion Range allows you to indicate the speed at which the subjects are moving to 
exclude areas with motion blur from the noise reduction effect.
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Clip 01 has almost no motion, so Small is a good choice.

9	 The Temporal Threshold controls how aggressively noise reduction is applied to 
luma and chroma levels. By default, these options are linked, but if the image has 
monochromatic noise (or vice versa), it’s advisable to unlink the two parameters and 
target the luma/chroma noise directly.

This is the setting that will activate noise reduction in the image, so you can begin by 
entering any number and then dragging left or right to increase or decrease the effect.

Enter 15.0 as the starting Threshold.

10	 To see how much the Temporal NR is affecting the image, you can use the Highlight 
tool to assess the pixel difference.

In the viewer, enable Highlight mode.

11	 In the upper-right of the viewer, click the A/B icon to activate the Difference mode.

The patterns you see in the viewer show the amount of noise that was removed from 
the original image.

12	 When you start to recognize the outlines of objects in the noise pattern, it indicates 
that the noise reduction has become so aggressive that it is now removing legitimate 
visual information.

Drag the Threshold left (5.0) until only noise remains.

Good noise reduction Noise reduction too aggressive

13	 The Motion value acts as a pivot for the point at which moving objects are excluded 
from noise reduction based on the motion controls. A lower value excludes larger 
areas of the image, whereas higher numbers assume less motion and target more 
of the image.

Very little motion occurs in the image, so a high Motion value of 60.0 is appropriate.

14	 The Blend value allows you to blend the original image into the noise-reduced version. 
This adjustment can be helpful when the noise reduction is too aggressive and areas 
of the image take on a plastic appearance.

Leave Blend unchanged for this clip.
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15	 Disable the Highlight view, and toggle the Grade Bypass to compare the image before 
and after the Temporal NR.

The noise reduction is substantial. However, you still have room for improvement by 
reducing the more generic noise patterns in the image.

NOTE Temporal NR avoids aggressive noise reduction in moving elements by 
analyzing the content of a scene. For this reason, it is best applied to locked-
off shots. In a shot with a quick pan or handheld camera motion, every 
element will be moving, which would defeat the purpose of the Temporal 
NR analysis.

16	 Under Spatial NR, set the reduction mode to Better.

As with Motion Estimation Type, this setting is responsible for determining the speed/
quality of the final output; although, in this case, Faster, Better, and Enhanced refer to 
different analysis algorithms. 

17	 The Radius value indicates the area of the image that is analyzed to determine the 
noise type within the frame. 

To begin, set the Radius to Small. When reviewing the final result, switch between 
Radius sizes to check whether the Spatial NR is substantially improved. With many 
noise types, Small is sufficient.

18	 As with the Temporal NR, the Luma and Chroma Threshold settings determine the 
intensity of the Spatial NR.

Change the Luma and Chroma Threshold settings to 40.0 to see a further reduction in 
the remaining image noise. As you did previously, use the Highlight tool to ensure that 
the details in the image are not too strongly affected.

Before noise reduction After noise reduction
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19	 Press Command-D (macOS) or Ctrl-D (Windows) to bypass the Denoise node and 
compare the image before and after noise reduction. Pay particular attention to the 
preservation of the fine detail in the image—the Ferris wheel spokes and the windows 
in the buildings of the skyline.

TIP Noise Reduction is available in the OpenFX library under the ResolveFX 
Revival category and features all the same settings. You can use it to apply 
noise reduction to clips directly in the edit or cut page timelines.

Before moving on, it would be worthwhile to check whether changing the location of 
the Denoise node could improve the noise reduction.

20	 Select the Denoise node and press E to extract it from the pipeline.

21	 Drag the Denoise node to the link between the RGB input and node 01 (Balance). 
Doing so will perform noise reduction on the original RGB signal before any grading or 
animation takes place.

In this instance, the change softens the impact of the noise reduction and gives a 
better visual output.

22	 Bypass the Denoise node before moving to the next exercise.

It’s always advisable to use a dedicated node for noise reduction. After the noise is 
reduced to a satisfactory level, you can disable the Denoise node before proceeding with 
the rest of the grading process. Deactivating the Noise Reduction node will reduce the 
amount of processing and caching that the software will need to perform for playback.

Where Should You Place the Noise Reduction Node?
Applying NR at the start of the node tree is advisable because it analyzes and uses the 
original RGB data to reduce noise. However, this placement may potentially impact the 
precision of key-based selection methods (HSL curves, qualifier).

Applying noise reduction at the end of the node tree can avoid this issue (if it is present) but 
can also produce a slightly less detailed image. When unsure, change the position of the NR 
node in the Node Editor until you find the optimal position.
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Optimizing Performance with 
Render Cache
Almost anyone who has done graphic-intensive work on a computer will be familiar with 
the frustration of experiencing lag when the workstation is incapable of processing the 
data in real time.

DaVinci Resolve offers a variety of methods for improving workstation performance. For 
example, by using Optimized Media, Proxy Media, or any transcoded media workflows, you 
can change the size and quality of the footage to ensure faster playback during editing.

Another powerful method for increasing playback speed is allowing Resolve to render your 
footage while the application is otherwise inactive. You can then play the cached media 
without the need to actively render effects-heavy clips.

Understanding Source and Sequence Caching
The process of rendering footage in the background, or generating a cache, in Resolve can 
be enabled on a variety of levels. In the following exercises, you will enable smart caching 
in your project and observe two early caching levels: source and sequence.

1	 Enter the edit page.

2	 Choose Playback > Render Cache > Smart.

By using the Smart Cache option, you are leaving it up to the software to choose which 
media or nodes are computationally intensive and require caching.

The first level at which caching takes place is the source. When in Smart Cache mode, 
it is generated for processor-intensive video formats such as H.264 and RAW. The 
Project 03 - The Long Work Day timeline uses media in an intermediary codec (DNxHR) 
that is already optimized for editing; therefore, the program is able to play it in real time 
without performing source caching.

After the source cache, a sequence cache is generated in the edit page when 
additional effects such as transitions, titles, or generators are applied to clips in 
the timeline.

3	 In the edit page, open the Effects Library palette.

4	 In the Titles folder under Toolbox, locate the Text title generator.

5	 Drag the title generator onto video track 2 and extend its length to cover the first five 
clips of the timeline.
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6	 In the upper-right of the edit page, open the Inspector palette.

7	 Click inside the text box under the Rich Text heading and enter the project name 
The Long Work Day.

A red line appears over the timeline to indicate that a cache is being generated for 
all the media under the title tool.

When the caching process is complete, the line turns blue.

Generating a Node Cache
The node cache appears in the Node Editor of the color page after the application of 
grades and effects. Like the source cache, when Smart Cache is enabled, rendering occurs 
only when Resolve deems the processes to be intensive.

1	 Enter the color page.

2	 At the top of the page, ensure that the Timeline button is enabled to view the timeline 
ruler in the color page and see your video tracks and cache processes.

3	 Note that the sequence cache over the title generator is still active. Because you do 
not need to see or cache the titles during your grading work, you can disable them by 
clicking V2 on the Timeline Ruler.

4	 Click clip 01 in the Thumbnail timeline.
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5	 The Denoise node was bypassed in a previous exercise. Click the Denoise node name 
to activate it.

The timecode above the clip thumbnail will turn red to indicate that it is in the process 
of caching. The node name and number will turn red in the Node Editor for the 
same reason.

The cache line on the timeline ruler will eventually turn blue as caching is completed.

6	 Create a serial node after the Sunrise node and label it BW (node 04).

7	 In the adjustment controls, drag the Sat value to 0.

Your image retains its sunrise animation, although it is now displayed in only black and 
white. The BW node did not turn red and will not require caching because the standard 
color grading tools are usually not intensive enough to disrupt clip playback.

Adding the BW node has not enacted a re-cache of the Denoise node because the 
denoising is not affected by the changes made in the BW node. If you follow the path 
of the RGB signal, it is denoised before it is desaturated, so the same denoised version 
of the cache can continue to be used.

8	 Click the Denoise node and press E to extract it.

9	 Drag the node over the connector at the end of the pipeline to place it after 
the BW node.

The Denoise node turns red as it re-caches the new RGB signal.
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10	 After the Denoise node turns blue, click the BW node, and adjust the Contrast in 
either direction.

This time, the change prompts the Denoise node to turn red and require a new cache. 
The BW change affected the RGB input of the Denoise node, which has to perform a 
new render using the new RGB signal.

Utilizing User Cache Modes
As you have seen, the decision to render clips on every level of the workflow is made 
within the background processes of the software. Smart Cache allows you to continue to 
focus on your project while Resolve detects when rendering is necessary to enable 
faster playback.

However, at times, you might want to control which clips are rendered. For that, you can 
enable User Cache that will not perform any media rendering until you specifically tell 
it to do so.

1	 Choose Playback > Render Cache > User.
The blue highlights on clip 01 and the Denoise node disappear when automated 
caching is disabled. From now on, all caching will occur only on your command.

Some colorists prefer to work in this mode when they do not want background caching 
to occur throughout a project. One reason may be because they are using RAW media 
and want to cache only those clips that they are actively working on instead of the 
entire timeline.

2	 Click clip 01.

3	 Right-click the Denoise node and choose Node Cache > On. Once again, caching is 
performed and the node name turns blue.

TIP When working on a larger project, you could use the Clips filter to isolate 
clips with noise reduction and manually cache them to avoid enabling 
Smart Cache.

In addition to selecting individual nodes in User Cache mode, you can manually render 
a clip’s entire node tree.
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4	 Right-click clip 05 and choose Render Cache Color Output.

The clip’s timecode turns red in the timeline while the nodes remain white. In this 
scenario, the entire node pipeline is cached, which results in even faster playback 
when compared to rendering individual nodes. However, it also means that making 
changes to any of the nodes in the pipeline will require that the entire clip be 
re-cached.

5	 In the clip 05 Node Editor, add a new serial node called Magenta Look.

6	 Drag the Offset color wheel toward magenta to add color to the clip.

Although the process of adding color to the clip is not processor intensive, the clip 
immediately turns red in the timeline because a new cache is generated for the 
entire pipeline.

Configuring Cache Quality
When you play media in the viewers of the edit and color pages, you can see the playback 
frame rate in the GPU status indicator in the upper-left of the viewer.

A green light indicates that the media is playing in real time. A red light indicates lag, 
with the numerical value displaying the actual frame rate. Caching should result in the 
GPU status indicator displaying a green light during playback. If it does not, you should 
consider lowering the Timeline Proxy mode resolution in the Playback menu or 
reducing the quality of the cache for faster review.

1	 Open Project Settings and click the Master settings tab.
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2	 Scroll down until you see the Optimized Media and Render Cache section.

The Render Cache Format field allows you to set up the quality and format of your 
cache data.

Lowering the cache quality will reduce your cache file size and prevent your hard drive 
from filling up too quickly with cached data. However, this setting will lower the visual 
quality of the rendered media in your viewer. You should avoid reducing cache quality 
if precision of color, luminance, and key data is important.

Inversely, raising the cache quality will ensure a faithful reproduction of your image 
data, but at the expense of producing very large rendered files.

3	 Set the Render Cache Format to one of the full quantization formats (444 or 4444) in 
preparation for the upcoming lessons.

Beneath the Render Cache Format menu are a few checkbox options.

You can specify the amount of time that needs to pass before background caching 
begins in Smart Cache mode. By default, the interval is 5 seconds, but you can 
increase it if you prefer to tweak your settings at a leisurely pace when grading.

Additionally, you can enable automated transition and composite rendering when in 
User mode, which will mimic the behavior of Smart Cache mode.

4	 Select “Automatically cache transitions in user mode.”

5	 Click Save to exit the Project Settings.
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Clearing a Cache
Wherever clips are cached (in the edit page, color page, or in individual nodes), a copy 
of the visual cache data is stored on your disc drive. Eventually, it might be necessary to 
remove this data to make room for more caching or to delete unnecessary materials from 
older projects.

1	 Choose Playback > Delete Render Cache > Unused.

A prompt will ask you to confirm that you want to delete the unused cache.

2	 Click Delete. The media in the timeline remains rendered, while all previous cache 
versions of the clips are removed.

Other options for deleting the render cache allow you to delete all cached media or 
selected clips on the timeline.It’s important to remember that no actual media is 
affected by clearing a cache, and even if you accidentally delete a cache currently 
used in your project, it will be regenerated when it is next needed.

TIP Occasionally, you might come across a graphic anomaly in which the viewer 
in the color page is outputting visual data that does not match the changes you 
made to a clip. For example, a Media Offline message appears when you are 
certain the media is connected. Clearing the render cache will remove the 
program’s memory of the clip render and force it to re-render the clip correctly.

NOTE Cached media is placed in the folder specified in the Project Settings 
under the Working Folders of the Master settings. By default, the Cache folder is 
located on the first media storage location (Preferences > System) of your 
database, but to optimize playback, you may want to redirect it to a drive other 
than the one that contains the Resolve application and your project files.

Proxies and offline media are vital for a clean editing workflow; but their use is discouraged 
for the grading process because they do not offer an accurate representation of the image 
when colors are graded (or when qualifier selections are made). For this reason, the render 
cache is the recommended optimization method.
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Self-Guided Exercises
Complete the following exercises in the unfiltered Project 03 - The Long Work Day timeline 
to test your understanding of the tools and workflows covered in this lesson.

Clip 02—Read the tip at the end of the Creating Cover-Ups with Patch Replacer 
ResolveFX exercise, and then use node sizing to cover up the speed limit signs at the 
top of the frame. For an added challenge, review how you can cover up these speed 
signs by drawing a Power Window directly over them, enabling Key Lock in the node 
sizing palette, and then panning the image.

Clip 08—Use dynamic and static keyframes to flicker the lights in the garage.

Clip 15—Generate a node before the Balance node and apply noise reduction.

When you’ve completed this exercise, you can open the Project 03 - The Long Work Day 
Commercial COMPLETED.drp and review the Lesson 8 Timeline COMPLETED to compare 
your work with this finalized version. If the media appears offline, click the red Relink Media 
button in the upper-left corner of the media pool and specify the location of the Project 03 
media on your workstation.

Lesson Review
1	 True or False? If you change the timeline resolution of a project, you will need to go 

over your secondary grade nodes and manually resize all the Power Windows to fit the 
new resolution.

2	 Where can you animate the sizing and color properties of a clip?

3	 What are dynamic keyframes?

4	 True or False? Noise reduction should be applied only to node 01 of any clip.

5	 Would adding a vignette to a clip cause Smart Cache to render the clip?
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Answers
1	 False. DaVinci Resolve is resolution independent, so all secondary tools automatically 

resize themselves to fit a new project resolution.

2	 You can animate the sizing and color properties of a clip in the Keyframes palette.

3	 Dynamic keyframes are keyframes that gradually change a value between two 
points in time.

4	 False. Noise reduction can be applied to any node in the pipeline, based on necessity.

5	 No. Primary and secondary grading tools are not considered processor intensive 
enough to prompt a Smart Cache render. However, the clip was set to Render Cache 
Color Output, any change, including a vignette, would trigger a re-cache.
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Setting Up  
RAW Projects

RAW media refers to a variety of still and 
video formats in which visual data is 
captured as an unprocessed digital signal. 
In its initial state, RAW media does not 
have any visual properties. It is only 
through a processing method called 
debayering that you are able to assign a 
color space and gamma to the image to 
view it on a monitor. RAW media has far 
greater grading potential due to its wide 
dynamic range and uncompressed 
approach to pixel data.

In this lesson, you will work with 
Blackmagic RAW (.braw) clips. Blackmagic 
RAW offers the same grading latitude as 
other RAW standards with the additional 
benefit of GPU‑acceleration and partial 
debayering, which results in dramatically 
smaller file sizes and faster playback. 

Time
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Adjusting RAW Settings at the 
Project Level
The color management exercises you completed in Lesson 4 demonstrated how you can 
configure a project’s color space and gamma to set up the starting point of a grade. 
Debayering RAW footage works on a similar premise, although it’s a far more essential part 
of the grading process. Without it, the RAW media cannot be displayed in the viewer.

RAW format sensors are defined by their ability to record the radiometric properties of light. 
Rather than representing as a set of pixels with hard color data, RAW formats record the 
light intensity of a scene within the geometry of the sensor’s individual photoreceptive 
elements, or photo sites. 

Each photo site has a filter that allows the capture of only one channel of color (with green 
captured at double the frequency of red and blue). Together, the filtered signals make up 
the Bayer filter mosaic that contains all the data necessary to recreate a digital image.

For this reason, RAW files are sometimes referred to as digital negatives: visual information 
that contains a wide dynamic range of light that remains unviewable until it is processed. 
Debayering (also known as demosaicing) allows you to appoint values to the radiometric 
signals and produce a visible image in a designated color gamut and resolution.

In this lesson, you will work with Blackmagic RAW media. This RAW format is unique in that 
it undergoes partial debayering in the camera hardware, which results in much smaller file 
sizes and its storage as a single video clip (as opposed to image sequences). This format 
allows for much faster playback, media management, and file transfer compared to 
traditional RAW formats. 

Determining Whether Clips Are RAW
You can generally recognize the RAW video file formats supported by DaVinci Resolve 17 by 
their file extensions (.ari, .braw, .cin, .dng, .crm, .rmf, .nef, .r3d, .vrw, and others). Additionally, 
you can check the codec and file type of any clip in the Metadata panel of the media page 
or the clip attributes in the contextual menu.

Another quick way to verify whether footage is RAW is to place it on a timeline, and open 
the Camera RAW palette in the color page. If a selected clip is in a RAW format, the palette 
becomes active and displays options for the Decode Quality and Decode Using fields. If the 
clip is not RAW, the Camera RAW palette is dimmed and inactive.
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NOTE The exercises in this lesson build on the tools and skills you learned in the 
previous sections of the book. If you skipped ahead to this lesson, you may need 
to review Lessons 1, 3, and 5 to gain a better understanding of primary and 
secondary grading and the Node Editor pipeline.

1	 Open DaVinci Resolve 17.

2	 Create a new project, and name it Blackmagic RAW Project.

3	 In the media page, create two bins in the media pool: Media and Timelines.

4	 In the Media storage library, locate the BMD 17 CC - Project 03 folder and enter the 
Blackmagic RAW subfolder.

5	 Open the Media folder and drag the four RAW clips into the media bin.

NOTE When importing media, if a dialogue box appears informing you that 
your Project Settings don’t match the clips’ frame rates and video formats, 
click Change to adjust the project timeline to accommodate your media.

6	 Enter the edit page.

7	 Select the four Blackmagic RAW clips. Right-click one of them and choose Create New 
Timeline Using Selected Clips.

8	 Name the timeline Blackmagic RAW Timeline and place it in the Timelines bin.

The newly generated timeline contains the four Blackmagic RAW clips in the order they 
were sorted in the media pool.

NOTE If Smart Cache is enabled in your project, the Blackmagic RAW clips 
will immediately begin the caching process. Unlike the media you’ve used in 
the previous lessons, RAW formats are not intermediary codecs and need 
constant debayering and caching.
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Reviewing the clips in the timeline viewer, you will see that two of the clips have black 
bars at the top and bottom of the image. This is known as letterboxing and occurs 
when clips have a different aspect ratio to the timeline viewer. By default, DaVinci  
Resolve will scale media with mismatched resolutions in a way that preserves maximum 
video data. However, if you want all the clips to have the same framing, you can change 
your scaling options in the Project Settings. 

9	 Open Project Settings and click the Image Scaling tab.

10	 Under the Input Scaling parameter, set Mismatched resolution files to Scale full frame 
with crop.

All imported media will now be scaled to fill the viewer frame. This happens at the 
expense of some cropping on the edges of the clips, but this data can still be retrieved 
using the Input sizing palette.

Next, you will set up the project color management.

11	 In the Project Settings window, click the Color Management tab.

12	 Set the Color Science to DaVinci YRGB Color Managed.

13	 Set the Resolve color management preset to DaVinci Wide Gamut. This color space is 
optimal for working with RAW media, as it exceeds all current recording standards.

14	 Leave the Output color space as Rec.709 Gamma 2.4

Finally, you will review the project-wide RAW settings currently in place.

15	 In the Project Settings, click the Camera RAW tab.

These parameters affect the debayering of RAW footage on a project-wide basis.

16	 Set RAW Profile to Blackmagic RAW.
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17	 The Decode Quality is set to Full Res. (full resolution) by default, which means the 
RAW media is debayered at the timeline resolution specified in the Master Settings. 
Changing the quality to Half or Quarter will substantially reduce the amount of 
processing required to play the footage (at the expense of the visual quality within the 
viewer/monitor) but is a viable option for slower systems.

Leave the Decode Quality at Full Res. to continue debayering at the 1920 x 1080 HD 
resolution.

18	 The Decode Using field allows you to specify how the color gamut of the RAW signal 
is debayered. By default, it is set to Camera Metadata, which is the color standard 
set by the camera operator when capturing the media. Changing it to Blackmagic 
RAW Default will prompt it to use any associated sidecar files that contain additional 
information such as ISO, white balance, color temperature, contrast, and many others. 
Setting the decode method to Project will reveal the fully customizable project and 
camera metadata settings at the bottom of the window.

NOTE DaVinci Resolve automatically detects the source of all supported 
RAW formats. Changes to the Project Settings will have an immediate effect 
on RAW clips in the media pool and timeline, even when working with 
multiple RAW profiles. 

Also, Camera RAW settings will impact only the RAW media in your project. 
Non-RAW clips remain unaffected.

Leave Decode Using set to Camera Metadata (default) and click Save to exit the 
Project Settings.

19	 Before you continue, check that the native color space of the clips has been correctly 
identified and mapped.

Select all four clips in the media pool, right-click one of them, and verify that the Input 
Color Space is Blackmagic Design Film Gen 1 in the contextual menu.

20	 Review the timeline to verify that the letterboxing has been removed and color 
management is enabled.
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Different Methods of Setting Up RAW Projects
There is no single correct approach to treatment of media prior to the start of the grading 
process. In the first part of this book, you began working on media without any special 
treatment. In Part 2, you enabled color management to automatically map log-encoded 
source clips to the Rec.709 color space. In the final part, you took advantage of DaVinci 
Wide Gamut to both remap and future-proof a grading project. The following are some other 
common approaches when starting a new grading project in DaVinci Resolve, in particular 
when working with RAW media:

Camera RAW Project Settings and Palette—DaVinci Resolve automatically detects all 
supported RAW media formats and debayers them accordingly. Additional controls in the 
Project Settings and Camera RAW palette allow you to tweak debayer parameters 
throughout a project or on each individual clip.

Lookup Tables (LUTs)—Digital files that transform color and tone pixel data from one state 
to another. Unlike other color management systems, LUTs assign specific RGB values during 
conversion, giving you identical results across applications. However, due to the finite 
amount of values they can represent, parts of the RAW signal are approximated during 
conversion, which can be limiting to the final grade. This makes them popular for dailies 
workflows, in which the integrity of the final video signal is not paramount. 

Color Space Transform (CST) and Gamut Mapping (GM) ResolveFX—Can be applied to 
nodes from the OpenFX panel in order to map the color and tonal data of individual clips or 
groups if applied on a pre-clip or post-clip Node Editor level. CST is often used to remap 
scenes with unique mapping requirements or placed at the end of the Timeline Node Editor 
pipeline to change the deliverable standard of a project when not using RCM. 

Resolve Color Management (RCM)—DaVinci Resolve’s internal mapping system allows you 
to indicate the color standard of your source media, set up a working timeline color space, 
and then change the output based on deliverable needs. Additional default parameters 
analyze and remap clip tonal data to produce the optimal visual results and consistent 
grading behavior. As well as allowing individual input color spaces, RCM accommodates the 
integration of other color management methods when the workflow requires it: Camera 
RAW settings, LUTs, CST, and others.

Academy Color Encoding System (ACES)—Display-independent color space that is 
emerging as an industry standard in major production houses and streaming services. ACES 
can be enabled in the Color Management settings and operates similarly to RCM. Like 
DaVinci WG, its working gamut far exceeds current monitoring standards, which makes it 
ideal for producing masters, archives, and deliverables. Due to its focus on standardization, 
ACES parameter setup and delivery tends to be more rigid, as it aims to produce an exact 
color space conversion rather than the visual-focused RCM approach.

The decision to use one color approach over another can be based on a number of factors: 
source media, delivery format, monitoring standards, access to appropriate LUTs, and 
personal preference. In this lesson, you will continue to work with Resolve color 
management, giving additional consideration to the treatment of the RAW signal on the 
color page.
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Adjusting RAW Settings at the 
Clip Level
You will often want to set up RAW media to address the individual needs of clips. Using the 
Camera RAW palette in the color page allows you to tweak on a clip-by-clip basis. 

1	 Enter the color page.

2	 Click clip 01 (C001).

3	 In the left palettes of the color page, open the Camera Raw palette.

4	 Set Decode Using to Clip. Doing so will disassociate it from the Project Settings and 
allow you to individually adjust the RAW settings on the clip.

The Camera Raw palette gives you access to a variety of color and detail adjustments 
that you can apply to the visual data of the image during debayering. The debayer level 
affects images before they enter the RGB input node of the Node Editor.

5	 Change the ISO to 200.

Although the image has already been captured, you can adjust the sensor sensitivity to 
better accommodate the starting point of your grade to the luminance in the scene. 
This is a feature unique to RAW media workflows.

6	 Change the ISO back to 100.

7	 Select the Highlight Recovery checkbox.
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Highlight Recovery will debayer highlight sensor data that is usually clipped in the 
standard decoding matrix. In RAW clips with extreme waveform peaks, this option will 
often reveal additional visual data.

Without Highlight Recovery With Highlight Recovery

8	 Temperature is another property of light that can be adjusted during the debayering 
stage. Drag the Color Temp slider right (6000) to warm up the image.

9	 To reset the Color Temp to the original setting used during filming, click the White 
Balance drop-down menu on the left and choose As Shot.

When working on a RAW timeline, you will often want to customize multiple RAW clips 
in a sequence. Two buttons at the bottom of the Camera Raw palette allow you to copy 
palette data: Use Settings and Use Changes.

	– Use Settings will apply all the Camera Raw settings from a selected clip to all 
highlighted clips on the timeline. This option is best used when working with media 
from the same source, with identical gamut and exposure needs.

	– Use Changes will ripple only the altered parameters, preserving the selected clips’ 
individual settings. This is ideal when working with visually diverse media that has 
unique ISO and Color Temp requirements.

10	 With clip 01 still selected, Shift-click clip 04 to highlight the timeline.

11	 Click Use Changes in the Camera Raw palette. As the only available parameters in clips 
2-4 are the decode settings, all three clips will switch from Project to Clip decoding, 
while keeping all other clip settings unchanged.

TIP When saving stills from clips with manually adjusted Camera RAW 
settings, you can specify that you do not want their camera RAW settings 
included in the still grade data. Right-click in the Gallery and choose Copy 
Grade: Preserve Camera Raw Settings to enforce this.



270 271Adjusting RAW Settings at the Clip Level

12	 Select clip 02 (C003).

The clip is a little dark but is otherwise in a good starting position for balancing and 
color grading. All its visual needs can be addressed using the standard primary 
grading tools. Leave the ISO at 800 and leave Highlight Recovery unselected. 

13	 Select clip 03 (D007).

Reviewing the scopes will tell you that there is a substantial amount of highlight data 
crushed at the top of the waveform graph. It will be difficult to target that area of the 
signal while grading, so you need to take steps to spread the waveform downward.

14	 Set the ISO to 200. This will darken the clip without damaging the shadows, and 
expand the highlights, making them easier to access.

Another method of adjusting signal brightness is to use the Exposure parameter in the 
central column of the Camera Raw palette. 1.00 stop of exposure is equivalent to 100 
ISO, which means that entering decimal values will allow you to adjust exposure in 
smaller amounts than the whole values featured in the ISO drop-down menu. 

15	 Lower the Exposure parameter (-0.80) to further reduce brightness and leave room for 
the highlights to be raised at the top of the waveform.

16	 Select Highlight Recovery to reveal additional data outside the window.

17	 Select clip 04 (E004).

This clip features a dark environment with unique lighting conditions. For best results, 
you’ll want to bypass the project color management process to gain full control over 
the clip’s gamma settings.

18	 Right-click clip 04 and select Input Color Space > Bypass.

As Resolve color management is no longer handling the gamma treatment of the 
image, the grayed-out areas of the Camera Raw palette become available for user 
customization.

19	 Leave the Color Space set to Blackmagic Design. 

There are several options for treating the image gamma (or EOTF) in the Gamma 
pop-up menu. Blackmagic Design Film applies the default BMD log-encoded gamma 
profile. BMD Video applies a Rec.709-like gamma curve for viewing RAW media on 
standard dynamic range HD/UHD displays. BMD Extended Video is similar but will also 
carefully roll off the highlights to avoid clipping in an SDR monitor.

20	 Leave the Gamma set to Blackmagic Design Film. Once you begin to make gamma 
adjustments in the palette, this setting will change to reflect the custom nature of the 
gamma treatment.

The Gamma Controls in the right column allow you to fine-tune additional debayer 
parameters. Saturation and contrast should be familiar terms but are best dealt with 
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using the primary palettes. Midpoint determines the level around which contrast is 
adjusted and can be used to pivot an image with a skewed tonal range. Highlight and 
Shadow Rolloff allow you to selectively lighten or darken those tonal ranges while 
maintaining a smooth blend in relation to the midtones. The white and black levels act 
as gain and lift adjusters. 

21	 Set the Midpoint to 0.50 in order to raise the waveform, leaving more room to expand 
and grade the prominent shadows.

With the clips successfully set up, you can begin grading in the Node Editor as usual. 

The Camera RAW palette is best used for addressing the unique exposure needs of RAW 
media prior to grading. It is highly advisable to avoid balancing or creating looks in the 
Camera RAW palette. The standard grading tools in the color page have the same level of 
impact on the RAW image and are far easier to keep track of in the context of the node 
tree, which will reduce instances of destructive grading.

Grading High Dynamic Range Media
One of the unique challenges of color grading HDR footage is targeting the wide tonal 
latitude of the available data. In a previous lesson, an overexposed sky had to be selected 
using secondary grading methods in order to make a luminance adjustment. Instances of 
such targeted tonal adjustment are much more frequent when shooting HDR and would 
ordinarily require extensive secondary grading to achieve a clean look. 

The High Dynamic Range (HDR) palette is a primary grading tool featuring color wheels 
mapped to customizable tonal ranges that can be used to grade the entire dynamic range 
of a RAW image within a single interface.

Targeting Individual Tonal Ranges
A major benefit of the HDR palette is its advanced tonal range control. Instead of relying on 
just three wheels to determine the placement of the highlights, midtones, and shadows, 
you can construct a scene by adjusting each tonal step of the image independently. The 
rolloff between the tonal ranges ensures grades appear smooth and natural.

In this lesson, you will color grade a RAW clip to gain an understanding of the HDR palette’s 
unique global and tonal range parameters.
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1	 Select clip 01 (C001).

2	 In the left palettes, open the High Dynamic Range palette, which is located next to the 
Primaries.

At first glance, this palette appears very similar to the Primaries color wheels. In fact, 
much of the operation remains the same—the control point in the center of the wheels 
is used to add color to a tonal range, while controls underneath determine exposure 
and saturation. 

One of the first major differences is the number of wheels you control. A row of buttons 
under the palette header allows you to navigate between the different tonal zone 
wheels. This action is called banking.

You can click the arrows on either side to bank wheels or click on the wheel icons to 
jump one or more wheels at a time.

Another major difference is in the way the global wheel impacts the image. Whereas 
the Primaries offset wheel affects the image uniformly, the global wheel pinches the 
black and white points of the signal, rolling the shadows and highlights in order to 
compress, but never clip, either extremes of the waveform. As a result, adjustments to 
the exposure and saturation of a video signal have less effect in the shadows and 
highlights, which produces more natural-looking changes.
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TIP The High Dynamic Range palette is designed for optimal performance 
with Resolve color management enabled. When RCM is enabled, the HDR 
palette adopts Color Space Aware behavior, meaning it automatically maps its 
own operational color space to the source image, producing perceptually 
uniform results while maintaining careful control of image saturation. However, 
you can still use the HDR palette without RCM enabled on both SDR and 
HDR media.

The Temp and Tint sliders on either side of the global color wheel are also uniquely 
mapped. They are designed to travel the image across the Planckian locus line, which 
represents the temperature path of natural light in the CIE graph. This results in more 
natural temperature change in the image.

The adjustment controls across the bottom of the palette have the same tonal mapping 
as the global wheel. Some controls exhibit behavior unique to the HDR palette:

	– Temp and Tint are numeric representations of the global wheel sliders and can be 
used when you need more accuracy or to reset the values. 

	– Contrast and Pivot keep saturation perceptually constant when adjusted. This is 
advantageous for HDR grading, where high contrast can lead to oversaturation in the 
highlights.

	– Black Offset determines the minimum value of the video signal (i.e., the darkest 
shadow), while gently compressing the data above it. 
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3	 To begin the grading process, review the waveform scope. 

Overall, the trace looks good; there is no obvious clipping in the highlights or shadows. 
Much of the midtone data representing the foreground appears gathered at the bottom 
of the graph, resulting in flat-looking shadows. The top of the waveform appears 
compressed along a narrow range, limiting the detail you can see in the clouds. 
You will address both of these issues using the HDR palette.

4	 The global wheel is a good starting point for establishing the overall exposure of a clip. 
Raise the global Exp (0.60) parameter until the foreground portion of the trace reaches 
the middle of the scope graph.

5	 To establish the overall image saturation, drag Sat (1.50) under the global wheel. 
Note that due to the unique global luminance mapping, saturation is not increased as 
aggressively in the foreground shadows or in the clouds.

TIP You can use Color Space Transform ResolveFX to automatically map the 
color space of log-encoded footage to Rec.709, while remaining in DaVinci  
Resolve’s Intermediate working gamma. After adding the CST ResolveFX to 
the first node in the pipeline, change the Output Color Space to Rec.709. This 
method will quickly prepare the color and saturation of an image, while still 
leaving you with full control over its luminance.
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With the global values set, you can move on to the individual tonal zones. The six 
default zone wheels are split into two categories: dark zones and light zones.

The graph above represents the order of the default zones in the palette and their 
respective tonal ranges. The further to the edges you travel, the more dedicated the 
tonal zones become.

The Shadow and Light wheels have the broadest impact and overlap each other by a 
factor of two stops. They each have narrower tonal ranges within them that allow you to 
fine-tune narrower luminance ranges and create contrast.

You will address the dark zones first.

6	 Bank the HDR palette wheels until you see three dark tonal range color wheels: Black, 
Dark, and Shadow.

7	 Drag the Dark wheel Exp (-0.20) to accentuate the shadows in the foreground bushes. 
This range is narrow enough not to impact most of the foreground midtones.

8	 To enhance the foreground saturation, increase Sat (1.20) in the wider Shadow zone.

Next, you will work on the light zones to reveal the details in the sky.

9	 Bank the HDR palette wheels until you see three Light zone color wheels: Light, 
Highlight, and Specular.

To create room for expansion in the highlights, you must lower the top section of 
the waveform.
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10	 Drag Highlight Exp (-1.60) left until the top of the waveform falls mostly along the third 
horizontal line from the top.

You now have room to expand the very top of the highlights, revealing detail 
through contrast.

11	 Drag Specular Exp (1.70) right to lift the top of the waveform trace, revealing fine 
cloud detail.

The default tonal range graph in step 5 shows that the Highlight and Specular zones 
both overlap the broad Light tonal range. This means you can use the Light zone to 
make broader exposure changes, while maintaining the established contrast in the 
narrower zones.

12	 Drag Light Exp (-0.75) left to darken the sky, while keeping the cloud detail intact. 

13	 Drag the Light color wheel control point slightly toward blue to add more color 
to the sky.

TIP In the HDR palette options menu, you can change the numeric 
representation of the control point position under the Exp parameter. 
Display X and Y allows you to adjust the control point horizontally and 
vertically. Display Angle and Strength will travel the control point in a circular 
motion to determine hue and on a radius to determine saturation. These 
controls can be useful when you need to make very fine adjustments.

There are several options that allow you to review and modify how the tonal zones 
affect the image. 
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14	 Click and hold the symbol next to the Light zone name to review which areas of the 
image are being impacted.

This quick preview option allows you to check the tonal range impact and determine if 
it needs adjustment.

In this case, the Light zone is affecting too much of the foreground and should 
be reduced.

15	 For a permanent view of the tonal zone selection, click the Highlight button in the 
upper left of the viewer. Highlight mode will display the selection of the tonal zone you 
are actively working on, leaving you free to make range and falloff adjustments.

NOTE When using the viewer’s highlight mode with other tools, such as the 
Qualifier, HSL curves, or Color Warper, ensure that the HDR palette is not 
active in the left palettes to avoid seeing the tonal zone selection.

Every zone color wheel is surrounded by two sliders: Min/Max Range and Falloff. The 
Min/Max Range slider determines the zone limit, while the Falloff gently fades the 
selection to avoid artifacting.
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16	 Drag the Light zone range slider up to 0.00. The selection in the viewer contracts to 
show mainly the sky.

17	 Click the Highlight button to disable preview of the Light zone range.

With the majority of the tone adjustment work done, you can make some final tweaks.

18	 Increase contrast (1.040) and pivot (2.000) to accentuate the details in the scene while 
keeping the saturation uniform.

19	 Increase midtone detail (20.00) to further sharpen the clouds and foreground data.

Before After

Let’s review the HDR Zone panel to gain a better understanding of how the tonal zones 
were distributed across the image.

20	 In the HDR palette header, click Zones Graph.
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The Zones graph is an additional panel in the HDR palette that allows you to modify the 
Max and Min Ranges of the tonal zones.

On the left is a sidebar featuring the names of the zones, which you can click to 
highlight their range indicator on the graph. Drag the indicator by the handle to change 
the minimum or maximum range of a zone. The range will impact the entire section in 
the direction of the handle arrow, with a soft falloff transition, which is indicated by the 
soft red line. You can also use the sliders beneath to adjust and reset the range and 
falloff values. These parameters are mapped to the sliders on either side of the color 
wheels in the color wheel panel.

Behind the graph is a histogram of the frame that the playhead is currently on. This 
histogram can be helpful for determining where range indicators should be placed and 
how soft the falloff should be. It’s important to note that if a histogram signal ends 
before the start of a range indicator, that zone will have no impact on the image when 
adjusted in the HDR palette. In this instance, there’s nothing to the left of the Black 
zone, meaning that changes to the Black zone color wheel, exposure, and saturation 
will not affect the image.

TIP The HDR palette Zones graph sidebar features additional controls that 
allow you, in order, to disable the impact of that particular zone, switch zones 
between light and dark, hide the zone indicator in the graph, or delete a zone 
(for custom zones only).



280 281Grading High Dynamic Range Media

Correcting Scenes with a Wide Dynamic Range
Scenes captured in HDR sometimes feature a dramatic shift in exposure over different 
areas of the frame—a common example is windows in an interior scene or when shooting 
someone against a light source. With standard correction tools, you would need to use a 
combination of secondary grading techniques to get an optimal result. The HDR grading 
palette allows you to address a range of exposure levels using just one primary tool.

1	 In the HDR palette header, return to the color wheels panel.

2	 Select clip 03 (D007).

In a previous lesson, you changed how this scene was debayered to better distribute 
the signal for grading. The resulting image features a dark interior with bright windows. 
Your first priority will be to restore the interior, which is where the audience will 
predominantly be looking.

3	 Label node 01 as HDR balance.

4	 Establish the overall scene brightness by raising the global Exp (2.40).

When you finish adjusting the global wheel at the start of a grading process, you have 
the option of banking it together with the other wheels, so that your palette can 
represent four tonal zones at once.

5	 Click the Option menu in the upper-right corner and select Bank Global with 
Color Wheels. If needed, you can still access the global wheel by banking to the 
rightmost wheels.

Before continuing, you will review how the tonal ranges are distributed across 
this image. 
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6	 To open the zones panel without hiding the HDR color wheels, click the Expand button 
in the HDR palette header.

This action opens the Zones graph in the central palettes of the color page, allowing 
you to grade and modify the tonal ranges simultaneously.

Overall, the tonal range layout and distribution appears appropriate for the scene’s 
histogram, which is evenly spread through the graph. Because the window and the 
light spill in the room compose a smaller portion of the image than the interior, you will 
likely need to adjust the Light range at some point. However, it’s too early to tell how 
the Light zone should be defined, so you will return to make adjustments later.

TIP You can create a custom zone in the HDR palette by clicking Create New 
Zone at the bottom of the Zones panel sidebar. Like the preset zones, a 
custom zone can be defined as either light or dark and will appear as a color 
wheel with unique range and falloff parameters in the HDR color 
wheels panel.

7	 Increase the Dark Exp (0.60) to brighten the shop interior. This completes the 
normalization in the dark zones. 

Next, you will use the light zones to fix the overexposed window.

8	 Lower the Light Exp (-5.50) until the waveform´s peak is between the top two lines in 
the scopes. 

9	 Gently increase the Specular Exp (0.20) to restore some of the exterior highlights, 
creating contrast.

This fixes the issue of the overexposed window, although there is now elevated 
saturation in the red and orange objects outside. 
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10	 Reduce the Highlight Sat (0.80) to target the bright elements outside the shop.

With the Light zone being the broadest light tone range, you can adjust the Min Range 
to produce optimal distribution of the light spill inside the shop.

11	 Select the Light range in the Zones panel sidebar and drag the Min Range value (-0.70) 
under the graph until the light spill in the shop appears more pronounced.

12	 To remove any artifacting on the walls and floor, raise the Light range Falloff parameter 
(0.90) until the daylight spills smoothly across the shop surfaces.

TIP You can save a custom HDR palette layout and parameter settings by 
opening the HDR palette options and selecting Save as New Preset. Presets 
can be useful if you regularly process footage from the same camera with 
similar lighting compositions (such as interviews or set shoots).

Make some final adjustments to complete the scene balance.

13	 Increase the Midtone Detail (50.00) to sharpen the details in the shop interior.

14	 Reduce the Temp (-1500) and Tint (-5.00) to balance the color cast on the walls.

15	 Raise the Black Offset (0.400) to set a lighter base level for the interior shadows.

You can now proceed to apply a creative grade as usual. 

16	 Create a second node, and label it Look.

17	 Use the curves palette to create a warm look with cool shadows. To brighten the 
image, isolate the Y curve and drag upward from the middle. Draw a reverse s-curve in 
the B channel and a standard s-curve in the R channel.

Before After

In many cases, grading RAW media is no different from grading non-RAW media. The 
wide dynamic range demands increased attention and handling, but the creative 
primary and secondary workflows often remain the same.
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Mapping the HDR Palette to Color Panels
The HDR palette is designed to be mapped to the DaVinci Resolve Advanced and Mini 
panels, even when incorporating custom tonal zones and presets.

Advanced panel: Press SHIFT + AUTO COLOR. All current controls will be mapped to the 
center panel soft buttons and rotaries, while the zones will be mapped to the trackballs and 
rings. Press the < and > soft keys to navigate all available zones.

Mini panel: Press USER and then the HDR soft key above the left display. All HDR palette 
controls will be mapped to the soft keys and knobs, while the zones are mapped to the 
trackballs and rings. Press the PREV ZONE and NEXT ZONE soft keys to navigate all 
available zones.

Setting Up a Render Cache 
for RAW Media Projects
In Lesson 8, you set up your project render cache to a full-quantization (444 or 4444), 12-bit 
depth codec, but the exercise did not go into detail about the effect this had on the grading 
process. In this exercise, you will change the render cache quality to observe its impact on 
the image in the viewer and gain an understanding of why the render cache format matters 
when working with RAW video.

1	 Click clip 01 (C001).

2	 Open Project Settings and click the Master settings tab.

3	 Scroll down to the Optimized Media and Render Cache section and set the Render 
Cache format to a lower-quality codec such as ProRes 422 Proxy (macOS) or DNxHR 
LB (Windows).

4	 Click Save to close the Project Settings.

5	 Choose Playback > Render Cache > Smart to ensure that caching is enabled.

The timecodes above the clips will appear red while the cache is rendered. When 
finished, the timecodes will turn blue.

6	 If you do not immediately see a change in the viewer, drag the playhead to force the 
active frame to be cached.
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Caching the RAW video in a lower-quality format produces a distorted image with 
pronounced banding in the sky.

Instead of a smooth blue gradient, the sky now appears to be made up of blue, purple, 
green, and pink stripes. This is the result of using a render cache format that can only 
represent a limited amount of luminance and color values. The impact is so severe that 
it is even visible in the waveform.

As well as being a poor representation of your grade, a low-quality render cache 
format can also interfere with your ability to accurately make Qualifier selections or 
view the result of analytical tools, like noise reduction or the Magic Mask. If you use a 
slightly higher-quality render cache format, you might experience reduced artifacting 
in the viewer, but the image grading potential will still be limited.
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7	 Open Project Settings and click the Master settings tab.

8	 Set the Render cache format to one of the full-quantization (444 or 4444) or HDR formats.

9	 Click Save to close the Project Settings.

TIP 12-bit depth codecs (such as DNxHR HQX, DNxHR 444, and ProRes 4444) are 
HDR compliant and can be used for cinema and UHD 4K delivery.

Due to its level of quality, you can use a 12-bit cache in the final export of a 
project. When adjusting the Render Settings, in the Advanced Settings, select 
“Use render cached images.”

When setting a render cache format, remember that it affects only what you see in the 
viewer. If you were to render a clip from the deliver page while caching in a low-quality 
codec, the exported image would not have clipped shadows and highlights. This behavior 
makes it particularly important to set up a high-quality cache when grading HDR and high 
bit depth footage. If you don’t, your final project could end up looking very different from 
what you see in the viewer.

The intermediary codecs available in the Master settings are all relatively high quality for 
editing and review work; but as you can see from this exercise, not all of them are suitable 
for grading media with a wide dynamic range. Due to their lower bit depths, most codecs 
are incapable of displaying the full scope of your grading work and could seriously impede 
the quality of your qualifier selections and clip details in the highlights and shadows.

Self-Guided Exercises
Complete the following self-guided exercises in Blackmagic RAW Timeline to get more 
practice using the HDR grading palette and secondary grading tools.

Clip 02 (C003)—Use the HDR palette to ensure that the models are well lit, with saturated 
skin and a warm overall tone. Increase the chromatic contrast in the sky by saturating the 
orange clouds against the blue sky. In a new node, use the Color Warper to change the 
models’ shirts to green/cyan. Use a window to isolate the shirt selection, if necessary.

Clip 04 (E004)—Use the HDR palette to illuminate the cable car against the dark 
background. In a new node, make the cart stand out by turning the interior a cool blue. Use 
a power window and qualifier, if necessary. In a final node, denoise the clip.

When you’ve completed these exercises, open the Blackmagic RAW Project COMPLETED.
drp and review the finished Blackmagic RAW COMPLETED timeline to compare it with your 
work. If the media appears offline, click the red Relink Media button in the upper-left corner 
of the media pool and specify the location of the Project 03 Blackmagic RAW media on 
your workstation.
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Lesson Review
1	 When adjusting project-wide RAW debayer settings, where do you indicate the 

camera format?

2	 True or False? You can change ISO and white balance of RAW media at any time.

3	 What does banking accomplish in the HDR palette?

4	 Which tonal range is wider, Shadow or Highlight?

5	 True or False? Render cache should always be disabled when grading.
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Answers
1	 Trick question! DaVinci Resolve automatically detects the camera format of imported 

RAW media. To access the appropriate RAW settings, open the Camera RAW project 
settings and select the RAW profile you wish to adjust. 

2	 True. Due to the wide dynamic range of RAW media, it is possible to adjust the ISO 
and white balance in the Camera RAW settings of any clip and at any stage of the 
grading process.

3	 Banking refers to the process of navigating between the tonal zone wheels in the 
HDR palette.

4	 In the default preset layout, the Shadow wheel has a wider tonal range than the 
Highlight. However, both of these zones can be modified as needed.

5	 False. Ideally, you will want to disable render cache to review your final grade and 
deliver it, but enabling render cache during grading often helps with faster rendering 
and real-time playback. This is acceptable grading practice as long as the render 
cache quality is sufficiently high.
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Using Lightbox to Check 
Timelines Prior to Delivery
The Lightbox is a color page feature that gives you an alternative, expanded representation 
of the timeline. It provides a general overview of clips in the edit rather than the viewer-
focused layout of the default color page. It is particularly powerful when combined with 
filters, and can be used to quickly assess the grade status of timeline clips.

1	 Open DaVinci Resolve 17.

2	 Import and open Project 03 - The Long Work Day Commercial COMPLETED.drp. 
If necessary, relink the media by clicking the red Relink Media button in the upper-left 
corner of the media pool and specifying the location of the Project 03 media on your 
workstation.

3	 Open the Lesson 10 Timeline.

4	 Enter the color page.

5	 In the upper right of the color page, click the Lightbox button.

The Lightbox displays a full-screen representation of your project timeline from left to 
right, top to bottom. A ruler to the right of the window indicates the timecode of the 
clips and turns into a scrollbar when a timeline has more clips than can be displayed in 
a single page.
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The Lightbox provides an expanded overview of the timeline’s thumbnails and can be 
helpful for colorists who find the Clip timeline in the regular color page too restrictive. 
With a single glance at the Lightbox, you can determine which clips are graded and 
which aren’t.

6	 Click the Clip Info button in the upper-left corner of the Lightbox panel to display clip 
numbers, timecodes, codecs, source names, and version information.

7	 Next to the Clip Info button, click the Sidebar button to expand the filtering options.

8	 In the filter options, click Ungraded clips.

The Lightbox panel is reduced to just four clips. The first two clips clearly belong in the 
Garage group but must have been overlooked during grading.

9	 Select both clips and choose Groups > Garage > Assign to Group.

The majority of the grading in the Garage group was carried out in the post-clip stage, 
so the two clips will immediately adopt the look of the rest of the group. They will 
remain in the Lightbox results until the next time you change the filter, after which their 
new status as graded clips will be acknowledged.

The third clip in the ungraded filter results has not been touched at all.

10	 In the upper left of the page, click the Color Controls button to open the grading 
palettes in the lower half of the screen.
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If you’re working with an external monitor, you will see a full-screen output of the 
selected clip in the Lightbox. You can continue to grade and tweak your media in 
Lightbox mode.

11	 Raise the offset master wheel (35.00) until the bulk of the image’s waveform occupies 
the bottom half of the scopes graph. Lower the lift master wheel (-0.01) to address the 
resulting raised shadows.

The result in the filter is the solid white matte at the end of the sequence, which doesn’t 
require grading.

12	 In the sidebar filter, select Noise Reduction.
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When performing noise reduction in Lesson 8, you learned that bypassing the Denoise 
node would facilitate faster playback during the remainder of the grading process and 
result in a more efficient workflow.

If you use this method of performance optimization, you must remember to re-enable 
the Denoise nodes before outputting the project.

13	 Click the Lightbox button in the upper-right corner to close the Lightbox interface.

14	 The Noise Reduction filter is still active in the timeline on the color page. Click the two 
clips one-by-one and verify that their Denoise nodes are not bypassed.

15	 Select Clips > All Clips to remove the filter and return to the entire timeline.

TIP The Timeline Thumbnail mode is another great option for visually assessing  
the status of clips in the timeline while in the Lightbox panel. Choose View > 
Timeline Thumbnail Mode > Source (C Mode) to switch the order of the clips in the 
timeline from their edit order to the order in which the media was created. When 
working with original camera footage, this will display the order in which the 
footage was recorded. C Mode will place clips that were captured on the same 
day/location next to each other, which enables faster copying of grades and visual 
assessment. When done, remember to set the Timeline Thumbnail mode back to 
Record (A Mode).

The media has now been checked to ensure that grades were applied to all relevant clips 
and that all nodes are active. When working on your own projects, think about the types of 
workflows you use and what is important to verify before delivering a project.

As well as the standard filters already present in the sidebar, you can also use the Smart 
Filters option at the bottom of the list to design filters based on the metadata of the clips 
on the timeline.
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Understanding the Render 
Workflow and Presets
The deliver page is optimally designed to help you quickly set up one or more render jobs. 
Only four steps are needed to export a video from Resolve:

a	� In the Render Settings panel, set up the video output format. These settings include 
the file type, codec, and audio format of the rendered video; its name and location on 
your workstation; and a variety of advanced controls to optimize the render speed 
and file size.

b	� Define the range of the timeline you want to export. By default, each job is set to 
render the entire timeline, but you can use In and Out points to define a custom range.

c	� Click Add to Render Queue to send the job(s) to the Render Queue.

d	� Click Start Render to begin the render process.

In the following exercise, you will create a render job based on a preset in the Render 
Settings of the deliver page.

1	 Enter the deliver page.

At the top of the Render Settings panel, you will find a horizontal list of render presets.
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Custom provides access to the full range of render settings in the panel below.

YouTube/Vimeo /Twitter sets up the render settings based on video configurations 
recommended by user-generated content and social media websites.

ProRes, H.264, and H.265 Masters deliver several versions of a video file for a client: 
from high-end exports appropriate for broadcast (ProRes) to compressed HD/UHD files 
for review or online playback (H.264 and H.265). Note that the ProRes Master preset is 
available only on macOS systems.

IMF features a set of SMPTE ST.2067-compliant resolutions and codecs for tapeless 
deliverables to networks. In DaVinci Resolve Studio, this option does not require a 
license and supports multiple media streams for video, audio, and subtitle tracks.

NOTE The Interoperable Mastering Format (IMF) is used for broadcast 
distribution and online streaming services like Netflix and Disney+.

Final Cut Pro 7/X, Premiere XML, and AVID AAF accommodate a return trip to the 
respective NLE software. This assumes a workflow in which media was originally 
edited in an NLE, migrated to Resolve for grading/VFX, and is returned to the same 
NLE for final delivery.
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Pro Tools renders out three files: a self-contained video for reference, individual 
exports of all audio clips and their channels, and an AAF file for Avid Pro Tools 
migration. This preset accommodates workflows in which the final audio mix is 
mastered by an external audio engineer in Pro Tools.

Audio Only disables video output and delivers a single audio-only file. You can specify 
the audio file format in the Audio tab of the Render Settings.

Clicking the icon of a preset will load its settings into the Render Settings panel.

2	 Click the disclosure arrow next to the YouTube preset and choose 2160p to load the 4K 
UHD version of the preset.

The Render Settings panel changes to display the most relevant values for the 
YouTube preset.

Presets are convenient for quickly setting up project renders but remain fully customizable 
for further refinement. In this case, you’d like to produce a video with a lower data rate than 
the default.
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3	 At the top of the panel, click the Custom button next to the YouTube preset.

The panel reverts to its custom layout but has adopted all the YouTube settings: the file 
format and codec and the 4K resolution.

4	 Scroll down the settings panel, and change the Quality to Restrict to 7500 Kb/s. Doing 
so will reduce the data rate of the file, significantly lowering the file size while still 
maintaining a good level of visual quality.

5	 To name the video file, scroll up to the Filename and Location fields.

6	 Click the empty field next to Filename, and enter WorkDay_YouTube_1.1.

The Location field identifies where the rendered file will appear after rendering. A job 
cannot be sent to the Render Queue without an assigned location.

7	 Click the Browse button next to the Location text field.

8	 In the File Destination window, navigate to your Desktop and click Add New Folder.

9	 Name it Exports and click OK.

10	 With the render settings completed, click Add to Render Queue at the bottom of 
the panel. 

A pop-up dialog asks if you want to export the project at a higher resolution than your 
timeline. It also informs you that this type of resizing is best performed in the Project 
Settings under Timeline Format. For the purpose of this exercise, you will accept the 
job as it is.

11	 Click Add.
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12	 In the Render Queue panel, click the Job 1 title and rename it to YouTube.

Supporting Multiple Resolution Options for User-Generated 
Content Websites
Video players on user-generated content (UGC) websites such as YouTube or Vimeo often 
offer the option to choose a playback video resolution. A lower- resolution video will enable 
smoother playback on a low-bandwidth Internet connection, whereas a higher resolution 
will produce a more detailed image.

This change in resolution does not occur in real time within the UGC player. Instead, every 
resolution of every video is generated at the time of the video’s upload, which is why a wait 
period usually occurs before an uploaded video goes live. When switching between 
resolution options, the user is actually switching between separate renders of the video as 
generated by the host website.

For this reason, it is advisable to render and upload your video in the highest quality 
possible and leave it up to the UGC website and the end user to determine which resolution 
is best suited for playback.

Presets offer an efficient way to export projects quickly with the confidence that the 
settings are appropriate for the intended destination. However, it’s valuable to understand 
how and why certain settings are used and to be able to configure them to meet more 
specific needs, especially when your project deliverable extends beyond the destinations 
targeted in the presets list.

Creating Custom Renders and 
Saving Presets
You create custom renders as soon as you make changes to the fields in the Render 
Settings panel. Editors and colorists adjust render settings based on a wide range of 
factors including the requirements of the receiving software and hardware and the 
collaborative workflows they are engaged in.
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In this exercise, you will set up a render job to deliver dailies to an editor who is 
working on a PC.

1	 At the top of the Render Settings, click the Custom button.

2	 Under the Filename and Location fields, choose Individual Clips. Doing so will export 
every clip in the timeline as its own video file. In the case of dailies, you’ll want to 
place untrimmed clips on the timeline to ensure that the editor receives the full media 
for every take.

3	 Set the Video format to MXF OP-Atom.

4	 Set the Codec to DNxHD and the Type to 1080p 145/120/115 8-bit.

TIP Click the Expand button in the interface toolbar at the top of the page to 
expand the Render Settings panel to the height of the deliver page.

The exercises in this lesson did not focus on audio syncing or editing; however, in a 
dailies workflow, it is assumed that the audio from an external recorder would have 
been synced to the video files. The option to export audio can remain selected under 
the Audio tab using the high-quality Linear PCM codec.

5	 Click the File tab to configure the naming convention of the dailies.

By default, Filename Uses is set to Custom name. When working with dailies, it’s highly 
advisable that you preserve the original filenames (Source Name in the Render 
Settings). Doing so will enable you to quickly switch between offline and online media, 
as well as maintain consistency between postproduction departments.

In this case, you do not want to use the source name because all the clips have come 
from the same video file (Project 3 - The Long Work Day SCD.mov) and will overwrite 
one another.

6	 Enter the Custom name as WorkDay_Dailies.

7	 Select “Use unique filenames.”
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8	 Choose Suffix as the method by which the files will be distinguished from one another.

9	 At the top of the panel, click Browse to change the Location.

10	 In the Exports folder on the Desktop, create a subfolder called Dailies and select it as 
the location. Click OK to confirm.

11	 In the option menu of the Render Settings panel, choose Save as New Preset.

12	 Name the preset Dailies for PC.

The custom preset appears in the horizontal menu at the top of the Render 
Settings panel.

13	 Click Add to Render Queue.

14	 In the Render Queue, change the Job 2 title to Dailies.

Configuring a Timeline for 
Digital Cinema
A digital cinema package, or DCP, is a collection of media and metadata files used to 
project digital movie files in a theatrical venue. Resolve makes it possible to create a digital 
cinema package with its integration of the DCP plug-in. The next few exercises combine 
some practical information about DCPs with the configuration steps necessary to generate 
a DCP in the deliver page.

When creating a DCP, the timeline must be set to one of three 2K resolutions:
	� 2K Native (1.90:1) 2048 × 1080 @ 24, 25, 30, 48, 50, or 60 fps
	� 2K Flat (1.85:1) 1998 × 1080 @ 24, 25, 30, 48, 50, or 60fps
	� 2K CinemaScope (2.39:1) 2048 × 858 @ 24, 25, 30, 48, 50, or 60 fps

Or one of three 4K resolutions:

	� 4K Native (1.90:1) 4096 × 2160 @ 24, 25, 30, 48, 50, or 60 fps
	� 4K Flat (1.85:1) 3996 × 2160 @ 24, 25, 30, 48, 50, or 60 fps
	� 4K CinemaScope (2.39:1) 4096 × 1716 @ 24, 25, 30, 48, 50, or 60 fps
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1	 In the edit page, ensure that the Lesson 10 Timeline is open.
The resolution for your DCP will be 2K Flat because it is the closest resolution option 
when starting from full HD. You will need to scale up the project and crop the top and 
bottom of the frame.

Native 1.9:1

Flat 1.85:1

Scope 2.39:1

16 x 9 frame 1.78:1

TIP 4K DCPs use a lower bit rate than 2K DCPs when played on 2K 
projectors. For that reason, when your target projector is 2K, always make a 
2K DCP, even if your content supports higher resolutions.

2	 Choose File > Project Settings.

3	 In the Master settings, set the “Timeline resolution” to 1998 x 1080 DCI Flat 1.85.
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4	 In the Image Scaling settings, set the Input Scaling to “Scale full frame with crop”.

Scaling full frame with crop ensures that the longest dimension of the timeline viewer is 
filled with the source media, removing letterboxing or pillars. However, this often 
means that a small portion off the top and bottom of the image will be cropped.

5	 Click Save to close the window.

Your frame size is now DCP compliant. The project timeline is 24 fps, which is also 
appropriate for DCP delivery. However, if you were working on a project at 23.976 fps, DCP 
would still interpret it as 24 fps, and audio playback would be pulled up to match.

Now you can move on to the deliver page to set up some DCP-specific parameters.

Rendering a DCP
When the resolution and frame rate are appropriately set up, all further output parameters 
are configured in the deliver page.

The DCP plug-in in DaVinci Resolve 17 Studio features two sets of codecs. The Kakadu-
based JPEG 2000 standard requires no license and delivers unencrypted digital cinema 
packages. The easyDCP format allows for the encryption of digital media but requires that 
you purchase a licensing package.

1	 Enter the deliver page.

2	 In the Render Settings, click Custom.

3	 Near the top of the panel, select Single Clip. Unlike the dailies, you want this timeline to 
be rendered as a single, self-contained video file.

4	 In the Video tab, set the Format to DCP.

5	 Set the Codec to Kakadu JPEG 2000.
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6	 Set the Type to 2K DCI Flat.

TIP DCP uses the XYZ color space. The conversion of your project color 
space to XYZ is done during the creation of the DCP file. The project color 
space is determined by the timeline color space setting in the Color 
management settings, even when DaVinci YRGB color management is 
not in use.

The “Use interop packaging” checkbox determines whether you are generating the 
DCP based on the older but more widely supported Interop standard or the more 
current and feature-rich SMPTE standard. One of the benefits of using the SMPTE 
standard is that it supports a wider range of frame rates. The major benefit of using 
the Interop standard is that it will work on more theater projectors, although it is 
limited to 24 or 48 fps.

7	 Select “Use interop packaging.”

8	 Leave all other settings on their default selection.

TIP The alternative available codec to DCP is easyDCP, which can be 
activated with a license. This codec displays an additional “Encrypt package” 
checkbox. When delivering a DCP file to a film festival, you might want to 
consider bypassing encryption. Encryption keys are linked to a specific 
theater and projector, so if a screening room or location is changed at the last 
minute, as is often the case in festivals, the encryption would prevent your film 
from being screened.
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Naming and Outputting a DCP
DCPs follow a somewhat specific, yet voluntary, Digital Cinema Naming Convention for the 
content title. For each version of a movie you create (such as the English 5.1 version, the 
Spanish 5.1 version, the stereo version, the in-flight version, and so on), a composition 
playlist (CPL) is created that contains the appropriate content name. The DCP preset 
creates this CPL for you and includes a straightforward way to generate a name that follows 
the appropriate naming convention.

1	 Ensure that you are still in the Video tab of the Render Settings.

2	 Scroll down to find and expand the Composition Settings. 

3	 To ensure that the project has a DCP appropriate name, click the Edit button next to 
the “Composition name” field. 

The Composition Name Generator window opens. Here you can enter the metadata 
that will be used to create a content title compatible with DCP servers and theater 
management systems.

TIP Separate the words in your project title using initial caps—not spaces, 
hyphens, or underscores.
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4	 Enter the Film Title as TheLongWorkDay, leave the Content Type as ADV 
(Advertisement), and set the Audio Language to EN (English). 

The selected metadata is added to the composition name.

5	 Click OK to close the window.

The composition name is not to be confused with the package name that contains the 
DCP. That custom name is managed in the File tab of the Render Settings panel.

6	 Click the File tab and enter the Custom name as Long Work Day DCP test. 

Lastly, you need to select a destination for this DCP.
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7	 Click the Browse button, and select your Desktop as the render location.

When delivering a real film project, you can output the DCP to a hard drive in a Cru 
Dataport DX-115 enclosure that will load directly onto many digital cinema servers and 
is often required by some film festivals. More conveniently, you can output to a USB 2 
or 3 hard drive or even a USB stick if it accommodates the film’s file size. No matter 
which storage device you choose, the device must be formatted as a Linux ext2 or 
ext3 drive. There are various ways do so on macOS and Windows workstations.

TIP Some projection servers do not have enough power for certain USB-
powered drives to mount. In those scenarios, be sure to use a USB drive that 
uses an external power source.

8	 Click Add to Render Queue.

9	 In the Render Queue, change the Job 3 title to DCP.

When rendering a real film project, you will want to test it after generating the DCP file. 
The only definite way to test your DCP is to rent a theater and run it just as it would 
be projected for an audience. That is the only way you can absolutely verify that the 
color conversion (from your timeline color space to XYZ) worked correctly. DCPs can 
also be tested by importing them back into a new DaVinci Resolve project file and 
managing the color space from DCI X’Y’Z to your monitoring standard. However, this 
method may not show you an accurate representation of how the project will appear 
when projected.

Exploring Advanced Render Settings
In addition to choosing how your footage is compressed, you have additional control over 
more nuanced aspects of the rendering process. This exercise is designed to familiarize 
you with these settings and enable you to set up your custom renders with more purpose.

1	 In the Render Settings panel, select the Vimeo preset at 720p resolution.

2	 Click the Custom preset button to reveal the full list of settings, while maintaining the 
Vimeo preset parameters.

3	 Leave the video format as QuickTime and the codec as H.264.

4	 Leave the resolution at 1280 x 720 HD and the frame rate at 23.976.

5	 The Quality value in the Render Settings panel specifically refers to the data rate of the 
digital data—that is, the data per second required to transmit the audiovisual stream. 
A higher data rate contains more visual information, which results in better motion 
representation and detail quality, whereas a lower data rate selectively discards some 
data in the interest of generating a smaller file size.
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Restrict the Quality setting to 4500 Kb/s. Doing so will substantially reduce the file size 
of the final render, albeit at the expense of its visual quality.

6	 The Encoding Profile determines the level of complexity involved with encoding an 
H.264 file. Auto will determine the optimal profile based on resolution and bit depth. 
For best performance, set Encoding Profile to High.

For this render job, leave the Encoding Profile set to Auto.

7	 Key frames are full-data, intra-coded frames, or i-frames, inserted into a lossy video 
stream at regular intervals, such as every 12 frames. These i-frames are reference 
points for recreating the temporally compressed p- (predicted) and b- (bi-directionally 
predicted) frames that make up the majority of the moving image in a distribution 
codec (such as H.264).

Restrict the Key Frames to be grabbed every 12 frames to ensure less distortion during 
the temporal compression and playback of the video.

8	 Click the disclosure triangle to see the Advanced Settings options.

9	 The “Pixel aspect ratio” allows you to indicate whether the video pixels are Square 
or Cinemascope (rectangular). This option pertains to older workflows in which 
digital footage recorded for analog television (at a rectangular 1.33:1 aspect ratio) 
was converted for computer displays (which have a square 1:1 aspect ratio). If your 
video looks horizontally distorted (too squashed or stretched out), change the pixel 
aspect ratio.

Since you’re working on digitally recorded and encoded media, you can leave the 
“Pixel aspect ratio” as Square.

10	 Data Levels specify the data range of an image based on its source. The default Auto 
setting renders the media at the data level appropriate for the selected codec. Video 
refers to YCbCr formats that constrain to pixel data values between 64–940 on a 10-bit 
system in formats using a Rec.709 video standard. Full expands the range to the film 
standard of 4–1023 values utilized in high-end digital film formats. If you find that your 
final video looks substantially darker or lighter than it appears in the viewer of the color 
page, it is likely that the data levels are incorrectly assigned.

Leave the Data Levels on Auto.
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11	 Color Space and Gamma tags allow you to embed colorimetry metadata into the video 
file that can be read and interpreted by operating systems and applications. These 
tags allow you to overcome the color shift that can occur between the DaVinci Resolve 
viewer and certain video players and browsers with an internal color profile.

Leave the tags set to Same. The resulting video file will be tagged with the project’s 
Output color space. When not using RCM, the tags will reflect the Timeline color space.

12	 Set the “Data burn-in” to None to ensure that the viewer’s data burn-in information will 
not appear in the rendered video.

13	 Selecting “Bypass re-encode when possible” will render a direct copy of the original 
media file when possible. This option will have no effect if you have graded or 
composited your media or if you are exporting to a format different from the source. An 
example of when this setting is beneficial could be if you were editing a project using 
ProRes 422 media, with the intention of delivering in ProRes 422. Bypassing re-encode 
will deliver such a project at the highest possible quality.

Leave “Bypass re-encode when possible” selected.

14	 The following options, “Use optimized media,” “Use proxy media,” and “Use render 
cached images,” allow you to employ previously-generated renders of the footage in 
the export process. It makes sense to select these options when your optimized or 
proxy media and render cache are set to a high or lossless quality such as 444 or HDR.

The project is currently using a lossless render cache codec, so it makes sense to use 
it in the final render for faster output.

Select “Use render cached images.”

15	 The “Force sizing to highest quality” and “Force debayer to highest quality” settings 
bypass the quality settings for resizing and debayering in the Project Settings. 
Selecting one of these is convenient when working on a processor-intensive timeline 
that uses high-quality images or RAW footage. You can adjust the Project Settings to 
ensure a lower-quality visual output during editing but bypass such settings to ensure 
the highest possible quality output upon final render.
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Select “Force sizing to highest quality” to ensure the optimal resize filter is used 
during rendering. 

It is not necessary to select the debayer option because this project does not contain 
any RAW media. 

16	 “Enable Flat Pass” allows you to bypass grades applied to versions of clips in the 
timeline. The default choice is Off, which ensures that all grades remain intact. 
Choosing  “With clip settings”’ ensures that the render will take into account the bypass 
status of each clip’s version. Choosing Always On will disable all the grades in the 
timeline, thereby providing a quick way to export an edited timeline or a set of dailies 
without a grade.

Set Enable Flat Pass to “With clip settings.”

17	 Selecting “Disable sizing and blanking output” removes any transform changes and 
blanking that were applied to the clips in the edit or color pages. Leave it deselected.

18	 In the Timeline panel, ensure the render range is set to Entire Timeline.

19	 Click Add to Render Queue.

20	 In the Render Queue, change the Job 4 title to Preview 720p.

21	 In the Render Queue, in the options menu, choose Show All Projects.

You should now see all the jobs that were added to the Render Queue in any project 
currently associated with the database you’re using. If you split longer projects into 
reels, or if you’re working on timelines with different frames rates, you might want to 
access all the jobs in the queue to render them from a  single project, instead of 
waiting for a batch to render before launching other projects.

22	 In the options menu, deselect Show All Projects to return to the current project’s 
Render Queue.
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Editing Render Jobs
A job can be removed or modified, even after it has already been added to the 
Render Queue.

1	 Find the DCP job in the Render Queue and click the X in the upper-right corner of the 
job to delete it from the queue.

2	 Find the YouTube job and click the pencil icon in the top-right corner to edit it.

The Render Settings change to reflect the settings of the custom YouTube job. The 
presence of additional buttons (Cancel, Update Job, and Add New Job) at the bottom 
of the panel indicates that a job is currently being edited.

3	 Change the Resolution to 1920 x 1080 for Full HD.

4	 Raise the Quality to Restrict to 8500 Kb/s.

5	 Click Update Job at the bottom of the Render Settings panel to exit the Edit mode.

The change overrides the original YouTube job with the new settings.

6	 Click the YouTube job in the Render Queue palette. 

7	 At the bottom of the Render Queue palette, click Render 1.

Note that the remaining, unselected jobs did not get rendered. When delivering 
multiple timelines or formats, ensure that you select all necessary jobs in the queue 
before clicking the render button. When no jobs are selected, the button will be set 
to Render All.
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TIP The fastest way to export a timeline from DaVinci Resolve is to choose File > 
Quick Export. This export feature is designed to produce light video files for 
immediate viewing or uploading to social media.

Utilizing the correct render settings is vital to delivering an aesthetically correct and 
technically functional video project. Understanding these settings has even greater 
benefits; it elevates your skillset as a colorist and imbues confidence that your projects are 
delivered at their optimal quality and adhere to industry standards.

Remote Rendering
DaVinci Resolve Studio allows you to offload rendering to another Resolve workstation. 
Remote rendering requires that all workstations have a copy of DaVinci Resolve 17 Studio 
installed, a shared Postgres database, and access to all necessary media files using the 
same filename paths. With one computer acting as a render station, all other Resolve 
stations can continue to be used for further editing and grading.

Lesson Review
1	 Yes or no? You can continue to view and grade media in the Lightbox.

2	 True or False? The deliver page supports roundtrip workflows with other NLE programs.

3	 How would you disable data burn-in from the Render Settings panel?

4	 How do you save a custom render preset?

5	 True or False? It is possible to continue editing a render job after it has been added to 
the Render Queue.
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Answers
1	 Yes, if you enable color controls and have an external monitor.

2	 True. The presets at the top of the Render Settings panel allow you to select an NLE 
program for a roundtrip delivery of individual video clips and an XML timeline.

3	 Set the “Data burn-in” parameter to None.

4	 Render Settings options menu > Save as New Preset.

5	 True. Clicking the pencil icon in the upper-right corner of a render job allows you to 
continue modifying its settings.

Congratulations!
You have completed The Colorist Guide to DaVinci Resolve 17 and are ready to explore 
more editing, visual effects, color grading, and audio mixing functionality using the 
additional certified books in this series. Completing all the lessons in this book has 
prepared you to become a certified DaVinci Resolve user. You can take the online exam 
by following the link below to earn your certificate.

We also invite you to become part of the DaVinci Resolve community by joining the web 
forum on the Blackmagic Design website. There, you can ask further questions about the 
creative aspects of editing, color correction, visual effects, and audio mixing.

We hope that you have you have found DaVinci Resolve 17’s professional nonlinear editing 
and world-class color correction tools to be intuitive to learn and a perfect fit for your 
creative workflow.

Test your skills by taking the online assessment: https://bit.ly/3rXUgZX. When registering, 
please select the BMD training partner country as ONLINE and the BMD training partner 
name as BMD Training Page.

https://bit.ly/3rXUgZX
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Using DaVinci Resolve Panels
The DaVinci Resolve panels allow you to make faster and much more nuanced changes to 
your images. Instead of being limited to color grading one click or drag at a time, the panels 
let you adjust multiple controls at the same time. It can be the difference between taking 
1 minute or 5 minutes to complete a shot.

The role of the colorist isn’t only about creativity; it’s about efficiency. To meet the time 
requirements of your budget as well as the expectations of your client, you’ll have to find 
ways to quickly navigate between clips and nodes, balance clips, and tweak numerous 
looks throughout your projects. Having a set of panels will help you meet those time-
sensitive demands.

Appendix

Setting Up and Using 
the Blackmagic Design 
Mini Panel
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DaVinci Resolve Mini Panel
The DaVinci Resolve Mini Panel is a compact device packed with a massive combination of 
features and controls. You get three professional trackballs along with a variety of buttons 
for switching tools, adding color correctors, and navigating your node tree. In addition to 
every tool and feature available on the Micro Panel, the Mini Panel features two 5” color 
LCD screens that display menus, controls, and parameter settings for the selected tool, 
along with eight soft buttons and eight soft knobs that give you direct access to the menus 
for specific features. The Mini Panel is ideal for users who regularly switch between editing 
and color grading, users who wish to access both primary and secondary color correction 
tools from their panel, or for freelance colorists who need to carry a panel with them when 
moving between facilities. It’s also great for colorists working on location shoots, for 
corporate and event videographers, for houses of worship, and more.
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DaVinci Resolve Micro Panel
The DaVinci Resolve Micro Panel is a high-quality, portable, low-profile panel that features 
three high-resolution trackballs and 12 precision-machined control knobs for accessing 
essential primary correction tools. Above the center trackball are keys for switching 
between Log and offset color correction, as well as a key to display DaVinci Resolve’s 
full-screen viewer, which is great for use with laptops. Eighteen dedicated keys on the right 
side of the panel also give you access to many commonly used grading features and 
playback controls. The DaVinci Resolve Micro Panel is perfect for anyone who needs a 
truly portable solution. It’s great for use on set to quickly create looks and evaluate color, 
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it’s ideal for grading in broadcast trucks, for education, and for anyone who’s work relies 
mostly on the primary color correction tools.
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DaVinci Resolve Advanced Panel 
For the ultimate in speed, power, and control, Blackmagic Design offers the 
DaVinci Resolve Advanced Panel. The Advanced Panel has been designed in collaboration 
with professional colorists to work together in total harmony with the software. This large 
panel consists of left, center, and right consoles that give you quick, one-touch access to 
virtually every parameter and control in the software. The DaVinci Resolve Advanced Panel 
lets colorists instinctively reach out and touch every part of the image, adjusting multiple 
parameters simultaneously with complete responsiveness for a smooth grading 
experience. While the Mini Panel gives you access to nearly all the color correction tools in 
Davinci Resolve, the Advanced Panel gives you even more flexibility with physical buttons 
and knobs to control Memories, OpenFX tools, Dolby Vision HDR, and many other speed 
and workflow-based tools that will increase your efficiency even more. The Advanced 
Panel also features a unique T-Bar used for playing back gallery stills, shuttle controls for 
cycling through frames and speeding through your timeline, as well as a slide out keyboard. 
Used in many of the top color grading facilities across the world, the Davinci Resolve 
Advanced Panel is the ultimate control surface for Davinci Resolve. 
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DaVinci Resolve Mini Panel Overview
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The lower-half of the Mini Panel contains the primary control tools. The largest controls 
on the Mini Panel are the three trackballs and rings that control Lift, Gamma, and Gain. 
Their behavior and layout mirrors the color wheels in the primaries palette, with the 
trackballs controlling hue, while the rings control brightness. When the Lift ring is rotated 
counterclockwise, the image shadows grow darker. When the Gain trackball is moved 
toward the upper left, the brighter areas of the image become warmer. The offset soft 
key above maps the right trackball to the offset wheel and the two left trackballs to the 
temp and tint controls. These tools are identical to the Micro Panel.
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Above the Lift, Gamma, and Gain controls are the Primary knobs, which are mapped to the 
adjustment controls in the primaries palette. They control frequently used Resolve tools 
such as Contrast, Pivot, Saturation, Color Boost, and Hue. These knobs (as well as all knobs 
on the panel) have 4,098 points per turn, and can be pushed to reset the tool they control.
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To the right of the Gain trackball are useful playback and shuttle controls to help you 
navigate quickly between clips, nodes, frames, and playback options. Some important 
controls to remember are Loop, which will loop the currently selected clip; Bypass, which 
will temporarily bypass all the nodes/color corrections on the timeline; and Disable, which 
will temporarily disable the selected node on a clip.

OFFSET

MID DETAIL COLOR BOOST SHADOWS HIGHLIGHTS SATURATION HUE LUM MIXPIVOTCONTRASTY GAINY GAMMAY LIFT

ALL
LEVEL

LOG

RGB

VIEWER

UNDOGRAB
STILL REDO

PREV
MEM

PLAY
STILL RESET

BYPASSLOOP DISABLE

PREV
NODE

NEXT
NODE

PREV
FRAME

NEXT
FRAME

PREV
CLIP

NEXT
CLIP

 



ALL
LEVELRGB

ALL
LEVELRGB

BLUR KEYERTRACKER

QUALIFIER WINDOWCURVES

PRIMARY MOTIONRAW

v wHOME

FX USERSIZING

PARALLEL LAYERSERIAL
2 31

NODE +
CIRCLE APPENDNODE +

LINEAR
5 64

NEXT
KF REFPREV

KF
14 1513

NEXT
STILL HIGHLIGHTPREV

STILL
11 1210

PASTE FULL
VIEWERCOPY

8 97

The lip of the Mini Panel consists of palette soft keys; two 5-inch high-resolution displays, 
and even more node, keyframing and selection controls. The color tools in Davinci Resolve 
are accessed in the user interface through a series of icons between the timeline and color 
tools. All these tool palettes are mirrored into their own buttons on the Mini Panel. The two 
displays—as well as the eight soft buttons and eight soft knobs above and below the 
displays offer advanced control over the active color page palette.
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Index

NUMBERS
2K and 4K resolutions, 300–301
4K to 1080p to 4K workflow, 234
12-bit depth codecs, 286. See also codecs
1920 × 1080 workflow, 234

A
AAF files, migrating with, 110
A/B Difference button, 63
ACES (Academy Color Encoding System), 268
actions, undoing, 131
Advanced Panel, xviii, 315
Age of Airplanes, 108
Alt key. See keyboard shortcuts
analog video look, applying, 224–226
animating position values, 243–245
appending grades and nodes, 163–167
archives

creating, 5
opening, 4–5

aspect ratios, customizing, 237
atmosphere, adding, 74–77
attention

drawing, 54–56
focusing with vignettes, 59–61

Audio Only, Render Settings panel, 296
AVID AAF, Render Settings panel, 295
Avid Media Composer, 110

B
Backplate node, 243
backups, setting up, 5–6
Balanced Timeline, 36. See also timeline
balancing

footage, 3–4
and shot matching, 7
shots, 30

base grades, applying at pre-clip group level, 
196–199. See also grades

Bézier curves, 76, 91

Black Offset, HDR palette, 274
blanking, applying to timeline, 236
Blend mode, removing, 145
Blur palette, 61
brightness, increasing, 13
BW node, 256
bypass, toggling on and off, 13
Bypassed and Graded, 26

C
cache, clearing, 260
cache quality, configuring, 258–259
cached media, locating, 260
caching, source and sequence, 254–255
Certificate of Completion, receiving, xi
Chroma-Luma panel, 85
Cinema Viewer, 162
classic color grading workflow, 195–196. 

See also colors
clips. See also matched clips

adjusting after post-clip grades, 221–223
comparing, 49–50, 75
creating versions of, 161
reframing, 235–236
selecting, 124, 191

Clips filter, 257
clip-specific adjustments, making, 199–204
codecs. See also 12-bit depth codecs

choosing, 306
and DCP, 302–303

color adjustments, disabling, 19
color channel values, 10
color charts, using to balance 

groups, 196–198
color effects, compositing, 147–155
Color Generator, 73
color grades, keyframing, 247
color management, setting up, 122–125, 

189–193. See also RCM (Resolve Color 
Management)

color monitoring, 126
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color page
entering, 5
layout, xiii–xiv

color panels, xvii
color ranges, warping, 77–89
color space, separating from gamma 

settings, 127
Color Space Transform ResolveFX, 275
Color Temp and RAW settings, 270
color values, changing with dynamic 

keyframes, 246–247
Color Warper, 77–89
colors. See also classic color grading 

workflow; memory colors; output 
color space

balancing, 17–20
and saturation across nodes, 131–133

ColorTrace, copying timeline grades, 172–177
Command key. See keyboard shortcuts
Commands list, 40
comparing clips, 49–50, 75
compositing, color effects, 147–155
Compound node, creating, 154–155
Conflict Resolution window, 117
conforming 

process, 107
timelines, 112–119

contrast
and luminance on nodes, 133–135
node, 42
setting, 14–17
and tonal range, 9–17

Contrast and Pivot, HDR palette, 274
control points, creating, 16
copying

grades from clips and stills, 158
grades using Timelines album, 177–178
nodes from stills, 166–167
timeline grades, 172–177

Coring Softness, 63
cover-ups, creating, 239–243
CPL (composition playlist), 304
cross process look, creating, 159–163
CST (Color Space Transform), 268
Ctrl key. See keyboard shortcuts
curves

balancing color with, 17–20
controls, 14–17
preventing from moving, 16

Curves palette, 15, 135
custom curves, xiii, xiv, 15

D
Data Burn-In, 226–228
DaVinci Resolve, downloading, x
DCP (digital cinema package), configuring 

timeline for, 300–306
deleting strokes in Magic Mask palette, 215
Denoise node

activating, 256–257
bypassing, 253

depth of field, mimicking, 57–58
display-referred color management 

setup, 122–123
downloading DaVinci Resolve, x
DPX and DRX files, exporting, 170–171
dynamic attributes, applying, 247–248
dynamic keyframes, 243–249
dynamic range, maximizing, 122–127

E
easyDCP format, 302–303
Edit Sizing, 236
editing render jobs, 310–311
effects, applying at timeline level, 223–228
Effects and Definitions panel, 174
endangered rhinos project, 3–4
Enhanced Viewer mode, 15, 20, 203–204. 

See also Viewer
exporting

DPX and DRX files, 170–171
projects, 298

eye of viewer, controlling, 54–61
Eyebag removal, 94

F
face refinement, 89–95
file source locations, changing, 121
film projects, rendering, 306
filters and flags, organizing shots with, 32–35
Final Cut Pro, Render Settings panel, 295
fixing tracks, 213–216
flags and filters, organizing shots with, 32–35
Frame mode, switching tracking to, 66
frame rate, setting, 306

G
Gain master wheel, 12, 21–22, 24–25
Gain wheel, xiv
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gallery
identifying, xiii
and stills, 171

Gamma master wheel, xiv, 12, 21, 26, 37, 244. 
See also log gamma curve

gamma range, changing, 127
gamut standards, considering, 127. See also 

Wide Gamut
GM (Gamut Mapping) ResolveFX, 268
Graded and Bypassed, 26
grades. See also base grades; group grades; 

secondary grading; timeline grades
appending, 163–167
applying at timeline level, 223–228
copying from clips and stills, 158
copying using Timelines album, 177–178
resetting, 133
saving, 168–172

grades and nodes, appending, 163–167
gradients, darkening ranges of, 21
grading workflow, 7–8
group grades, disabling, 232. 

See also grades
groups

balancing using color charts, 196–198
creating, 193–196

H
HDR (High Dynamic Range) media, 

grading, 272–284
HDR palette

color wheels panel, 281
custom zones, 282
Exp parameter, 277
mapping to color panels, 284
saving custom layouts, 283
and viewer’s highlight mode, 278
Zones Graph, 279–280, 282

Highlight button, 63–64
Highlight master wheel, 23
Highlight Recovery and RAW 

settings, 269–270
HQ footage, associating with timeline, 119–121
HQ transcodes bin, opening, 124
HSL Curves, 102
HSL Qualifier palette, 69
hue curves, naming convention, 97
Hue Vs Sat node, disabling, 101
hues, selecting in Color Warper grid, 81–84

I
imagery, improving, 3
IMF, Render Settings panel, 295
importing

LUTs (Lookup tables), 118
media, 265
XML timeline, 108–110

Input Sizing, 236
ISO, changing, 269

J
jump cuts, 187

K
Kakadu-based JPEG 2000 standard, 302
keyboard shortcuts

bypassing node grades, 135
bypassing node trees, 220
bypassing nodes, 64
Cinema Viewer, 162
color adjustments, 19
Color Warper, 81
comparing clips, 75
Contrast node, 42
curves, 16
Denoise node, 253
disabling nodes, 76
fitting video frames, 234
Highlight feature, 63–64
Hue Vs Sat node, 101
inverting wipes, 39
labelling nodes, 40
Layer Mixer node, 143, 149, 237
layer nodes, 151
nodes, 149, 154
Parallel Mixer node, 139
Primaries wheels and Log controls, 26
Reset command, 161
resetting grades, 133
Select All, 124, 188, 191
serial nodes, 36
sharpening adjustments, 63
timeline clips, 20
toggling bypass on and off, 13
toggling wipes, 44
undoing actions, 131
versions of clips, 161
Viewer, 15
window outline, 56
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Keyframe Editor, xvi
keyframing, 243–249
keying and masking, 7

L
Layer Mixer node

adding, 143
and color effects, 147–155
compositing color effects with, 147–155
using, 237

layer nodes, creating, 151
lesson files, acquiring, xi
Lift master wheel, xiv, 11, 21–22, 25
Lightbox, using to check timelines, 290–293
Lip Retouching, 94
Live Save feature, 5–6. See also saving
local versions, working with, 159–163
log controls, and primaries wheels, 20–27
log gamma curve, correcting, 122–123. 

See also Gamma master wheel
looks

analog video, 224–226
creating, 8
unifying, 216–223

Loop button, 245
luminance

channel values, 10
and contrast on nodes, 133–135
enhancing colors based on, 84–89

luminance curve, 15–16
LUTs (Lookup tables), 118, 268

M
Magic Mask palette, 206–216. See also 

masking and keying
markers, using for filtering, 35
masking and keying, 7. See also Magic 

Mask palette
master wheels

identifying, xiv
normalizing with, 9–13

match shots, 3
matched clips, removing, 175. See also clips
matching, reframed clips, 116
matte data, sharing across nodes, 150–155
media. See also offline media and proxies

importing, 265
preparing using Scene Cut 

Detection, 184–193

memories, saving stills as, 169
memory colors, 102. See also colors
Micro Panel, xvii, 314–315
Mini Panel, xvii–xviii, 4, 314, 316–317

Curves, 20
Hue Curves, 102
offset mode, 14
Power Windows, 61
Qualifiers, 70
Tracking, 67

Mixer nodes
morphing, 141–142
visualizing, 142–146

Motion Blur, 250
Motion Effects palette, 250

N
node cache, generating, 255–257
Node Editor

decluttering, 155
serial nodes, 36
using, xiii
visualizing grading workflow in, 8

node grades, bypassing, 135
node graph, xiii
node layers, reordering, 145–146
node order, 131–139
Node Sizing, 236
node sizing, sampling visual data 

with, 237–239
node tree, bypassing, 220
node-based cover-ups, 239–243
node-based grade compositing, 130–131. 

See also RGB channels
nodes. See also Parallel Mixer node and 

processing pipelines
adding, 149
anatomy of, 130–131
appending, 163–167
bypassing and evaluating, 64, 154
color and saturation, 131–133
contrast and luminance, 133
copying from stills, 166–167
disabling, 76
dominance color grades, 136–139
inputs and outputs, 130
labelling, 40
order of, 131
removing plug-ins from, 95
sharing matte data across, 150–155
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nodes and grades, appending, 163–167
noise reduction, applying, 249–253, 292–293
normalizing with master wheels, 9–13

O
Object Removal effect, 243. See also 

obscured objects
obscured objects, tracking, 64–67. See also 

Object Removal effect
offline media and proxies, 260. 

See also media
offline reference, syncing, 111–112
Offset wheel, xiv
online references, syncing, 111–112
OpenFX panel, opening, 57
opening

archives, 4–5
HQ transcodes bin, 124
Motion Effects palette, 250
Primaries palette, 11
Project Settings, 123
Window palette, 237

Option key. See keyboard shortcuts
output color space, changing, 125–127. 

See also colors
Output Sizing, 236
Outside node, disabling, 76
overcast skies, fixing, 68–77. 

See also sky color

P
P3 digital cinema, 125–126
Palette panel, xvi
panels, using, 313–317
Parade and Waveform scopes, 10, 25, 39–40
Parallel Mixer node and processing pipelines, 

139–142. See also nodes
Patch Replacer ResolveFX, 239–243
people and features, tracking, 205–216
performance, optimizing, 254–260
physical features, masking, 209–212
Pivot control, 13
“Pixel aspect ratio,” 307
plug-ins, removing from nodes, 95
position values, animating, 243–245
Post-Clip Group level, 216–223
Power Windows palette, 7, 61
Premiere XML, Render Settings panel, 295
preparing media, 184–193

presets, saving, 298–300
Primaries Bars, adjusting, 41
Primaries palette, opening, 11
Primaries wheels, xiii, xiv, 20–27
Pro Tools, Render Settings panel, 296
processing pipelines and Parallel Mixer 

node, 139–142
project backups, setting up, 5–6
project files, locating, xvi, xvii
Project Settings, opening, 123
ProRes, H.264 and H.265 Masters, Render 

Settings panel, 295
proxies and offline media, 260

Q
qualifiers, limiting, 70, 72–74

R
RAW clips

color grading, 272–280
verifying, 264

RAW media, setting up render cache 
for, 284–286

RAW projects, setting up, 268
RAW settings

adjusting at clip level, 269–272
adjusting at project level, 264–268

RCM (Resolve Color Management), 268. 
See also color management

Rec.709 color standard, 122, 125
Rec.2020 UHD, 125
Reference Sizing, 236
RGB channels, viewing, 17. See also 

node-based grade compositing; 
YRGB color management

reframed clips, matching, 116
remote rendering, 311
remote versions, 163
render cache

optimizing performance with, 254–260
setting up for RAW media, 284–286

render jobs, editing, 310–311
Render Settings panel, 294–296, 306–311
render workflow and presets, 294–298
rendering

DCPs (digital cinema packages), 302–303
film projects, 306

renders, customizing and saving 
presets, 298–300
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Reset command, 161
resolutions

2K, 300
4K, 300
customizations, 237
options, 298
rescaling media to, 233
setting, 306

RGB channels, viewing, 17. See also 
node-based grade compositing; 
YRGB color management

RGB Mixer palette, 144–146
rhinos project, 3–4

S
sampling visual data, 237–239
saturation and windows, 54–56
saving. See also Live Save feature

grades, 168–172
presets, 298–300

Scene Cut Detection, using to prepare 
media, 184–193

scene-referred color management, 123
scenes, correcting with Wide Dynamic 

Range, 281–283
scopes, xiii, xiv
Scopes palette, Vectorscope option, 98
s-curve

creating on Y channel, 150
shaping master curve into, 218

secondary grading, performing, 7–8. 
See also grades

Select All, 124, 188, 191
serial nodes, adding, 36, 42
Shadow master wheel, 23, 26
shadows, matching, 41
sharing timelines, 119
sharpening key elements, 62–64
shot matching

applying, 35–37 
and balancing, 7
goal of, 29
strategy, 30–31

shots
comparing and matching, 43–50
matching at clip group level, 199–203
matching using stills, 38–43
organizing, 32–35

Sizing Palette, 232–243

skin tones
adjusting, 96–102, 140
enhancing, 89–95

sky color. See also overcast skies
blending, 74
replacing, 73

Smart Bins, 124
Smart Cache, 257–258, 265
SMPTE ST.2067-compliant resolutions, 295
source and sequence caching, 254–255
Spatial NR, 250–252
Split Screen, disabling, 163
split-screen views, 49–50
static keyframes, using, 249
stills

copying nodes from, 166–167
dragging from gallery, 165
saving as memories, 169
using to match shots, 38–43

strokes, deleting in Magic Mask palette, 215
Sunlight node, 56
syncing offline reference, 111–112
system requirements, x

T
Temp and Tint, HDR palette, 274
Temp field, 13
Temporal NR, 250
Tilt-Shift Blur effect, 57
timeline. See also Balanced Timeline

applying blanking to, 236
applying grades and effects, 223–228
associating HQ footage with, 119–121
checking prior to delivery, 290–293
configuring for digital cinema, 300–306
conforming, 112–119
resolutions, 232–234
sharing, 119

timeline clips, displaying, 20
timeline grades, copying, 172–177. 

See also grades
Timeline Thumbnail mode, 293
Timelines album, using to copy 

grades, 177–178
Tint field, 13
tonal range

and contrast, 9–17
targeting, 272–280



324 325Index

tracking
obscured objects, 64–67
people and features, 205–216

tracks, fixing, 213–216
translation errors, fixing for timeline, 114–119

U
UGC (user-generated content), 298
undoing actions, 131
unifying look, creating, 216–223
user cache modes, 257–258

V
Vectorscope, choosing in Scopes 

palette, 98–99
versions, working with, 159–163
VFX workflows, 174
video formats, choosing, 306
video frames, fitting to viewer panel, 234
Viewer, xiii, xv. See also Enhanced Viewer 

mode; split-screen views
enlarging, 15
warping colors in, 78–81

vignettes, focusing attention with, 59–60
visual data, sampling with node 

sizing, 237–239

W
warping color ranges, 77–89
watermark, applying over video, 227

Waveform and Parade scopes, 10, 25, 39–40
waveforms, using to match clips, 202
Wide Dynamic Range, correcting scenes 

with, 281–283
Wide Gamut, setting up color management in, 

189–193. See also gamut standards
Window palette, 237
windows

combining with Face Refinement, 91–92
customizing, 76
and saturation, 54–56
using to limit qualifiers, 72–74

wipes
inverting, 39
toggling on and off, 44

X
XML timeline, importing, 108–110
XYZ color space, DCP (digital cinema 

packages), 303

Y
Y channel, creating s-curve on, 150
YouTube/Vimeo/Twitter, Render Settings 

panel, 295, 297–298, 306
YRGB color management, xiv, 124–125. 

See also RGB channels

Z
Zones graph, HDR palette, 279–280, 282



DaVinci Resolve 17 is Hollywood’s most popular color correction 

software and is used to color grade more feature films, television shows, 

and commercials than any other solution. This official Blackmagic Design 

hands-on training guide takes you through a series of practical exercises 

that teach you how to use DaVinci Resolve’s color correction tools in 

detail. You’ll learn a wide variety of workflows, effects, and tools 

necessary to perform Hollywood-caliber grades. 

What You’ll Learn

•	 Launching Resolve project files and restoring archives

•	 Normalizing, balancing, and matching footage

•	 Analyzing and color correcting images with the help of scopes

•	 Primary and secondary grading tool operations

•	 Migrating XML timelines and roundtrip workflows

•	 Remapping video color gamuts with color management

•	 Working with nodes to create sophisticated grades

•	 Managing and copying grades with stills, versions, and ColorTrace

•	 Creating groups to streamline your workflow

•	 Color grading high dynamic range footage

•	 Render cache and delivery settings for optimal quality

•	 Dozens of tips and tricks that will transform how you work!  

Who This Book Is For 
This book is designed for video editors and colorists. It contains clear and concise lessons, 

along with dozens of tips and tricks from professional colorists to help you create cinematic 

images that stand out! You’ll learn about the primary grading tools used for balancing 

images, fundamental color theory, secondary tools for isolating specific parts of an image, 

how to read scopes, create unique looks, and more!

Color Page Workflows

Secondary Grading

Node Editor Pipeline

Reading Scopes

DaVinci
Resolve 17
The Colorist Guide to
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